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Part 1: Paper Ballot

The Paper Ballot module of the Design group enables you to create and edit elements 
that relate to your paper ballots such as text, cells, style sheets and graphics. The 
following topics are described in this part of the EVS5200_DOC_SOP_EW03Design:

 Chapter 1: Paper Ballot Overview

 Chapter 2: Paper Ballot Screen

 Chapter 3: Ballot Management

 Chapter 4: Ballot Template Management

 Chapter 5: View Menu

 Chapter 6: Universal Paper Ballot Features

 Chapter 7: Ballot Setup

 Chapter 8: Ballot Sheet Management

 Chapter 9: Graphics

 Chapter 10: Text

 Chapter 11: Font Substitutions

 Chapter 12: Multi-Sheet Setup

 Chapter 13: Default Language

 Chapter 14: Scan for Errors

 Chapter 15: Style Sheets

 Chapter 16: Adding Content to Style Sheets

 Chapter 17: Managing Style Sheets

 Chapter 18: Ballot Frames

 Chapter 19: Finalizing the Ballot

 Chapter 20: Print Ballots
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Chapter 1: Paper Ballot Overview

Paper Ballot is a design tool encompassed within the Design module of the 
ElectionWare program. Paper Ballot reads and converts the information in your 
jurisdiction’s election database (created in Capture) into finished ballot layouts. This 
particular portion of ElectionWare functions in an external window, and enables you to 
design and publish ES&S paper ballots for central and precinct ballot scanners. Use 
Paper Ballot to create ballot formats for ES&S ballot services, for a partner printer who 
uses your layouts to print official ballots, or use the layouts you create with Paper Ballot 
to print extra Election Day ballots with the Print module. 

Do one of the following:

• From the Modules menu, point to Design, and 
select Paper Ballot.

• From the Modules pane, click the Paper Ballot symbol.

The Paper Ballot module appears in a window:

Note: Only one ElectionWare user can access the election when using Paper Ballot. 



 Chapter 2: Paper Ballot Screen 11

EVS5200_DOC_SOP_EW03Design
 Software Version 4.6

 Published: April 25, 2014

Chapter 2: Paper Ballot Screen

The Paper Ballot screen is divided into three separate panes by default: 

 Ballot Style Navigator – navigate between ballot styles.

 Ballot Work – make ballot formatting changes.

 Messages – shows important information regarding your ballot, (e.g., error 
messages).

In addition to these panes, Paper Ballot has a standard set of menu trees and tool bar 
menus. Review the following sections for an overview of the Paper Ballot screen.

Paper Ballot Menu Trees

Like the main ElectionWare screen, Paper Ballot contains its own collection of menu 
trees. Each of these menus enables you to access different features within Paper Ballot. 
Review the following sections for a brief overview of each of these menus.
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File Menu Options

Begin the ballot creation process on the File menu. From 
this menu you can access the New Document Wizard, as 
well as the New Document from Template features. This 
menu also contains options for saving, opening, updating 
the database, and printing your ballots. When finished 
with your ballot, you can also use the File menu to open 
recently saved ballots, or to exit Paper Ballot completely. 

Edit Menu Options

You can choose from the following options on the Edit menu:

 Undo – undoes the last option.

 Redo – redoes the last option.

View Menu Options

Paper Ballot’s View menu enables you to change options 
relating to both ballot appearance, as well as the appearance 
of the Paper Ballot window itself. Use the zoom features to 
change the size of the ballot displayed in the ballot preview 
pane. Use options such as Mark Numbers and Indicate 
Ballot Errors to change how information relating to ballot 
marks or errors are displayed in the ballot preview pane.

Options such as Tooltips, Message Pane Settings, Toolbar, 
and Status Bar enable you to change how certain aspects of 
the Paper Ballot window are displayed. 
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 Paper Ballot Formatting Menus

In Paper Ballot, use the commands on the Ballot, Style 
Sheets, and Frames menus to design the ballots for your 
jurisdiction. 

Ballot menu commands control the general formatting rules 
for all of your ballots. From this menu, you can select the 
ballot layout types and their individual options. These options 
include ballot setup, graphics and text options, font 
substitutions, multi-sheet setup, default languages and scanning your ballots for errors.

Use Style Sheets commands to format individual 
components of an election definition file from Capture. For 
example, format an office style sheet to control how the 
office information from your election database appears on 
your ballots. 

Use the Frames feature to place external text or graphics on your 
ballots. You can create ballot text in Paper Ballot or Capture. 

After you format ballots, you can use Paper Ballot layouts to print 
ballots directly from your PC or save your ballot images as Portable Document Format 
(PDF) files for bulk printing by ES&S Ballot Services or a partner printer.

Caution:  When formatting ballots and using any ES&S DS200 ballot stamping options, 
keep in mind the placement of the stamp on the bottom center of the reverse side of the 
ballot, regardless of the orientation in which the ballot was scanned.

Reference: See Write-in Votes in Chapter 6: Election Day Tasks of the ES&S DS200 System 
Operator Guide for more information about the Write-in Stamp.
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Warning:  If using any ES&S DS200 stamping options, ES&S recommends that you do not 
allow any votable positions at the top and bottom center position of the ballot (see figure 
below). This space on both sides of the ballot will be used for the DS200 stamp.
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Help Menu Options

At any time while working with Paper Ballot, you can access this 
document from the Help menu. Use Help to open the Paper 
Ballot PDF file in a separate window. Here you can read this document in its entirety, or 
simply search for and review specific sections of the document. To access this document 
from the Help menu, click User Guide.

In addition to this document, the help menu also enables you to access the 
ElectionWare help system. The ElectionWare help system enables you to search for 
individual topics regarding Paper Ballot or any of the other modules within 
ElectionWare. To access this feature, click Help Contents.

Paper Ballot Toolbar

Similar to the main ElectionWare window, Paper Ballot contains its own toolbar with 
easy to access symbols. This toolbar can be enabled or disabled from the View menu, 
but is defaulted to be enabled. Icons included on the tool bar are broken into sections. 
These sections include  Ballot Creation and Save Symbols,  Print Symbols,  Utility 
Symbols, Zoom Symbol,  Ballot Scan Symbols, and the  Help Symbol. 

Review the following sections for more information regarding usage of the toolbar.

Ballot Creation and 
Save Symbols

The far left side of the toolbar 
contains the ballot creation and 
save symbols. Icons included in 
this section are New document 
wizard, Open, and Save. These 
symbols offer shortcuts to 
available menu tree options found 
in the File menu.

Ballot Creation and Save Symbols

Icon Action Name Description

New Document 
Wizard/New 
Document from 
Template

Create a new 
ballot layout, or 
create ballot 
layout using a 
previously saved 
template.

Open

Open a 
previously saved 
ballot layout 
project.

Save

Save the current 
ballot layout 
project.
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Print Symbols

To the right of the ballot creation 
and save symbols are the print 
symbols. Symbols included in this 
section are Print Preview and 
Print. These symbols offer 
shortcuts to available menu tree 
options found in the File menu.

 Utility Symbols

To the right of the print symbols 
are the work pane utility symbols. 
Icons included in this section are 
Mark Numbers, Target 
Encroachment, Content Outside 
Cell, and Show Tooltips. These 
symbols offer shortcuts to 
available menu tree options found 
in the View menu. 

Print Symbols

Symbol Action Name Description

Print Preview

Preview the print 
layout of the 
selected ballot.

Print

Print the layout 
of the selected 
ballot.

Finalize Ballot 
Layout

Finalizes ballot 
layout for 
succeeding steps.

Work Pane Utility Symbols

Symbol Action Name Description

Mark Numbers

Enables/Disables 
mark numbers in 
the work space.

Target 
Encroachment

Enables/Disables 
target 
encroachment 
errors in the 
work space.

Content Outside 
Cell

Enables/Disables 
content outside 
cell errors in the 
work space.

Show Tooltips

Show Paper 
Ballot Tooltips.
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Zoom Symbol

To the right of the work pane 
utility symbols are the zoom 
symbols. Icons included in this 
section are Zoom Out, Zoom 
Level, and Zoom In. These 
symbols offer shortcuts to 
available menu tree options found 
in the View menu. 

Ballot Scan Symbols

To the right of the zoom symbols 
are the ballot scan symbols. Icons 
included in this section are Scan 
current ballot style for errors, 
and Scan all ballot styles for 
errors. These symbols offer 
shortcuts to available menu tree 
options found in the Ballot menu. 

Grid Overlay Symbol

To the right of the ballot mode 
symbols is the Display grid 
overlay symbol. This symbol 
displays a grid overlay over the 
ballot in the work pane. 

Help Symbol

The far right side of the toolbar 
contains the help symbol. This 
symbol opens the ElectionWare 
help system. 

Zoom Symbols

Symbol Action Name Description

Zoom Out

Reduces the size 
of the ballot in 
the work pane.

Zoom Level

Displays the 
current zoom 
level, and allows 
adjustment via 
the drop-down 
menu.

Zoom In

Increases the size 
of the ballot in 
the work pane.

Ballot Scan Symbols

Symbol Action Name Description

Scan current ballot 
style for errors

Scans the 
displayed ballot 
style for errors.

Scan all ballot 
styles for errors

Scans all ballot 
styles in the 
election for 
errors.

Grid Overlay Symbol

Symbol Action Name Description

Display grid 
overlay

Enables or 
disables the 
displayed grid 
overlay in the 
work pane.

Help Symbol

Symbol Action Name Description

Help

Opens the 
Electionware 
help system.



 Chapter 3: Ballot Management 18

EVS5200_DOC_SOP_EW03Design
 Software Version 4.6

 Published: April 25, 2014

Chapter 3: Ballot Management

The Paper Ballot portion of ElectionWare’s Design module uses the information entered 
in Capture to create ballots for your election. Paper Ballot utilizes these files in 
conjunction with specific options you select to create ballot styles that meet the needs 
of your jurisdiction. 

Additionally, Paper Ballot enables you to create three separate ballot layout types for 
your jurisdiction. These ballot types are Grid-Landscape, Grid-Portrait, and Column 
Portrait ballots. 

Use the following sections to create ballot styles in Paper Ballot. 

Reference: If you wish to apply the template of a previously-created ballot style to a new 
ballot style, see Chapter 4: Ballot Template Management for instructions about creating a 
ballot style with a saved ballot template.

Important: Asian fonts will not display without the proper fonts installed. 

• To view Chinese characters correctly, verify that the PMingliU font is 
installed in Windows.

• To view Korean characters correctly, verify that the Batang font is installed 
in Windows.

Verify: Ballot layout types are jurisdiction specific. Before selecting a ballot layout type, check 
with your state or local election official for confirmation on the type utilized by your 
jurisdiction.
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Ballot Glossary 

The following examples give a brief anatomical summary for the three ballot layout 
types created in Paper Ballot:
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New

Menu Items found here enable you to create new ballots. By utilizing either the New 
document wizard, or the New document from template options, you can create new 
ballots using only the information already entered in the Capture module, or that 
information in conjunction with previously created ballot templates. For further 
information regarding these topics, review the information below.

Important: Use of any color near the black check marks or timing tracks, should be tested 
on the hardware to be used in the election. Testing will help verify that the color usage will 
not cause scan validation errors.
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New Document Wizard

The new document wizard enables you to create new ballot styles in a simple three-step 
process. In the first step you select the ballot layout type you wish to use. The second 
step enables you to select the size of the ballot. And the third and final step, enables 
you to review your settings and create a draft of the ballot based on the settings you 
have chosen. More in depth information about using the new document wizard is listed 
below:

1. On the File menu and click New. 

The New Document-Step 1 window will appear:

2. From the available options, select 
Default or Best Practices for your ballot 
type. A default ballot is a basic template 
that only incorporates your current 
election data. A best practices ballot is a 
more complex ballot that contains 
instructional text and more refined layout 
options already in place.

From this screen, you also have the 
option of importing and/or exporting 
ballot (.dst) files. 

• To import a ballot (.dst) file, click the 
Import button to the right of the Load Template section of the screen. Once the 
explorer window appears, browse to the location of the desired file and click 
Open. The imported ballot (.dst) file will now appear in the Load Template 
section of the screen.

• To export a ballot (.dst) file, click the Export button to the right of the Load 
Template section of the screen. Once the explorer window appears, browse to 
the location that the (.dst) file will be stored and click Save.

Reference: If you are selecting a Column-Portrait ballot, 
you may also click the Template button at the lower right 
side of the window. For more information on using column 
templates with the Column-Portrait ballot, see Working 
With Column Templates.
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From this screen, you can also delete any added ballot templates by clicking the 
Delete button.

You can also select a specific ballot template to set as default by selecting the 
desired template and then clicking Set as Default. 

3. When finished, click Next to continue.

The New Document - Step 2 window will 
appear: 

4. In the Ballot Type box, click on a ballot 
type option to view a preview of the 
ballot. An example of each ballot type 
will appear in the box to the right of the 
Ballot Type box.

• If you utilize the Column - Portrait 
layout type, you also have the option 
of selecting the number of columns 
on the ballot. To do so, click the 
Column Layout button beneath the 
ballot preview.

When the Select Column Layout 
window appears, select the 
appropriate number of columns 
from the left-hand portion of the 
screen. As with the previous 
window, a preview of the ballot 
template will be displayed to the 
right of your selection.

When finished, click OK to 
continue.

5. Click Next to continue. 

Note: The Default and Best Practices templates can not be deleted.
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The New Document - Step 3 window 
will appear.

6. In the Ballot Size box, select the size 
of the ballot you will use. Each ballot 
size provides the number of ovals 
that can appear on a ballot. 

7. In the Target Type box, select the 
type of voting target that will appear 
on the ballot. 

8. In the Target Position box, select from Upper Left or Upper Right, and Lower Left 
or Lower Right to choose where you want the voting target to appear in relation to 
the candidate on a ballot.

9. Click Next to continue. 

The New Document - Final Step 
window will appear: 

10. From this window, review your 
selections before finishing. If you 
wish to change any of the settings in 
this window, click Back. 

11. If you want to abandon the ballot 
wizard without opening a document, 
click Cancel to close the New 
Document wizard window.

12. If the settings in the Final Step 
window are correct, click Finish. Your 
ballot selection will appear in the 
Paper Ballot Work pane.

Note: Oval is currently the only 
option available in this version of 
Electionware.
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Open

If you wish to continue the creation of an existing ballot, 
instead of creating a new ballot you can open a 
previously saved ballot from the File menu.

To open a saved ballot, follow the steps listed below:

• From the File menu, click Open. 

The Open Layout Window appears.

13. Previously saved Ballot Layouts are 
listed in the Open Layout window. 
Left-click on the appropriate ballot 
layout to select it.

14. Click OK to open the ballot layout. 
Or, click Cancel to close the Open 
Layout window.

Note: Once a ballot has been saved, this option opens 
automatically when starting Paper Ballot.
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Close

At times during the ballot creation process, you may find 
it necessary to close the ballot you are currently working 
on. To do so, from the file menu, click Close.

Save

The Save feature enables you save your ballots at any 
time. While you are working on your ballot layout, save 
your work often. 

Take the following steps to save your ballot layout: 

1. From the File menu, click Save. 

Note: Any unsaved ballot changes will be lost.

Note: If the ballot has previously been saved, no 
further steps are required when saving your ballot. The 
following steps only indicate those steps necessary for 
saving a ballot for the first time.
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The Save Layout As window appears.

2. Enter the name of the ballot file in 
the Layout Name field. 

3. Click OK once the save name is 
entered to save your ballot. 

Save As

The Save As feature enables you to save a ballot under a 
different name. Use the following steps to save a ballot 
using the Save As feature.

1. From the File menu, click Save As.

Reference: You can also use the 
Paper Ballot toolbar to save your 
ballots. See Paper Ballot Toolbar 
for more information.

Reference: See Steps 2 and 3 of the Save section for 
more information on completing the Save As process.
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Chapter 4: Ballot Template Management

At any time during the ballot creation process, you can save your ballot layout and use it 
as a template for future elections. Use the following sections to utilize ballot template 
features: 

Load Template

If a ballot layout was saved as a template, you will use 
the Load Template feature to load the desired ballot 
template.

1. From the File menu, select Load Template. 

The Load Template window appears:

2. Select the ballot template file you 
want to load. 

3. Click OK. The template will appear 
in the Paper Ballot work pane.

Note: If a ballot is already open, Paper Ballot will 
prompt you to verify that you wish to abandon all 
unsaved changes before opening the ballot template.

Note: The template contains the 
basic format and layout design of 
the ballot. The data from the 
previous ballot will be replaced 
with the data from the current 
election. 

Reference: You can also import, export or set ballot templates from this window. See  New 
Document Wizard for more information on importing and exporting ballot templates.
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Save As Template

In preparing for future elections, you might wish to save 
ballot layouts as templates. Saving a ballot layout as a 
template stores the shell ballot and style sheet 
information, while allowing new race and candidate data 
to be incorporated in future elections. To save a ballot 
layout as a template, follow the steps below.

1. From the File menu, select Save as Template. 

The Save Template As window 
appears.

2. Enter the name of the ballot 
template in the Layout Template 
Name field. 

3. Click OK to continue. 

Note: Although Paper Ballot saves the ballot layout as a template, this feature only stores 
the ballot template data in the Electionware database. To save your ballot layout as a 
template file, use the Save Template to File feature instead.

Reference: You can also import, export or set ballot templates from this window. See  New 
Document Wizard for more information on importing and exporting ballot templates.
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Load Template From File

If you have saved a ballot layout as a template file, you 
can use the Load Template From File feature to load 
the ballot template. To load a template file, use the 
following steps:

1. From the File menu, click Load Template From File.

2. When the browser window appears, locate the 
desired template (.dst) file and click Open.

3. If the template (.dst) file is linked to another election, 
Paper Ballot may warn you if a template was created 
from a different election or the same, but older 
version. 

Your ballot selection appears in the Paper Ballot 
Work pane.

Save Template To File

At times you may want to save a ballot template as a file, 
rather than save it as a template stored in the 
ElectionWare database. To do so, use the following 
steps:

1. From the File menu, select Save Template to File.

The Save As window appears.

2. When the browser appears, enter the template 
filename in the Filename field and click Save. 

A ballot template (.dst) file is saved in the location 
you selected.
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Chapter 5: View Menu

Use the options under the View menu to adjust the appearance of ballots in the work 
pane. These adjustments include the ability to zoom in or out of the current view, view 
the mark numbers on the ballot, whether or not to view tooltips, and choosing different 
ballot errors to indicate.

In addition to these options, from the View menu you can also select options which 
affect certain aspects of how Paper Ballot window is displayed. These options include 
adding or removing the tool and status bars from the main Paper Ballot screen.

Review the following information for details about the different options listed in the 
View menu.

Zoom Features

You can use the Zoom features in Paper Ballot to zoom in our out on the ballot in the 
work pane. To use the Zoom features, use the steps below:

1. From the View menu, point to Zoom 
and click the scaling option you wish to 
select. The ballot view will increase or 
decrease in size.

If applicable, you can also customize the zoom 
level by selecting Custom from the Zoom 
sub-menu. The Custom Zoom Factor window 
appears: 

To select a custom size to view, left-click and 
hold down on the bar and slide the bar to the 
appropriate setting. 

Note: The larger the percentage you 
select, the larger the ballot preview 
will appear on your screen.
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2. Click OK to keep the adjusted zoom level. 

Mark Numbers

Tabulating machines use black check and timing marks to read important information 
from ballots. Although displaying mark numbers is not necessary for proper tabulation, 
viewing mark numbers in the work pane enables you to easily locate oval positions on 
the ballot.

You can enable or disable mark numbers by pointing to the 
View menu and clicking Mark Numbers. 

The mark numbers will appear in the work pane.

Reference: For more information regarding zoom features and the toolbar, see Zoom 
Symbol.

Caution: Remember to deactivate mark numbers prior 
to printing your ballots. Failure to do so may cause 
errors when tabulating ballots.

Reference: For information regarding mark numbers 
and the toolbar, see Utility Symbols.
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Grid Display

By using the Grid Display command, you can show and hide the grid overlay on the 
ballot design. When selected, the grid overlays the ballot design and makes it easier for 
you to line up the oval targets.

You can enable or disable the grid display by pointing to the 
View menu and clicking Grid Display. 

The grid display appears in the work pane.

Tooltips 

If the Tooltips option is active, when your mouse hovers over a cell, the contents and 
style sheet name of that cell will appear in a pop-up. Enabling tooltips allows you to 
quickly locate style sheet information for ballot elements.

You can enable or disable tooltips by pointing to the View 
menu and clicking Tooltips. 
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Tooltips will appear in the work pane.

Changing the Message Pane Settings

Use the Message Pane Settings feature to change settings to the message pane 
located at the bottom of the Paper Ballot window. Settings in this menu include 
suppressing duplicate messages, clearing messages when documents are opened, and 
clearing messages when a new ballot style is displayed in the message pane. To change 
the Message Pane settings, use the following steps:

1. From the View Menu, click Message Pane Settings. 

The Message Pane Settings window appears:

• To Suppress Duplicate messages in the 
message pane, click the Suppress 
duplicate messages check box.

• To clear messages when a new 
document is opened, click the Clear 
messages when a new document is 
opened check box.

• To clear messages when opening a 
new ballot style, click the Clear 
messages when a new ballot style is 
displayed check box.

2. To accept your settings, click OK.

• Or, to close the Message Pane Settings window without accepting your changes, 
click Cancel. 

Reference: For more information regarding tooltips and the 
tool bar, see  Utility Symbols.
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Displaying Ballot Errors in the Work Space

A ballot error occurs if ballot text overlaps a ballot target or extends outside the current 
cell. You can check for ballot errors by looking for a red box surrounding the affected 
text. 

View Target Encroachment Errors

A target encroachment error occurs when text overlaps the voting target area on a 
ballot. To view target encroachment errors in the work pane, use the following steps:

From the View menu, point to 
Indicate Ballot Errors and click 
Target Encroachment. 

Target encroachment errors are 
activated by default. To deactivate 
them, from the View menu, select 
Indicate Ballot Errors, then click 
Target Encroachment.

Target encroachment errors appear in the work pane.

View Content Outside of Cell Errors

A content outside of cell error occurs when the ballot text extends beyond the 
boundaries of a cell. You can check for this error using the Content Outside Cell option. 

Reference: For more information regarding target 
encroachment errors and the tool bar, see  Utility 
Symbols.
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From the View menu, point to 
Indicate Ballot Errors and click 
Content Outside Cell. 

Content outside cell errors appear in 
the work pane.

Toolbar

The tool bar displays symbols such as those mentioned in Paper Ballot Toolbar. The 
toolbar itself is located near the top of the Paper Ballot window. To display the Paper 
Ballot toolbar, use the following steps:

From the View menu, click Toolbar. 

The tool bar will appear at the top of the Paper Ballot 
window.

Note: Content outside cell 
errors are activated by default. 
To deactivate them, from the 
View menu, select Indicate 
Ballot Errors, then click 
Content Outside Cell.

Reference: For more information regarding 
content outside cell errors and the tool bar, see  
Utility Symbols.
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The default setting for the Toolbar is enabled. If you do not want the tool bar to appear 
on the Paper Ballot window, use the Toolbar option to disable it.

Status Bar

The status bar is located at the bottom of the Paper Ballot window. It displays 
information such as the ballot style number, type sequence split code information, sheet 
number, side of the ballot being viewed, and zoom level. To enable or disable the Paper 
Window status bar, use the following steps:

From the View menu, click Status Bar. 

The status bar appears at the bottom of the Paper Ballot 
window.

The default setting for the Status Bar is enabled. If you do not want the status bar to 
appear on the Paper Ballot window, use the Status Bar option to disable it.

Reference: See Paper Ballot Toolbar for more information about specific toolbar symbols.
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Chapter 6: Universal Paper Ballot Features

In Electionware’s Paper Ballot, you can select from the following ballot layout types:

 Column-Portrait

 Grid-Portrait

 Grid-Landscape

The available Style Sheet menu options vary according to the ballot layout type. The 
information in this chapter applies to all ballot layout types. See “Style Sheets” on 
page 83 for more information.

Font Settings Window

As you design the ballot, you can change font settings during several different steps. 
The Font window remains the same no matter what process you are trying to complete. 
If during the layout process you have questions regarding the Font window, please refer 
to this section for more detailed information.

The Font window enables you to select from numerous font formats. After selecting 
from any of the different options listed below, you can preview these selections by 
reviewing the Sample view posted in the lower right portion of the Font window.

1. From the window where the Font option is available, click Font. 

The Font window appears:

2. Select the desired font from the Font list.

3. To change the font style, select one from 
the Font Style list.

4. Change the size of your text by selecting 
from those sizes available in the Size list.

5. Under the Effects options, you can select 
from the following options:

• Strikeout - Places a line of text 
through the selected font.

• Underline - Places a line under the 
selected text.

• Double Underline - Places a double line under the selected text.

Note: The Underline and Double Underline options are mutually exclusive. Both cannot 
be selected simultaneously. However, they may both be left unselected.
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6. The font Color option enables you to select the desired font color for ballot text. 
Select the color of your choice from the Color drop-down menu.

7. From the Script drop-down menu, select how you want the font script to appear. 
Choices include Western, Hebrew, Arabic, Greek, Turkish, Baltic, Central 
European, Cyrillic, and Vietnamese.

Western is the default Paper Ballot script.

8. Click OK to accept the changes you have made and return to the previous window.

Panels

Panels, which are available on many of the style sheet windows, appear on the three 
ballot layout types. When adding panels to your ballot in later chapters, please refer to 
this section for more detailed information. See “Style Sheets” on page 83 for more 
information about ballot style sheets.

Any cell (Frame, Question, Office, Candidate, Heading, etc.) on your ballot can contain 
panels. The primary purpose of panels is to facilitate text in multiple languages, with a 
different language in each panel. Panels may be positioned either horizontal or vertical. 
A cell can contain two or more panels, with each panel positioned and numbered for 
content assignment from left to right (horizontal panels) or top to bottom (vertical 
panels) starting at one. 

Panel Construction Considerations

Consider the following construction tips when creating panels:

 A cell can contain panels along with content for the main cell. When both panel 
content and main cell content are used, the main cell content is assigned to panel 0. 
Care needs to be taken in how content is placed when using both main cell content 
and panel content together. Absolute positioned content in the main cell reference 
their positions on the main cell and will ignore the panels. 

 Paper Ballot will size and place the panels in between any top and bottom 
positioned items in the main cell. For horizontal panels, the height equals the main 
cell height minus any main top lines and minus any main bottom lines. For horizontal 
panels, the width is expressed as a percentage of the main cell width. Panels can be 
different widths. For vertical panels, panel height is expressed as a percentage of 
the main cell height minus top and bottom content in the main cell. Vertical panels 
can be different heights.

Reference: To create a customized color, click Custom, located at the bottom of the Font 
Color drop-down menu. For more information about creating custom colors, see Custom 
Color Settings. 
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Absolute positioned items in panels are referenced inside the calculated panel size. 
The text in panels, like text in a main cell, will continue flowing downward even 
though the panels have a height. The panel height is used when content is bottom 
positioned in the panel. 

Each panel inherits the margins from the main cell. For horizontal panels, the left-most 
panel uses the left margin setting and the right-most panel uses the right margin. 
The other margins (both margins for middle panels) are taken from the gutter width 
(gutter default is 1/16 inch). You can apply individual content margins on panel 
content. For vertical panels, the top panel uses the top margin and the bottom 
panel uses the bottom margin. The other margins (both margins for middle panels) 
are taken from the gutter width.

Each panel has its own rendering object and you can do almost any content in a 
panel that you can do in a cell. Panels can contain different content items from other 
panels. 

 You cannot use vertical centering when both main cell content and panels are 
present. You can use vertical centering if the cell contains only panels. In that 
scenario, each panel will vertically center within its own panel. The alternative would 
be to vertically center the largest panel and align the tops of the other panels to that 
if desired. 

 When using panels and you are using the ‘same line flag’ the content items for each 
panel must be contiguous in the content list. If you are not using the ‘same line flag,’ 
then any content can be entered in any order in the content list. Even with the ‘same 
line flag,’ panels do not need to be entered in strict panel order, just all the content 
items for a panel must be grouped together.

Add Panels

To add panels to a ballot:

1. From the window where the Panels option is available, click Panels.

The Panels window appears:

2. Click Add to add a panel to a style sheet.

Reference: See step 15 in  Return to the 
Write-in Style Sheet window for 
instructions on adding panels to a 
write-in style sheet.
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Panel Properties Window - Use the Panel 
Properties window to make changes to a new 
or existing panel on your ballot. To edit panel 
options:

3. Width Section - Choose the total 
percentage of the cell which the panel will 
span from the Width spin box. (Vertical 
panels will show height instead of width.)

4. Margins Section - Enter the panel margins 
in the Top, Left, Bottom, and Right fields.

5. Ruling Lines Section - Enter the width of the 
panel Ruling Lines in the Top, Left, Bottom, 
and Right fields.

6. Additional Information Section - Click the Background Color list and select the 
background color for the panel.

7. Click Reserve Panel for Write-In Recognition to enable write-in recognition for the 
panel. See “Write-in Style Sheet” on page 100 for more information about creating 
write-in recognition areas.

8. Click OK to accept your changes and return to the Panels window. 

Return to the Panels Screen - Upon returning to the Panels window, the panel you 
created will appear in the list. 

Once you have made all of the changes to your panel, click OK if you want to save the 
panel. Or, click Cancel to return to the style sheet window. 

Edit Panels

Once a panel has been added to a style sheet, you may find it necessary to edit that 
panel. To edit a panel you have already created, use the following steps.

1. From the window where the Panels option is available, click Panels.

Reference: To create a customized color, click Custom, located at the bottom of the 
drop-down menu. For more information about creating custom colors, see Custom Color 
Settings. 

Note: The Reserve Panel for Write-In Recognition option is only available when creating 
write-in panels.
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The Panels window appears:

2. To edit an existing panel, select one from the 
list and click Edit. 

Delete Panels

At times you may find it necessary to delete an existing panel from your style sheet. To 
delete a an existing panel, use the following steps.

1. From the window where the Panels option is available, click Panels.

The Panels window appears:

2. To delete an existing panel, select one from the 
list and click Delete. 

A prompt will appear confirming the deletion of 
the panel.

3. Click Yes to confirm the deletion and return to 
the Panels window. 

• Or, click No to cancel the deletion and 
return to the Panels window. 

Custom Color Settings

As you layout your ballots, there are several points where you can apply custom colors. 
The following steps will guide you through creating a custom color:

1. From the window where the custom color option is available, select Custom from 
the Background Color drop-down menu. 

Reference: See steps 3-7 of  Add Panels for 
more information regarding the Panels window.



 Chapter 6: Universal Paper Ballot Features 42

EVS5200_DOC_SOP_EW03Design
 Software Version 4.6

 Published: April 25, 2014

The Color window appears:

2. Select any of the Basic colors from the 
hexagonal grid in the left-hand portion of the 
window. The color you have chosen will be 
previewed to the right, and contrasted 
against the current color.

You can also select from various shades of 
gray by selecting the hexagonal gray boxes 
at the bottom of the screen.

To define and select an existing color, click 
the Select button. Using the dropper icon, 
you can select from any colors currently on 
your screen. As with the basic color selection, the new color is previewed and 
contrasted in the same location.

3. To further customize a color, click the Custom tab at the top of the window.

The Custom tab is displayed:

4. Point to the general color you want, and then 
move the target icon to the more specific 
color your desire. You can then fine tune your 
color selection by using either steps 4-6 to 
manually enter your hue, saturation and 
luminosity. Or steps 7-9, to manually enter 
your red, green, and blue color definitions.

Hue, Saturation, and Luminance Settings

5. Define the hue by entering a value in the Hue 
field. 

6. Define the saturation by entering a value in 
the Sat field.

7. Define the luminosity by entering a value in the Lum box.

Red, Green, and Blue Settings

8. Enter a value in the Red box to increase or decrease the amount of red.

9. Enter a value in the Green box to increase or decrease the amount of green.

Note: Any values entered in the Hue, Sat, or Lum fields will adjust the values entered in the 
adjacent Red, Green, or Blue fields.
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10. Enter a value in the Blue box to increase or decrease the amount of blue.

11. Once you are satisfied with your custom color selection, click Add Custom Colors to 
add your custom color to the Custom Colors section of the window:

12. Click OK to confirm your custom color selection.

Note: Any values entered in the Red, Green, or Blue fields will adjust the values entered in 
the adjacent Hue, Sat, or Lum fields.
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Chapter 7: Ballot Setup

The Ballot menu enables you to manage items such as Ballot Setup, Graphics, Text, 
Font Substitutions, Multi-sheet Setup, Default Language, and Scan For Errors. Each 
of these items will aid you in creating your paper ballots. For more information 
regarding the Ballot menu, review the following sections.

Before you begin your election layout, it is strongly advised that you verify that the 
office information and candidate name spellings are correct on your ballots.

Once you have verified that your office and candidate information are correct, be sure 
to save your ballot. 

Ballot Setup

The Ballot Setup feature is where you will begin creating your paper ballots. Using 
Ballot Setup, you will define your ballot’s characteristics, including but not limited to 
your Ballot Layout Type, Ballot Sheets, and number of Ballot Sheets. You can also use 
Ballot Setup to edit a ballot in progress if necessary. To learn more about Ballot Setup, 
review the following information.

1. From the Ballot menu, click Ballot Setup. 

Reference: See Save for further information about saving ballots. 
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The Ballot Settings window appears:

The Ballot Settings window enables you to 
select the basic layout features of your 
ballot. This window is where you will 
decide on the ballot layout type, ballot 
options, and number of ballot sheets. 
Note that the window is divided into three 
tabs, Ballot, Target, and Misc. Each tab 
contains its own set of options.

Ballot Tab

The Ballot tab is the default opening window for Ballot Settings. This tab allows you to 
enable or disable a number of options including the sidecard, registration crosshairs, cut 
marks, office headings, and whether candidates can float from column to column. From 
this tab, you can also add, edit, or delete sheets from your ballot. The following 
information details options found under the Ballot Tab.

2. Ballot Layout Type Section - In the Ballot Layout Type 
section, select from the following options:

• Grid-Landscape - Grid-Landscape ballots are 
ballots laid out in a grid, but in the landscape 
orientation.

• Grid-Portrait - Grid-Portrait ballots are ballots laid 
out in a grid, but in the portrait orientation.

• Column-Portrait - Column Portrait ballots are 
ballots laid out using a selected number of columns in the portrait orientation.

3. Ballot Options Section - The Ballot Options section changes depending on the 
ballot layout type selected in the previous step. From the Ballot Options section, 
select any of the following options: 

Note: The Ballot Layout type selected, changes the options available in the Ballot Options 
section.
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• Select Show Sidecard to display the side card on the ballot. The side card 
displays political parties and their logos.

The Show Sidecard option is only available for Grid-Landscape ballots.

• Select Registration Crosshairs to display the registration cross hair on the ballot. 
Registration crosshairs are used to verify that your ballots are within ES&S 
registration specifications.

• Select Cut Marks to display the cut marks on the ballots. The cut marks are used 
to guide you or your printer when your ballots are cut down to their appropriate 
size.

• Select Use Office Headings to display office headings on the ballot. Office 
headings are used to categorize contests (e.g. Federal, County, Municipal).

The Use Office Headings option is only available for Column-Portrait ballots.

• Select Allow Float to allow the same contest on one ballot style to appear in a 
different location than it does on another ballot style. This situation is caused by 
having a different number of contests on different ballot styles. Select the Allow 
Float option or, you will get a validation error that all like contests are not in the 
same location on every ballot style.

The Allow Float option is only available for Grid-Landscape ballots.

Target Tab

The Target tab is where you set options for voter targets on your ballot. Unlike the 
Ballot tab, the Target tab does not change with the ballot layout type selected. For 
more information on the Target tab, see the information below.

4. From the available tabs in the Ballot Settings window, select Target. 

The Target screen appears:

5. Appearance Section - From the Target 
Type drop-down menu, select the desired 
target type.

6. Select the appropriate color for the voting 
target from the Target Color drop-down 
menu.

7. Select the appropriate line thickness by entering a value in the Line Thickness field. 

Note: The Target Type option is not 
available in this version of Electionware. 
Because of this, the Oval target type is 
the only type available.

Reference: To create a customized color, click Custom located at the bottom of the Target 
Color drop-down menu. For more information about creating custom colors, see Custom 
Color Settings. 
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8. Position Section - The Target Position drop-down menu enables you to determine 
where the voting target appears on a ballot. Select Lower Right, Lower Left, Upper 
Right, or Upper Left from the Target Position drop-down menu to select the target 
position.

Misc Tab

The Misc (miscellaneous) Tab of the Ballot Settings window enables you to select 
options regarding mixed orientations, and applying watermarks to your ballot. Review 
the following steps to edit the miscellaneous settings: 

9. Mixed Orientation Section - Click the Swap Stubs on Landscape Sides, to have 
your ballot stubs swapped depending on which side of the ballot is landscaped 
(front or back).

10. Watermark Section - Select the Display Watermark option if you want your ballots 
to be overlayed with a watermark. For example, if you wanted to produce a number 
of demonstration ballots, you might use the watermark option to overlay the word 
SAMPLE over the entire ballot. 

11. If you choose to utilize a watermark on your ballots, click Watermark Settings to 
adjust the watermark’s settings.

Watermark Settings

The Watermark window appears:

12. Preset Section - From the 
Preset section, select a 
watermark to use from the 
drop-down menu. Options 
available are Test, Sample, 
and Specimen.

13. Click Apply to apply the 
watermark to your ballots.

14. Margins Section - Select 
margins for the watermark 
by entering values in the 
Top, Left, Bottom, and 
Right fields.

15. Additional Information 
Section - From the Z-Order drop-down menu, select whether the watermark will 
appear in the Foreground, or Background. 

Note: You may want to wait until after your ballots are completed to add a watermark. 
Also, unless the watermark is to be used on your Election Day ballots, be sure to save your 
ballots prior to adding a watermark. 
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16. Select the Vertically Center Content check box to vertically center the watermark 
on your ballot.

17. From the rotate drop-down 
menu, select the angle of 
rotation for the watermark. 
Select from 0, 90, 180, 270, 
and Diagonal.

18. Content Section - From the 
Content area, select an 
existing watermark to Edit, or 
Delete. Or, select Add to add 
content to your watermark.
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Add Text to Watermark Content

The Watermark Content window appears:

19. Content Type Section - 
Data radio button is not 
available. 

In the Content Type 
section, you can enter 
additional text to the 
watermark. To add text to 
the watermark, follow steps 
20 - 29.

Add Text to a Watermark

20. In the Content section, click Add to add text to the watermark. 

The Watermark Content window appears:

21. Content Type Section - 
Click the Text radio button 
and either enter the text 
you wish to appear on the 
watermark (for example, 
Demonstration) or select 
the appropriate text item 
from the drop-down menu. 

22. Additional Information 
Section - Enter the text 
margins (in inches) in the 
Left Margin and Right 
Margin fields.

If an Absolute value is selected in the Position drop-down menu, the Margin fields 
are absent from the Additional Information section.

23. Content Properties Section - Click the Position drop-down menu and select where 
you want the text to appear. 

• Select Top to place the text at the top of the watermark. 

• Select Bottom to place the text at the bottom of the watermark. 

• Select Absolute/Left Top, Absolute/Right Top, Absolute/Left Bottom, or 
Absolute/Right Bottom to enable the Left or Right, and Top or Bottom Offset 
fields. Enter your settings (in inches) in the fields. The entries made in these 
fields will determine how far from the left or right, and top or bottom of the 
watermark the text will appear.
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• Select the Same Line check box to include all of your data on the same line as 
the previous content item. For instance, if you wanted both the additional data 
content and additional text content both to appear on the same line, you would 
click Same Line for the additional text content. This flags the system that you 
want to merge the two items on the first line. 

Same Line is not available if an Absolute value is selected from the Position 
drop-down menu.

24. Click the Line Size drop-down menu and select the height of the area used for your 
text. If you choose Font Size, the text will appear with standard spacing between 
the two lines of content. If you select a smaller line size, the two lines of content will 
be closer together. If you select a larger line size, the two lines of content will be 
farther apart.

25. To rotate the text, click the Rotate drop-down menu and select the appropriate 
angle. Options available are 0, 90, 180, 270.

26. Click the Alignment drop-down menu and select the appropriate text alignment 
option (for example, Right, Center, or Justify).

This option is not available if an Absolute value is selected from the Position 
drop-down menu.

• Text wrapping is automatically activated. If you want to turn off text wrapping, 
select the No Text Wrap check box.

This option is not available if an Absolute value is selected from the Position 
drop-down menu.

• Click the Language list and select the appropriate ballot language. Languages 
are dependent upon the information entered in Capture.

27. To change the appearance of the displayed text, click Font and make the 
appropriate changes. 

28. Click the Font Kerning drop-down menu and select an appropriate value. The 
greater the positive number, the farther apart the content will appear. The greater 
the negative number, the closer together the content will appear.

29. Click OK to accept your changes. The additional data content will appear in the 
Content section in the Watermark window.

Note: If the Content Rows are positioned as TOP, then you should apply the Same Line 
options to the second of the two Content Rows you want to combine. If the Content Rows 
are positioned as Bottom then you should apply the Same Line options to the first of the 
two Content Rows you want to combine.

Caution: If you place additional items on the same line, you must use different alignments 
(Left, Center, or Right), for each of them. Failure to do so will make the two items overlap 
in the style sheet.

Reference: Refer to the Font Settings Window heading for more detailed information 
regarding changing your font settings.
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Chapter 8: Ballot Sheet Management

Ballot sheets are sheets that are composed of additional ballot data, but still affiliated 
with the original ballot style. For example, if the amount of information on a particular 
ballot style is too great, you might consider using additional ballot sheets. The amount 
of additional sheets is conversely related to the amount of data attributed to a particular 
ballot style. Therefore even though a ballot may be composed of more than one sheet, 
all of the sheets are still considered to be part of the same ballot.

Use the following sections for more information on adding and editing ballot sections.

Add Ballot Sheets

1. From the Ballot menu, click Ballot Setup.

The Ballot Setup window appears.

2. From the Ballot Sheets section of the 
Ballot Settings window, click Add.
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The Sheet Settings window appears.

As noted in the diagram below, the configuration of the sheet settings window changes, 
depending on the ballot layout type selected. Whereas the left hand portion of the 
window remains static, options in the right portion of the window vary. Review the 
following sections to configure Sheet Settings options.
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Sheet Settings Window - Universal Options

1. From the Ballot Settings window, click Add or select an existing sheet and click 
Edit. 

The Sheet Settings 
window appears:

2. Sheet Name Section - Enter a name for the sheet in the Sheet Name field.

3. Sheet Size Section - Choose a sheet size, (in inches) from the Sheet Size drop-down 
menu. Sheet size only available on first sheet as all sheets must be same size.

The Sheet Size option is only available when editing an existing sheet.

4. Stub Height Section - Enter the size of ballot stubs, (in inches) in the either the Top 
Stub or Bottom Stub fields if applicable.

5. Orientation Section - Choose either a Landscape or Portrait orientation from the 
Orientation drop-down menu.

6. Margins Section - Input your ballot margins, (in inches) in the Top Margin and Left 
Margin fields. 

Sheet margins are defaulted to a one-quarter inch setting for both top and left 
margins.

7. Ruling Lines Section - Under the Ruling Lines section, enter the width of the ballot 
border, (in inches) in the Top, Left, Bottom and Right boxes.

Sheet ruling lines are defaulted to .006 inches for the top, left, bottom, and right 
ruling lines.

Verify: Ballot Stubs are optional, and are dependent on local and state requirements. If you 
have questions regarding whether stubs are required in your jurisdiction, please contact 
your state or local election official.

Note:  Selecting a Grid‐Landscape ballot, in conjunction with the Portrait orientation will 
cause the ballot to switch to a portrait perspective.

You can select differing orientations for both the front and backsides of the ballot. For 
example, you can select a Grid-Landscape ballot for your ballot type, and then apply a 
landscape orientation to the front and a portrait orientation to the back.
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8. Mark Suppression - Under the Mark Suppression section, you can select whether to 
suppress timing and code channel marks by selecting the appropriate check boxes. 

Suppression of the timing and code channel marks would be an option to printing 
sample ballots, or posting ballots to a public forum such as the newspaper or web.

When to Suppress

Select one of the following from the drop-down menu:

• No Votable Position Exists – suppresses timing and code channel marks on the 
ballot if there are no votable positions.

• Suppress Always – always suppresses timing and code channel marks on the 
ballot whether or not there are votable positions.

Grid-Landscape Sheet Settings Options

The Sheet Settings Window contains layout related options that are dependent on the 
ballot layout style being used. The right portion of the sheet settings window changes 
depending on the ballot layout chosen. The following information is specific to only the 
Grid-Landscape sheet settings.

Office Rows Section - The Office Rows section of the Sheet Settings window contains 
three options to choose from: Add, Edit and Delete. For more information regarding 
the Office Row settings, see the information below:

Reference: Because the left portion of the Sheet Settings window remains static, the 
information covered here is specific to the Grid-Landscape Sheet Settings. For information 
on using the universal sheet settings, see  Sheet Settings Window - Universal Options.
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Adding or Editing an Office Row

1. To add an Office Row to the ballot layout, click Add. Or, to edit an existing Office 
Row, select an office row from those listed, and click Edit. 

The Office Row window appears:

Office Row Window: Layout Tab

The Layout tab of the Office Row window enables 
you to edit positional aspects of the office row. 
These options include the Office Row Name, Office 
Title Row Position, Candidate Row Position, 
Write-in Row Position, and Fill With Empty Offices 
options. See the following sections for more 
information: 

2. Office Row Name Section - Enter or edit the 
office row name in the Office Row Name field.

3. Office Title Row Position Section - Select the starting column for the office title 
from the Start Column drop-down menu.

4. Select the column label for the office title from the Column Label drop-down menu.

5. Select the starting row for the office title from the Start Row drop-down menu. To 
have the office title appear at the start of the next available row, select Next 
Available.

6. Select the span of the row height for the office title from the Row Height 
drop-down menu.

7. Candidate Row Position Section - Select the candidate starting row from the Start 
Row drop-down menu. To have the candidate appear at the start of the next 
available row, select Next Available.

8. Select the span of the candidate cell height from the Cell Height drop-down menu.

9. Write In Row Position Section - Select the Write-In starting row from the Start Row 
drop-down menu. To have the Write-In appear at the start of the next available row, 
select Next Available.

10. Select the span of the Write-In cell height from the Cell Height drop-down menu.

11. Fill With Empty Offices Section - Select a row to fill with empty offices from the Fill 
to Column drop-down menu.
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12. Select the office style sheet for empty offices from the Office Stylesheet drop-down 
menu. Using the Fill With Empty Offices option will fill up to the selected column 
with empty offices.

Office Row Window: Parties Tab

The Parties tab of the Office Row window 
enables you to edit attributes that relate to how 
the selected party is displayed on your ballot. 
See below for further information relating to the 
Office Row Window’s Parties Tab:

1. Select the party you wish to edit, and click 
Edit. 

The Party Properties window appears.

The name of the party you are editing will 
appear in the upper left hand corner of the 
Party Properties window.

2. Select “Party is used in the office row,” if you 
want the party to display on the ballot.

The default for “Party is used in the office 
row” is enabled. To disable this option, 
deselect it by clicking the appropriate check 
box.

3. Select “Party shares a split cell with the next 
party,” if you want candidates from two parties to share a row.

4. Use the radio button to select from the following options:

• Select “Party is always shown in sidecard,” if you want the party to be 
displayed in the sidecard. 

The default for “Party is shown in sidecard” is enabled. Select one of the other 
available options to deselect it.
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• Select “Party is shown in sidecard when candidates are present” if you want 
the party to be displayed in the sidecard only when there are candidates for the 
party.

• Select “Party is not shown in sidecard,” if you do not want the party to be 
displayed in the sidecard.

• Select “Party is not shown in sidecard” to remove party affiliations from the 
sidecard. If this option is selected, the “Place party candidates on the same 
row as” drop-down menu becomes active. From the drop-down menu, select 
the party affiliation row where you want to place the party candidates.

5. Click OK to accept your changes and close the Party Properties window.

6. After returning to the Office Row window, click OK to accept your changes and 
return to the Sheet Settings window.

Return to the Sheet Settings Window

Upon returning to the Sheet Settings window, if you added an Office Row to the 
existing layout, it will now appear in the Office Rows section of the Sheet Settings 
window.

Deleting an Office Row

1. To delete an existing Office Row, select one of the office rows listed and click 
Delete. 

2. A prompt appears asking you to confirm your deletion. Click Yes to confirm your 
deletion and return to the Sheet Settings window. 

• Or, click No to cancel your deletion and close the prompt. 

Adding or Editing a Question Row

Question Rows Section - The Question Rows section of the Sheet Settings window 
contains three options to choose from: Add, Edit and Delete. For more information 
regarding the Question Row settings, see the information below:

When adding a Question Row to a Grid-Landscape ballot, the question row will always 
be on the back. Make sure to select the Back tab before adding the question row.

1. Click the Back tab.

2. To add a Question Row to the ballot layout, click Add. Or, to edit an existing 
Question Row, select an office row from those listed, and click Edit. 

The Question Row window appears:
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Question Row Window

The Question Row window enables you to edit 
positional aspects of the question row. These 
options include the question row name, question 
row start column, question row start row, and 
height of the question row. See below for further 
information: 

3. Question Row Name Section - Make changes to, or enter a new question row name 
in the Question Row Name field.

4. Question Row Position Section - Select the starting column for the question row 
from the Start Column drop-down menu.

5. Select the starting row for the question row from the Start Row drop-down menu. 
To have the question appear at the start of the next available row, select Next 
Available.

6. Select the desired span of the question’s row height from the Row Height 
drop-down menu.

7. Click OK to accept the changes you have made, and close the Question Row 
window.

Return to the Sheet Settings Window

Upon returning to the Sheet Settings window, if you added a question row to the 
existing layout, it will now appear in the Question Rows section of the Sheet Settings 
window.

Deleting a Question Row

1. To delete an existing Question Row, select a Question Row from those listed, and 
click Delete. 

2. A prompt appears asking you to confirm your deletion. Click Yes to confirm your 
deletion and return to the Sheet Settings window. 

• Or, click No to cancel your deletion and close the prompt.
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Adding or Editing a Ballot Title

The Ballot Titles section of the Sheet Settings window contains three options to choose 
from: Add, Edit and Delete. 

For more information regarding the Ballot Titles settings, see the following steps:

1. To add a Ballot Title to the ballot layout, click Add. To edit an existing Ballot Title, 
select an ballot title from those listed, and click Edit. 

The Ballot Title window appears.

Ballot Title Window

From the Ballot Title window, you can alter many 
of the textual aspects relating to the ballot title. 
For more information regarding the Ballot Title 
window, see the information below:

2. Title Text Section - You can choose to use the 
existing election name as your ballot title, by 
selecting the Election Title option. Or, you can 
enter a custom ballot title by selecting the 
Custom Text option and entering a name in 
the adjacent field.
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3. Font Section - From the Font Section, click Font to change the font characteristics 
of the ballot title.

Return to the Ballot Title Window

Upon returning to the Ballot Title window, the font adjustments made in the previous 
section will appear adjacent to the Font button.

4. Title Location Section - Select the Ballot Title start column, by selecting the column 
number from the Start Column drop-down menu.

5. Choose the width of the Ballot Title by selecting from the Width drop down menu.

The Start Column and Width options work together to create the total length of the 
Election Title. The start column represents the column that the election title starts over, 
and the width represents the column that it ends over. For example, to make the 
election title span the entirety of the ballot length, you would select the start column as 
1, and the width as the highest number available.

6. You can determine the Ballot Title’s alignment by selecting from the options in the 
Align drop-down menu.

• Left: Select Left to align the ballot title to the left.

• Center: Select Center to center the ballot title.

• Right: Select Right to align the ballot title to the right.

7. Additional Information Section - Select the background color for the Ballot Title 
from the Background Color drop-down menu.

8. Click OK to accept your settings and return to the Sheet Settings window.

Reference: See Font Settings Window for more information on using the Font Window. 

Reference: To create a customized color, click Custom, located at the bottom of the 
Background Color list. For more information about creating custom colors, see Custom 
Color Settings. 
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Return to the Sheet Settings Window

Upon returning to the Sheet Settings window, if you added a ballot title to the existing 
layout, it will now appear in the Ballot Titles section of the Sheet Settings window.

Deleting a Ballot Title

1. To delete an existing ballot title, select one from those listed, and click Delete.

2. A prompt appears asking you to confirm your deletion. Click Yes to confirm your 
deletion and return to the Sheet Settings window. 

• Or, click No to cancel your deletion and close the prompt.

Review the changes you have made to the Sheet Settings window for both the front and 
back tabs. If you are satisfied with your changes, click OK to accept your settings and 
return to the Ballot Settings window.

• Or, click Cancel to reject your settings and close the Sheet Settings window. 

Grid-Portrait Sheet Settings Options

The following information is related to the Grid-Portrait version of the Sheet Settings 
Window. The options in the left hand portion of the window are universal, and remain 
the same no matter what layout type you choose. The right half of the window changes 
to reflect the type of ballot layout you have chosen. 

1. From the Ballot Settings window, click Add or Edit. 

The Sheet Settings window 
appears:

Note: If your election requires a two-sided ballot, be sure to apply format settings to the 
back sheet as well by clicking the Back tab in the Sheet Settings Window.

Reference: Because the left 
portion of the Sheet Settings 
window remains static, the 
information covered here is 
specific to the Grid-Portrait 
Sheet Settings. For 
information on using the 
universal sheet settings, see  
Sheet Settings Window - 
Universal Options.
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2. Layout Section - Select the contest type from the Place contests of type 
drop-down menu. From this menu, you can choose whether to format an office or 
question.

Layout Options

The layout options found in the Grid-Portrait version of the Sheet Settings window 
enable you to alter the layout of your ballot. Options include choosing starting locations 
for columns and rows, number of party columns, and the width of the party, office and 
write-in columns. For more information regarding these options, see the information 
below:

3. Layout Section: Office Selection - Enter the starting column for the office in the 
Start Column field.

4. Enter the starting row for the office in the Start Row field.

5. Enter the number of party columns for the office in the Number of Party Columns 
field.

6. Enter the span of the office column width in the Office Column Width field.

7. Enter the span of the party column width in the Party Column Width field.

8. Enter the span of the write-In column width in the Write-in Column Width field.

9. Layout Section: Question Selection - To add a question column to the ballot, click 
Add. Or, select an existing question column from the list and click Edit. 

The Column Properties window appears. 

Note: The Layout section changes, depending on whether Office or Question is selected 
from the Place contests of type drop-down menu.
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Column Properties Window

10. Select the start location of the question column from the 
Start drop-down menu.

11. Select the span of the question column from the Width 
drop-down menu.

12. Enter the question column margins, (in inches) in the Left 
and Right margin boxes.

13. Enter the ruling lines for the question column in the Top, 
Left, Bottom, and Right boxes.

Ruling lines are defaulted to .006 inches for the top, left, 
bottom, and right rules.

14. Select the background color for the question column 
from the Background Color drop-down menu.

15. Do one of the following:

• Click OK to accept your changes and return to the Sheet Settings window.

• Click Cancel to reject your changes and close the Column Properties window.

Return to the Sheet Settings Window

Upon returning to the Sheet Settings window, if you added a question column format to 
the existing layout, it will now appear in the Columns section of the Sheet Settings 
window.

Deleting a Ballot Question Column

1. To delete an existing column, select a question column from those listed in the 
Columns section and click Delete. 

A window appears requesting that you confirm the deletion. 

2. Click No to reject the deletion and close the confirmation window. Or, click Yes to 
confirm the deletion and return to the Sheet Settings window.

Reference: To create a customized color, click Custom, located at the bottom of the 
Background Color list. For more information about creating custom colors, see Custom 
Color Settings.

Note: If your election requires a two-sided ballot, be sure to apply format settings to the 
back sheet as well by clicking the Back tab.
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Column-Portrait Sheet Settings Options

The layout options found in the Column-Portrait version of the Sheet Settings window 
enable you to alter the layout of your ballot. Options include adding, editing and 
deleting columns, choosing from column templates, choosing whether to display 
column headings and choosing whether to suppress empty columns. For more 
information regarding these options, see the information below:

1. From the Ballot Settings window, click Add or Edit. 

The Sheet Settings window 
appears:

2. Columns Section - To add a column to the ballot layout, click Add. To edit an 
existing column, select an column from those listed, and click Edit. 

The Column Properties window appears.

Column Properties Window

The Column Properties window enables you to alter column 
settings on your ballot.

3. Select the start location of the column from the Start 
drop-down menu.

4. Select the span of the column from the Width 
drop-down menu.

5. Enter the column margins, (in inches) in the Left and 
Right margin boxes.

Note: Because the left portion of the Sheet Settings window remains static, the information 
covered here is specific to the Column-Portrait Sheet Settings. For information on using the 
universal sheet settings, see  Sheet Settings Window - Universal Options.

Note: Column width is defaulted to a setting of 8. If adding 
one or multiple columns to the ballot, be sure to reduce the 
width of the additional columns to a size that will allow all 
of the columns to fit on the ballot. Failure to do so will 
result in errors.
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6. Enter the ruling lines for the column in the Top, Left, Bottom, and Right boxes.

7. Select the background color for the column from the Background Color drop-down 
menu.

8. Click OK to accept your changes and return to the Sheet Settings window.

• Or, click Cancel to reject your changes and close the Column Properties window. 

Working With Column Templates

Column settings can be controlled by using templates. The ballot wizard in 
ElectionWare comes with several default column template ballots in multiple variations. 
These default templates can be edited to meet the needs of your election. To apply 
templates to your Column-Portrait ballot, follow the steps below:

1. To select a column template, click Templates. 

The Select Column Layout Template 
window appears:

2. Select the layout that suits your needs. 
The column layout options are shown 
below:

Reference: To create a customized color, click Custom, located at the bottom of the 
Background Color list. For more information about creating custom colors, see Custom 
Color Settings.

Note: If you use a column template, adding columns to the ballot will mean adjusting the 
width of the columns incorporated in the template.

For instance, if you choose to use a three column template, and then choose to add a 
fourth column, the widths of all columns must be edited to verify that the entirety of the 
four columns will fit on the ballot. Failure to adjust the columns will cause a warning 
indicating that the additional column will not fit on the ballot.

In addition, the default column templates can be edited, but any changes made will not be 
saved to the default template. Instead, you can save your ballot as a template by using the 
Save as Template feature.
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Column Template Options

3. Click OK to accept your selection and return to the Sheet Settings window.

• Or, click Cancel to reject your changes and close the Select Column Layout 
Template window.

4. From the margins section, select the margins of the column. Column margins are 
defaulted to zero, but can be added if desired. 

5. From the Ruling Lines section, select the ruling lines for the column. Column ruling 
lines are defaulted to a setting of .006. 

6. In the Background section, select the background color of the new column. 

7. Click OK to add the new column to the ballot.

8. Column Settings - Under the Column Settings portion of the Sheet Settings 
window, you can select whether you wish to use column headings, or suppress 
empty columns. 

• Click the Use Column Headings check box to use column headings on your 
ballot.

Note: If your election requires a two-sided ballot, be sure to apply format settings to the 
back sheet as well by clicking the Back tab.

Note: Columns on a ballot are not incorporated as individual constructs in Paper Ballot. 
Therefore, columns cannot be renamed or saved as individual entities. For example, if a 
fourth column is added to a three-column ballot, and the third column is deleted, the fourth 
column becomes the third column on the ballot.

1 Column 2 Columns 2 Columns 3 Columns
[single, double]

2 Columns
[double, single]

4 Columns 4 Columns
with Instructions

3 Columns
[single, single,

3 Columns
[double, single,

single]double]
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• Click the Suppress Empty Columns check box to exclude empty columns from 
your ballot.

Deleting a Column

1. To delete an existing column, select one from those listed, and click Delete. A 
prompt appears asking you to confirm your deletion. 

2. Click Yes to confirm the deletion and return to the Sheet Settings window.

• Or, click No to reject the deletion and close the confirmation window.

Note: Both the Use Column Headings and Suppress Empty Columns options are enabled 
by default. Deselect these options to disable them.
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Chapter 9: Graphics

Paper Ballot automatically imports the Party Graphics you add in Capture when you 
enter your election data. You can also import graphics into Paper Ballot using the 
Graphics option on the Ballot menu. Paper Ballot supports the following graphic file 
types: (.bmp), (.jpg), (.jpeg), (.png), (.gif), (.tif), (.tiff), (.ico).

Adding an Image 

1. On the Ballot menu, click Graphics. 

The Ballot Graphics window 
appears:

2. From the Ballot Graphics 
window, click Add. 

The Graphics Information window appears:

3. In the Image Description field, enter a 
description for the imported image. 

4. Click the Browse button next to the Image 
File Path field.

5. Browse out to the location where your 
images are stored, select the image you want 
to use, and click Open.

6. Click OK. 

The ballot image appears in a preview pane of the Graphics Information window.
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Edit Images

1. Click the Ballot menu and select Graphics.

2. Select the appropriate image from the Ballot Graphics window and click Edit. 

3. Enter any changes in the Graphics Information window. 

4. Click OK.

Delete Images

1. Click the Ballot menu and select Graphics. 

2. Select the appropriate image from the Ballot Graphics window and click Delete. 

3. Click OK.
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Chapter 10: Text

At several points in the layout process, you can use the Text Manager to create items 
such as instructions and other text-based information for your ballot. When using these 
text editors, it is necessary to know the substitution variables, text codes, and font 
codes to properly format your text. 

1. From the Ballot menu, click Text. 

The Text window appears:

Add Text Item

Use the following steps to add text items 
to your ballot layout:

1. From the Text window, click Add.

2. On the Text window, 
enter the text in the text 
area.

3. Click OK to keep the 
entered text, or, click 
Cancel to close the 
window and lose any 
unsaved changes.
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4. Click Close to close the Text window.

Import Text Items

Using the Import feature, you can import text items from other layout versions of an 
election, but not from other elections as each election has its own database, rather than 
re-entering them in ElectionWare. To import text items, complete the following steps:

1. From the Text window, click Import.

2. On the Select Layout window, select a 
layout from which to import the text.

3. Click OK to confirm the selection. 

4. On the Import Text window, select the text 
items to import from the list in the left side of the 
window.

5. Click OK to confirm the import, or click Cancel 
to abort the import and close the Import Text 
window.

Note: You must enter any translations for the English version of the text, using the 
language tabs at the top of the text editor.

Reference: While entering your text, utilize substitution variables, format codes, and font 
codes as necessary. See the tables under Substitution Variables, Text Format Codes, and 
Font Codes for more information.

Time Saver: You can also click Select All to select 
all of the text items, or Clear All to clear any and 
all selected text items.

Note: The imported text item’s name must be unique. If the text item shares its name with 
another text item in the election, you are prompted to change the name of the imported 
item before you can complete the import process.
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Edit Text Items

Use the following steps to edit text items already incorporated in your ballot layout:

1. From the Text window, click Edit.

2. On the text editor, make any necessary revisions to the existing text.

3. Click OK to keep the text revisions, or, click Cancel to close the text manager and 
lose any unsaved changes.

4. Click Close.

Delete Text Items

Use the following steps to delete text items:

1. From the Text window, select a text item and click Delete.

A message prompt confirms the deletion of the text item.

2. Click Yes to confirm the deletion and return to the Text window, or, click No to 
cancel the deletion and return to the Text window. 

3. Click Close.

Substitution Variables

Use the table below to enter substitution variables into the text editor, or in the Text 
content row of the Frame Content window. 

Substitution variables are codes that can be entered into text files. When viewed on a 
ballot, these variables substitute themselves for various information; dependent upon 
the selected variable. These variables, when applied correctly, enable your text to 
incorporate jurisdiction and other information relative to the current election. 

You can also display variables in other languages by placing language identifiers in front 
of the variable. For example: <es:GJURISDICTION> would pull from the Spanish 
language tab for the substitution.

Note: If you make a change to a text item, the change will appear in all frames where that 
text item is used.

You must edit any translations for the English version of the text, using the language tabs at 
the top of the text editor.

If the Text Item Name is changed, a prompt appears asking whether you wish to update all 
of the references in the current election. Click Yes to update all of the references and return 
to the Text window. Or, click No to cancel updating the references and close the prompt.
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For example: Offices for <GEONAME> would be displayed as Offices for Precinct One.

Note: Text Variables are not case sensitive, and can be entered in all lower case. You can 
type a variable in all lowercase and still have the output displayed in all uppercase by using 
the ‘^’ symbol in front of the variable. (For example: <^gjurisdiction>)

Text Variables

Name Usage Description

MERGE <MERGE> Date and Time of Capture Merge

GELECTIONDESCRIPTI
ON

<GELECTIONDESCRIPTION> Election Description

GELECTIONDATE <GELECTIONDATE> Election Date (YYYY-MM-DD)

GJURISDICTION <GJURISDICTION> Jurisdiction Name

DATETIME <DATETIME> Current Date and Time

VERSION <VERSION> Ballot Version

GAPPCODE GAPPCODE Ballot Side (e.g. Side 1 of 2)

GJurisdictionName <GJurisdictionName> Jurisdiction Name

GJurisdictionAbbr <GJurisdictionAbbr> Jurisdiction abbreviation

GELECDATEFMT <GELECDATEFMT (n)> Formatted election date

GTYPECODE <GTYPECODE> 2-digit type code

GSEQCODE <GSEQCODE> 4-digit sequence code

GSPLITCODE <GSPLITCODE> 2-digit split code

GTSSCODE <GTSSCODE> Type-Sequence-Split code (e.g. “Typ:01 
Seq:0001Spl:01”)

GPRECCOUNT <GPRECCOUNT> Number of precincts

BALSETPARTYNAME <BALSETPARTYNAME> Ballot set party name

BALSETPARTYABBR <BALSETPARTYABBR> Ballot set party abbreviation

BALSETPARTYTXT1 <BALSETPARTYTXT1> Ballot set party additional text 1

BALSETPARTYTXT2 <BALSETPARTYTXT2> Ballot set party additional text 2

BALSETPARTYTXT3 <BALSETPARTYTXT3> Ballot set party additional text 3

GEO <GEO> Precinct name

GEO2 <GEO2> Precinct name 2 (split name)

GEOTXT1 <GEOTXT1> Precinct additional text 1

GEOTXT2 <GEOTXT2> Precinct additional text 2

GEOTXT3 <GEOTXT3> Precinct additional text 3
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GEOTXT4 <GEOTXT4> Precinct additional text 4

GEONAME <GEONAME> Precinct Name

GEONUM <GEONUM> Precinct Number

SPLITNUM <SPLITNUM> Split number

GEOID <GEOID> Precinct ID

GPID1 <GPID1> Precinct number without the split number

GPID2 <GDPI2> Precinct number with the split number

GSTYLENUM <GSTYLENUM> Ballot style number

GEOADDLTEXT <GEADDLTEXT (addl text #, 
append type)>

Precinct additional text, formatted as a list 
of numbers. See the Append Type table 

below.

PRECBYDISTTYPE <PRECBYDISTTYPE (dist type, prec 
addl text #, prefix)>

Precinct numbers for a specified district 
type.

GROUPBYTYPE(TOWN <GROUPTBYTYPE(TOWN)> Lists districts by district type

GCOLUMN <GCOLUMN> or <GCOLUMN (n)> Column number starting with 1 or n 
(column portrait layout only).

APPVERSION <APPVERSION>  Electionware Paper Ballot Version

SHEET <SHEET> or <SHEET(n)> Current ballot sheet number

SIDE <SIDE>or <SIDE(n)> Current ballot side

NUMSHEETS <NUMSHEETS> Number of ballot sheets

FACE <FACE> Current ballot face number (a face is a side 
of a sheet)

NUMFACES <NUMFACES> Number of ballot faces

NEXTNUMBER <NEXTNUMBER> Then next running number, starting from 1

TARGET <TARGET (T,S)> Renders target in line with text. T = Type (0 
= Open, 1 = Filled, S = size in points (6 to 

128)

RUNNINGSTYLENUM <RUNNINGSTYLENUM> Running ballot style number

BALLOTSTYLEALTERNA
TEID1

<BALLOTSTYLEALTERNATEID1> Ballot style alternate ID #1

BALLOTSTYLEALTERNA
TEID2

<BALLOTSTYLEALTERNATEID2> Ballot style alternate ID #2

BALLOTSHEETALTERNA
TEID1

<BALLOTSHEETALTERNATEID1> Ballot sheet alternate ID #1

BALLOTSHEETALTERNA
TEID2

<BALLOTSHEETALTERNATEID2> Ballot sheet alternate ID #2

Text Variables (continued)

Name Usage Description



 Chapter 10: Text 75

EVS5200_DOC_SOP_EW03Design
 Software Version 4.6

 Published: April 25, 2014

BALSETNAME <BALSETNAME> Set ballot name

BALSETPREFIX <BALSETPREFIX> Set ballot style name prefix

Note: Not all variables have language variations.

Variable Modifiers

Name Usage Description

^ <^GJURISDICTION> Force substituted text to upper case

iso: <es:GJURISDICTION> Substitute a language variation of the text

^iso: <^es:GJURISDICTION> Substitute a language variation of the text 
and force to upper case.

Append Type Values for GEOADDLTEXT

Name Description

1 Append text with no separators

2 Append text separated by a space

3 Append text separated by a comma

4 Append text separated by a comma and a 
space

Note: For precinct variables, use (H) parameter to display a horizontal list, or (V) for a 
vertical list (e.g. <GEONAME(H)>, or <GEO(V)>).

Text Variables (continued)

Name Usage Description
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Text Format Codes

Use text format codes to make stylistic 
changes to your text, such as bold, italic, 
or underlining. 

For example: 
“<B><L><P12><S12>Instructions to the 
Voter:<NL><N>To vote, completely fill in 
the oval...” would be displayed as:

“Instructions to the Voter:
To vote, completely fill in the oval...”

Use the adjacent table to reference 
important text format codes for all text 
files that you create for your ballot: 

Note: The usage of the term (n) in a 
code is equivalent to a number.

Caution: Not all text format codes 
are supported by the AutoMARK 
and ExpressVote. To ensure that the 
selected text format code is 
supported by your equipment, test 
Accessible Equipment prior to 
official use.

Text Format Codes

Code Description

Special Characters

<NL> New line or blank line

<Tn> Tab (n) spaces wide

<BULLET (n1, 
n2)>

Bullet Indent, n1 = indent from 
left margin to bullet. n2 = 

indent from n1

<BULLET> Bullet indent, uses default 
parameters or last specified 

parameters within that content 
item.

Text Format Codes

<Fnn> Use Font (nn) See the list of 
supported fonts in the Font 

table.

<Pn> Use font size (n)

<Sn> Use line size (n)

<Kn> Kern text by (n)

<B> Toggle bold text

<I> Toggle italics text

<U> Toggle Underscored text

<O> Toggle strikethrough text

<L> Left align text

<R> Right align text

<C> Center text

<J> Justify text
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Font Codes

In the previous table, the code <Fnn> is 
listed. This code enables you to change 
the font of the displayed text. Use the 
font table to translate font types when 
using the <Fnn> text format code:

Note: The usage of the term (n) in 
a code is equivalent to a number.

Note: In order for a font code to 
be used, the font must be installed 
on the system.

Font Codes

(nn) Value Font Name

0 Arial

1 Helvetica

2 Times New Roman

3 Courier New

4 MS Sans Serif

5 Chn FMing S5

5 Elite

7 Arial Superscript

8 Wingdings

9 Symbol

10 Zapf Dingbats

11 Zapf Chancery

12 Arial Narrow

13 Helvetica Narrow

14 Batang Che

15 MS Mincho

16 VNI-Helve
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Chapter 11: Font Substitutions 

The Font Substitutions feature enables you to substitute fonts for other fonts that may 
not apply to your printer or a specific language. For example, if your font is Arial in 
English, you may need to substitute another font for a ballot in Chinese. 

Take the following steps to create a font substitution: 

1. From the Ballot menu, click Font Substitutions. 

2. On the Font Substitutions 
window, click Add. 

A second Font Substitution window appears: 

3. Click the Language drop-down menu, and 
select a language where this font 
substitution will take effect. Select <All> if 
this substitution will carry over for all 
languages.

4. Click the When this font is specified list and 
select the font the substitute font will 
replace. If you only want the font to be 
replaced for a specific font size, deselect the 
Any Size check box and select a font size from the list.

5. Click the Substitute this font list and select the font size you are substituting. 

• To keep the font size the same as the size of the font you are substituting, click 
the Same Size check box. 

• To change the font size, deselect the Same Size check box and select the font 
size from the list. 
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6. Click OK to save your changes, or, click Cancel to reject your changes and return to 
the previous window. 

Edit Font Substitutions

1. On the Ballot menu, click Font Substitutions...

2. Select the appropriate font substitution in the Font Substitutions window and click 
Edit.

3. From the Font Substitution window, enter your changes. 

4. Click OK to accept your changes, or click Cancel to reject your changes and return 
to the previous window. 

Delete Font Substitutions

1. On the Ballot menu, click Font Substitutions...

2. Select the appropriate style sheet in the Font Substitutions window. 

3. Click Delete. A confirmation window appears, asking if you want to delete the font 
substitution. 

4. Click Yes to confirm deletion of the font substitution, or, click No to cancel the 
deletion and return to the previous window. 

Note: If you have multiple fonts to replace one font, Paper Ballot will first use the substitute 
font displayed at the top of the Font Substitutions window. If that font cannot be used, 
Paper Ballot will use the next available font option. To rearrange the order of substitution, 
click the font substitute and click the Move Up or Move Down arrows. 
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Chapter 12: Multi-Sheet Setup

When producing ballot layouts, at times the utilization of multiple sheets becomes 
necessary. For instance, if the amount of information on a ballot, (e.g., races, 
candidates, and questions) is too great for a single ballot sheet, you can use multiple 
sheets to allow the excess information to flow to the additional sheets.

With this understood however, when using multiple ballot sheets, the number of ballot 
styles can get very large. Each sheet is a style, and therefore, the numbering of ballot 
styles can get very large, and summarily go out of range. The following information 
details how to set up multiple sheets, and the settings best used for particular 
situations.

1. From the Ballot menu, click Multi-Sheet Setup. 

2. On the Multi-sheet Setup window, select 
Sequence Code, if you want Paper Ballot 
to set multi-sheet timing track string.

3. Select Type Code, if you want Paper Ballot 
to create multi-sheets based on the ballot 
sheet type code.

4. Select Split Code, if you want Paper Ballot to create multi-sheets based on the 
ballot sheet split code.

5. Click OK to accept your changes, or click Cancel to reject your changes and return 
to the previous window. 

Note: The need for setting up multi-sheet ballots occurs primarily in closed primary 
elections where there are a lot of parties and multiple sheets. When setting up multiple 
sheets in this scenario however, depending upon the amount of ballots in the election, 
using the Type Code selection may cause an overflow. In this situation, it would be better 
to utilize the Split Code or Sequence Code options instead.
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Chapter 13: Default Language

Use the Default Language option to set the default language on a ballot. Generally, the 
default language in Paper Ballot is set for English. Using the Default Language option 
however, you can change your default language to any of the languages in your current 
election. Use the steps below to change your ballot’s default language.

1. From the Ballot menu, point to Default Language. If more than one language is 
included in the election, a list of those languages appears to the right of the Default 
Language option.

2. Select the language you want to make the 
default language.

3. The following example demonstrates 
how the ballot preview changes to 
reflect the new default language 
selection. 

Specifying Non-English Languages

The following attributes apply to non-English languages:

 Use the Vrinda font for best viewing results.

 Use a PDF to proofread as the screen image can differ from the printed ballot.

 Double-underlining characters is not supported.

 Typeface characters are evenly spaced.

 If you specify full justification, the lines will be aligned on the left.
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Chapter 14: Scan for Errors

At any point in the layout process, you can use Paper Ballot to scan your layout for 
errors. This helps to avoid mistakes that may unintentionally cause printing or reading 
problems later in the election process. It is recommended that you use this feature any 
time you make a substantial change to your ballots. Use the steps below to scan your 
ballots for errors:

1. From the Ballot menu, select Scan For 
Errors. Two options are presented:

• Select Current Ballot to scan only the 
current ballot style for errors. This 
option is helpful if there is a known 
problem with one particular ballot style.

• Select All Ballots to scan every ballot 
style in the current election.

After scanning for errors, Paper Ballot reports any errors 
immediately in the adjacent ballot navigator pane. Ballot 
styles with errors are displayed with an ‘x’ as demonstrated in 
the adjacent example:

Ballot errors can also be indicated in red boxes, as 
indicated in the example to the right:

If instead the scan returns no errors, Paper Ballot will 
indicate this by displaying a green check mark for those 
ballot styles in the adjacent Ballot Style Pane.

Note: If you double-click on any error messages 
returned from the scan, Paper Ballot will automatically 
change the view to show you where the error resides.

Reference: You can also scan your ballots for errors using the symbols on the toolbar. Refer 
to Ballot Scan Symbols for more information.
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Chapter 15: Style Sheets

The Style Sheets menu changes to reflect the ballot layout type being used. Depending 
on the selected layout type, unavailable options are grayed out in the Style Sheets 
menu. The following sections detail all of the style sheets found in Paper Ballot.

Default Style Sheets

Each style sheet type has a default sheet that contains predefined settings for such 
elements as font size, background color and ballot text. You can use these default style 
sheets to lay out your ballots.

Note: You can also right-click on any style sheet in the ballot preview pane to display a list 
of all style sheets of that type, or to add, edit or delete an existing one.

Note: Double-click a style sheet to edit an item.
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Empty Cell Style Sheet

Empty cells are empty boxes that contain no data on your ballots. You can change the 
color and the ruling lines of these cells in the Empty Cell Style Sheet window. 

Editing the Empty Cell Style Sheet

Take the following steps to edit the empty cell style sheet:

1. On the Style Sheets menu, click Empty Cell. 

2. On the Empty Cell Style window, select 
the Empty Cell Style and click Edit. 

3. On the Empty Cell Style Sheet window, 
under the Ruling Lines section, type the measurements (in 
inches) of the border around the empty cell in the Top, Left, 
Bottom and Right boxes. 

4. Click the Background Color list and select the background 
color for the empty cell.

5. Click OK to accept your settings, and return to the Empty Cell 
Style window, or, click Cancel to reject your changes and close the Empty Cell Style 
Sheet window.

Your empty cell settings will appear on your ballot. The ballot image will appear 
showing the changes to your empty cell. 

Once you have added a new style sheet for your empty cells, a new Empty Cell Style 
Sheet will appear in the Empty Cell Style window. 

Note: Empty Cells are only available in the Grid-Landscape ballot layout type.

Reference: To create a customized color, click Custom located at 
the bottom of the list. For more information about creating 
custom colors, see Custom Color Settings. 
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Click Close to close the Empty Cell Style window and return to the main Paper Ballot 
window.

Office Style Sheet

The Office style sheet is applicable to all three types of ballot layouts, but options 
change depending on the layout type selected. The following information details the 
office style sheet for all three ballot layout types. Not all of the options listed are 
available for every ballot layout type. Be sure to verify that an option is available when 
reviewing the information below.

The Office style sheet enables you to change the location and appearance of offices 
that appear on ballots. When you create a new office style sheet, the default settings 
automatically appear in the boxes within the Office Style Sheet window. 

Adding an Office Style Sheet

Take the following steps to create a new office style sheet for a Grid-Landscape ballot:

Note: You can also turn all or a portion of an empty cell into a frame by right-clicking within 
the empty cell and selecting New Frame. The location of the cursor is positioned in the cell 
will determine the location of the frame. This location can be adjusted.

Reference: See Chapter 32: Paper Ballot Style Sheet Option Tables for more information 
on the office style sheet window options, and their availability for the three ballot layout 
types.

Warning: If you are working with multiple ballot styles and you want to ensure that a 
specific office contest is in the same position on all ballots, you must create an office style 
for each contest. 

Note: Contests can float in portrait mode, but must start in the same column on every 
ballot style in landscape mode if the option is selected (unless the Allow Float option is 
selected).
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1. From the Style Sheets menu, click 
Office. 

2. On the Office Styles window, click Add. 

The Office Style Sheet window 
appears:

3. In the Style Sheet Name area, in 
the Style Sheet Name field, enter 
a name for the office style sheet. 

4. In the Offices Applied To area, 

click the ellipsis button ( ) next 
to the Offices Applied To field. 

Offices Applied To Window

5. From the Offices Applied To 
window, you can either select 
the individual offices to include 
in this office style, or, you can 
use the Select All button to 
select all offices. After selecting 
an office, you can also click the 
Additional Criteria.

Note: If multiple office style sheets are 
listed, you can select and reposition a 
style sheet by clicking the Move Up 
and Move Down buttons. The default 
style sheet must be first in the list and 
cannot be moved up or down.

Note: The appearance of the 
Office Style Sheet window 
changes, depending on the 
layout style being used. This 
example represents the 
Grid-Landscape version.
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Additional Criteria Window

6. From the left pane of the 
Additional Criteria window, 
select additional conditions 
that will enable the style 
sheet.

• Ballot Set enables you to 
select a particular ballot 
set. Selecting this option 
will allow you to select 
from the list of ballot sets 
in the right pane.

• Ballot Style enables you 
to select a particular 
ballot style. Selecting this 
options will allow you to 
select from the list of ballot styles in the right pane.

• Language Group enables you to select a particular language group. Selecting 
this option will allow you to select from the list of language groups in the right 
pane.

• Precinct enables you to select a particular precinct. Selecting this option will 
allow you to select from the list of precincts in the right pane.

• District enables you to select a particular district. Selecting this option will allow 
you to select from the list of districts in the right hand pane.

7. Click the Select All button to select all of the objects within one of the criterion 
groups for the style sheet. You can also click the Clear All button to clear any or all 
of the objects selected within the criteria group.

8. When you are finished selecting additional criteria, click OK to accept your changes 
and return to the Office Style Sheet window, or, click Cancel to reject your changes 
and close the Additional Criteria window.

Note: By selecting one of the additional conditions, the listed ballot sets, Select All, and 
Clear All buttons are enabled.

Note: For example: If you select the Ballot Style check box from the left side of the 
Additional Criteria window, you would use Select All to select all of the ballot styles 

listed in the right side of the Additional Criteria window.
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Return to the Offices Applied To Window

9. After returning to the Offices Applied To window, and selecting the offices you wish 
to include in the Office style sheet, click OK to accept your Office style sheet 
settings and return to the Office Style Sheet window.

• Or, click Cancel to reject your settings and close the Offices Applied To window.

Return to the Office Style Sheet Window

Upon returning to the Office Style Sheet window, continue editing your Office style 
sheet by adjusting settings within the size section.

10. In the Size Selection field, if applicable, enter the width the Office style sheet will 
span in the Width field.

The Width field is only available for the Grid-Landscape layout type.

11. If applicable, enter the height of the Office style sheet in the Height field.

The Height field is only available for the Column-Portrait layout type.

12. If applicable, enter the number of cells assigned to the office style in the Span field.

The Span field is only available for the Grid-Landscape layout type.

13. In the Margins area, enter the measurement (in inches) in the Top, Left, Bottom and 
Right fields. 

14. In the Ruling Lines area, type the measurements you want for the border around the 
office (in inches) in the Top, Left, Bottom and Right boxes. 

Sheet ruling lines are defaulted to .006 inches for the top, left, bottom, and right.

15. In the Skip area, to insert a space before or after the selected offices, enter the 
number of marks to skip before a contest in the Marks to Skip Before field. And/or 
the number of marks to skip after a contest in the Marks to Skip After field. 

The Skip area is only available for the Grid-Landscape and Column-Portrait layout 
types.

16. In the Additional Information area (1), click the Background Color list and select 
the background color for the office.

Reference: To create a customized color, click Custom, located at the bottom of the 
Background Color list. For more information about creating custom colors, see Custom 
Color Settings.
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17. Select the Vertically Center Content check box to place the items entered in the 
Content frame in the center of the box. If this check box is not selected, your 
content will appear at the top of the box. 

18. Click the Panels button to add or delete panels from the current Office style sheet.

The Additional Information area (2) of the Office Style Sheet window differs in 
functionality, depending upon what ballot layout type is selected. Use the information 
below to set options in the Additional Information area (2) of the Office style sheet.

19a. Additional Information Section (2) - (Grid-Landscape Ballot) Select the Extend 
Left Ruling Line and/or Extend Right Ruling Line check boxes if you want the line 
to run to the bottom of the ballot page. 

19b. Additional Information Section (2) - (Grid-Portrait Ballot) Click the Custom Party 
Row check box to add a custom party row to the ballot. This enables the Party Row 
button. 

The Custom Party Row options are only available for the Grid-Portrait layout type

• Click Party Row to open the Party Row window. Click the drop-down menus for 
any of the rows in any of the columns, and select one of the listed parties to 
apply it to that location. 

• When you have finished adding your party rows, click OK to accept your settings 
and return to the Office Style Sheet window.

• Or, click Cancel to reject your changes and close the Party Row window.

19c. Additional Information Section (2) - (Column-Portrait Ballot) Click the Top 
Double Rule check box to add a double rule to the top office ruling line.

Note: If you use the Vertically Center Content option, the exact location is determined by 
what Position is applied to the content items.

Note: See Panels for more detailed information regarding creating panels for your ballot.

Note: The Extend Left Ruling Line and Extend Right Ruling Line options are only 
available for the Grid-Landscape and Grid-Portrait ballot types. Also, when enabling this 
option, it is advised that you increase the line thickness to verify that the settings have 
taken affect.
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• Click the Bottom Double Rule check box to add a double rule to the bottom 
office ruling line.

• Click the Enable Candidate Flow check box to enable candidate flow.

The Top Double Rule, Bottom Double Rule, and Enable Candidate Flow 
options are only available for the Column-Portrait ballot type.

Candidate flow is utilized when the amount of candidates in an office is too large for the 
selected column. When candidate flow is activated, candidate names are allowed to 
flow from column-to-column as necessary.

When selected, the Flow Settings button is enabled.

• Click the Flow Settings button to open the 
Candidate Flow Settings window.

• Select the Allow candidates to flow from 
front side to back side check box to allow 
candidate names to flow from the front of the 
ballot, to the back of the ballot.

• From the Style Sheet for continued columns 
drop-down menu, choose a style sheet (or 
create a new one) for the Continued 
candidates and placement of that style sheet 
at bottom of current column or top of the 
Continued in column.

• After an office has been selected, use the radio button to select either Place at 
top of column, and Place at bottom of column, to indicate whether the 
candidate flow will populate the top or bottom of the column.

When you have finished configuring the candidate flow settings, click OK to accept 
those settings and close the Candidate Flow Settings window.

The position section of the Office Style Sheet window differs in functionality, depending 
upon what ballot layout type is selected. Use the information below to set options in the 
Position section of the office style sheet.

20a. Position Section - (Grid-Landscape Ballot) - Click the Office Row list and select 
the position where the contests will display on your ballots. 

• Select Current Row to display the contests on the first available row. 

• If you wish to apply this style sheet to an office row style you created in the 
Ballot Settings window, select the name of the office row style sheet.

The Office Row options are only available for the Grid-Landscape layout type.

• Click the Column list to select the column to begin displaying the contests. 
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• Click the Column Label list and select a number that will appear in each office 
heading within that column. Select Auto to automatically number each contest 
according to the column where the contest appears. 

20b. Position Section - (Grid-Portrait Ballot) - Click the Sheet/Side drop-down menu 
and select either Auto or Sheet 1 - Front to place the office style sheet either 
automatically, or on the front of sheet one.

20c. Position Section - (Column-Portrait Ballot) - Click the Sheet/Side drop-down 
menu and select either Auto, Sheet 1 - Front, or Sheet 1 - Back to place the office 
style sheet either automatically, or on the front or back of sheet one.

• After selecting either Sheet 1 - Front or Sheet 1 - Back, the Column and Row 
drop-down menus become available. From these menus, select the column and 
row where the office style sheet will be placed.

• Layout Direction - (Column-Portrait Ballot) - From the Layout Direction 
drop-down menu, select either Down or Right. Typically, the Down selection is 
used as a default for most ballots. However, if using Rank Choice Voting (RCV), 
you would select Right in order to ensure that the races are parallel with each 
other on the ballot.

Straight Party Style Sheet

The Straight Party style sheet is only applicable to Column-Portrait ballots. The straight 
party style sheet enables you to change the location and appearance of the straight 
party offices that appear on your ballots. 

Adding a Straight Party Style Sheet

Take the following steps to create a new straight party style sheet for a Column-Portrait 
ballot:

1. From the Style Sheets menu, click Straight Party. 

Note: Take the following steps to view column numbers on your ballot. 

1. From the Office Style Sheet window, click Add, next to the Content section. 
The Style Sheet Content window appears. 

2. From the Style Sheet Content window, click the Data list and select Column 
Number(s). 

3. Adjust any of the formatting from the Additional Information and Content 
Properties sections.

4. Click OK accept your settings and close the Style Sheet Content window. Or 
click Cancel to reject your settings and close the Style Sheet Content window.
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The Straight Party Styles window 
appears:

2. From the Straight Party Style Sheet window, click Add. 

The Straight Party Contest 
Style Sheet window will 
appear:

3. Style Sheet Name Section - 
In the Style Sheet Name 
field, enter a name for the 
straight party style sheet.

4. Contests Applied To 
Section - Click the ellipsis 

button ( ) next to the 
Contests Applied To field. 

The Straight Party Contests Applied To window appears: 

Note: If multiple straight party style 
sheets are listed, you can click on and 
reposition your selected style sheet by 
clicking the Move Up and Move 
Down buttons. The default style sheet 
is always first in the list and cannot be 
moved.
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Straight Party Contests 
Applied To Window

5. From the Straight Party 
Contests Applied To window, 
you can either select the 
individual style sheets, or you 
can click the Select All button 
to select all straight party 
contests. 

After selecting a straight party, you 
can also click the Additional 
Criteria... button. 

The Additional Criteria window appears:

Additional Criteria Window

6. From the left pane of the 
Additional Criteria window, 
you can select additional 
conditions that will enable 
the style sheet.

By selecting one of the 
additional conditions, the 
Select All, and Clear All 
buttons become available.

• Ballot Set enables you 
to select a particular 
ballot set. Selecting this 
option will allow you to 
select from the list of 
ballot sets in the right 
pane.

• Ballot Style enables you to select a particular ballot style. Selecting this options 
will allow you to select from the list of ballot styles in the right pane.

• Language Group enables you to select a particular language group. Selecting 
this option will allow you to select from the list of language groups in the right 
pane.

• Precinct enables you to select a particular precinct. Selecting this option will 
allow you to select from the list of precincts in the right pane.

• District enables you to select a particular district. Selecting this option will allow 
you to select from the list of districts in the right hand pane.
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7. You can use the Select All button to select all of the objects within one of the 
criterion groups for the style sheet. You can also use the Clear All button to clear 
any or all of the objects selected within the criteria group.

For example: If you select the Ballot Style check box from the left side of the 
Additional Criteria window, you would use Select All to select all of the ballot styles 
listed in the right side of the Additional Criteria window.

8. When you are finished selecting additional criteria, click OK to accept your changes 
and return to the Straight Party Style Sheet window.

• Or, click Cancel to reject your changes and close the Additional Criteria window.

Return to the Straight Party Contests Applied To Window

9. After returning to the Straight Party Contests Applied To window, and selecting the 
contests you wish to include in the straight party style sheet, click OK to accept your 
straight party contests applied to settings and return to the Straight Party Contest 
Style Sheet window.

• Or, click Cancel to reject your settings and close the Straight Party Contests 
Applied To window.

Return to the Straight Party Contest Style Sheet Window

Upon returning to the Straight Party Contest Style Sheet window, continue editing your 
straight party style sheet by adjusting settings within the size frame.

10. Size Section - Enter the height the straight party style will span in the Height field.

Both the Width and Span boxes are disabled for the straight party style sheet.

11. Margins Section - Under the Margins section, type the measurement (in inches) in 
the Top, Left, Bottom and Right fields. 

12. Ruling Lines Section - Under the Ruling Lines section, type the measurements you 
want for the border around the straight party (in inches) in the Top, Left, Bottom 
and Right fields. 

Sheet ruling lines are defaulted to .006 inches for the top, left, bottom, and right 
ruling lines.

13. Skip Section - To insert a space before or after the parties selected for this style 
sheet, enter the number of marks to skip before a straight party contest in the 
Marks to Skip Before field and the number of marks to skip after a straight party 
contest in the Marks to Skip After field. 
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14. Additional Information (1) Section - Click the Background Color drop-down menu, 
and select the background color for the straight party race.

15. Select the Vertically Center Content check box to place the items entered in the 
Content section in the center of the style sheet. If this check box is not selected, the 
content is defaulted to appear at the top of the style sheet. 

16. Click the Panels button to add or delete panels from the current straight party style 
sheet.

17. Additional Information (2) Section - Click the Apply Background Color to the 
Associated Contests check box to apply the selected color to the contests 
associated with the straight party style sheet.

18. Position Section - Click the Sheet/Slide list and select the position where contest 
will appear on the ballot.

After selecting either Sheet (#) - Front or Sheet (#) - Back, the Column and Row 
drop-down menus become available.

• From the Column drop-down menu, select the starting column for the contest. If 
Auto is selected, the straight party contest is automatically placed on the ballot.

• From the Row drop-down menu, select the row position where the contest will 
be displayed. If Auto is selected, the straight party contest is automatically 
placed on the ballot.

Reference: To create a customized color, click Custom, located at the bottom of the 
Background Color drop-down menu. For more information about creating custom colors, 
see Custom Color Settings.

Reference: Refer to Panels for more detailed information regarding creating panels for 
your ballot.

Note: The (‘#’) is equal to the available sheet number. (e.g. sheet 1)
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Candidate Style Sheet

The candidate style sheet is applicable to all three types of ballot layout, but options 
change depending on the layout type selected. The following information details the 
candidate style sheet for all three ballot layout types. Not all of the options listed are 
available for every ballot layout type. Be sure to verify that an option is available when 
reviewing the information below.

The candidate style sheet enables you to change the location and appearance of 
candidates that appear on your ballots. When you create a new candidate style sheet, 
the default settings automatically appear in the boxes within the Candidate Style Sheet 
window. 

If you are creating a style sheet for a candidate in a race that is split among multiple 
districts, you must return to Capture and create an individual contest for each district 
and re-merge your data for Paper Ballot before you can create the candidate style 
sheet.

For example, there is a city council contest with three districts and you want to create a 
style sheet for the first candidate in District 2. Before you create this style sheet, return 
to Capture. If you see one city council contest assigned to three districts, make three 
separate city council contests and assign each one to a district. When you return to 
Paper Ballot, create a candidate style sheet and assign it to City Council - District 2 - 
Candidate 1. 

Adding a Candidate Style Sheet

Take the following steps to create a new candidate style sheet to your ballot:

1. From the Style Sheets menu, click Candidate. 

Reference: See Chapter 32: Paper Ballot Style Sheet Option Tables for more information 
on the candidate style sheet window options, and their availability for the three ballot 
layout types.

Caution: When Empty Cells are used within a contest, in order for them to display correctly 
on the ES&S AutoMARK screen, a content item with a language setting of default must be 
added to the empty cell. 

For example: You can add the data content First Name to the empty cell, and the cell will 
still appear empty on the Paper Ballot. The content will carry through to the ES&S 
AutoMARK however, and enable the empty cell to display correctly on the screen. 

For more information on adding content to an empty Candidate Style Sheet, see Chapter 
16: Adding Content to Style Sheets.
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The Candidate Styles window will 
appear:

If multiple candidate style sheets are 
listed, you can click on and reposition 
your selected style sheet by clicking the 
Move Up and Move Down buttons. 
The default style sheet is always first in 
the list and cannot be moved up or 
down.

2. From the Candidate Styles window, 
click Add. 

The Candidate Style Sheet 
window will appear:

3. Style Sheet Name Section - 
In the Style Sheet Name 
field, enter a name for the 
candidate style sheet. 

4. Candidates Applied To 
Section - Click the ellipsis 

button ( ) next to the 
Candidates Applied To field. 

The Candidates Applied To 
window will appear:

Note: The appearance of 
the Candidate Style Sheet 
window changes, 
depending on the layout 
style being used. The 
adjacent example 
represents the 
Grid-Landscape version.
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5. From the Candidates Applied To window, you can either select the individual check 
boxes next to the offices and candidates to include in this candidate style sheet, or 
you can click Select All to select all offices and candidates. You can also click Clear 
All to clear any and all candidates and offices currently selected.

6. To apply additional criteria to the candidate style sheet, click Additional Criteria in 
the lower right corner of the window. 

The Additional Criteria window appears.

Additional Criteria Window

7. From the left pane of the 
Additional Criteria window, 
you can select additional 
conditions that will enable 
the style sheet.

By selecting one of the 
additional conditions, the 
Select All, and Clear All 
buttons become available.

• Ballot Set enables you 
to select a particular 
ballot set. Selecting this 
option will allow you to 
select from the list of 
ballot sets in the right 
pane.

• Ballot Style enables you to select a particular ballot style. Selecting this options 
will allow you to select from the list of ballot styles in the right pane.

• Language Group enables you to select a particular language group. Selecting 
this option will allow you to select from the list of language groups in the right 
pane.

• Precinct enables you to select a particular precinct. Selecting this option will 
allow you to select from the list of precincts in the right pane.

• District enables you to select a particular district. Selecting this option will allow 
you to select from the list of districts in the right hand pane.

Time Saver: When you select an office check box, all candidates in that race are included in 
this style sheet. You can then deselect individual candidates if desired.

Reference: To adjust the height of the candidate style sheet, adjust the setting in the Cell 
Height field of the Candidate Row Position section in the Office Row window. See 
Adding or Editing an Office Row for more information. 



 Chapter 15: Style Sheets 99

EVS5200_DOC_SOP_EW03Design
 Software Version 4.6

 Published: April 25, 2014

8. You can use the Select All button to select all of the objects within one of the 
criterion groups for the style sheet. You can also use the Clear All button to clear 
any or all of the objects selected within the criteria group.

For example, if you select the Ballot Style check box from the left side of the 
Additional Criteria window, you would use Select All to select all of the ballot styles 
listed in the right side of the Additional Criteria window.

9. When you are finished selecting additional criteria, click OK to accept your changes 
and return to the Candidates Applied To window.

• Or, click Cancel to reject your changes and close the Additional Criteria window.

Return to the Candidates Applied To Window

10. Upon returning to the Candidates Applied To window, click OK to accept your 
changes and return to the Candidate Style Sheet window.

• Or click Cancel to reject your changes and close the Candidates Applied To 
window.

Return to the Candidate Style Sheet Window

Upon returning to the Candidate Style Sheet window continue editing your candidate 
style sheet, by adjusting settings within the size section.

11. Size Section - Enter the height the candidate style sheet will span in the Height 
field.

The height field is only enabled for the Grid-Portrait and Column-Portrait ballot 
types.

Both the Width and Span fields are disabled for the candidate style sheet.

12. Margins Section - Under the Margins section, enter the measurement (in inches) in 
the Top, Left, Bottom and Right fields. 

13. Ruling Lines Section - Under the Ruling Lines section, enter the measurements (in 
inches) of the border around the candidate style sheet in the Top, Left, Bottom and 
Right fields. 

Sheet ruling lines are defaulted to .006 inches for the top, left, bottom, and right 
ruling lines.

14. Landscape Options - Enter the relative target location where the candidate should 
appear in the Relative Candidate Position field. 

15. Click the check box next to Adjacent Party Cell to place a candidate next to an 
adjacent party cell.

Options located under the Landscape Options section are only enabled for the 
Grid-Landscape ballot type.
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16. Additional Information Section - Click the Background Color list and select the 
background color for the candidate. 

17. Select the Vertically Center Content check box to place the items entered in the 
Content section in the center of the box. If this check box is not selected, your 
content will appear at the top of the style sheet. 

18. Click the Panels button to add or delete panels from the current candidate style 
sheet.

19. Relative Target Position - If an office contest spans more than one column, use the 
Relative Position box to adjust the position where a candidate appears on the 
ballot. For example, if an office contest spans three columns (a vote for three 
candidates option), but only one candidate is running for this office, then, by default, 
the candidate would appear on the ballot in the left-most (first) column of the 
contest. You can use the Relative Position box to adjust this candidate to appear in 
the second column by typing 2 in this box. 

20. Select the Adjacent Party Cell check box to place a party cell to the left of the 
specified candidate(s). Use this option if candidates are endorsed by seldom-used 
political parties. Using this option prevents you from having to use an entire row on 
a ballot for a particular party.

Write-in Style Sheet

On the Write-in Style Sheet window, you can specify the location and appearance of 
write-in candidates that appear on the ballot. When creating a new write-in style sheet, 
the default settings automatically appear in the fields within the Write-in Style Sheet 
window. The Write-in Style Sheet window is available to all ballot layout formats. See 
Chapter 15: Style Sheets for more information about ballot layout formats; however, the 
options that appear on the style sheets are determined by the ballot layout format. 

Reference: To create a customized color, click the Custom, located at the bottom of the 
drop-down menu. For more information about creating custom colors, see Custom Color 
Settings.

Reference: See Panels for more information regarding creating panels for your ballot.

Note: If the Adjacent Party Cell check box is selected, consider increasing the number in 
the Span box in the Office Style Sheet window to make room for the political party cells.

Reference: See Chapter 32: Paper Ballot Style Sheet Option Tables for more information 
on the Write-in Style sheet options that are available on the ballot layout formats.
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Defining a Panel with a Write-in Recognition Area

You can define an area in a write-in panel, which makes it possible for the scanner to 
recognize and record a write-in candidate’s name if only a name is entered in the 
designated panel and the voter target (oval) is left blank. You cannot type text in this 
space. The space appears blank on the finished ballot.

How to specify the write-in recognition area attributes are described in the steps to  
Adding a Write-in Style Sheet. The Reserve for Write-in Recognition Area check box 
on the Panel Properties window controls the availability of this feature for a panel.

Adding a Write-in Style Sheet

To create a write-in style sheet for your ballot:

1. From the Style Sheets menu, click Write-in. 

The Write-in Styles window appears:

If multiple write-In style sheets are listed, 
click on and reposition your selected style 
sheet by clicking the Move Up and Move 
Down buttons. The default style sheet must 
be first in the list and cannot be moved up 
or down. Note, if you use a reserved 
(extended) Write-in panel, you must use a 
reserved panel on all write-ins. If you do 
not, an error will appear when you finalize 
data that reserved panels for write-ins are 
inconsistent.

Write-in Style Sheet window

2. On the Write-in Styles window, click Add. 

Reference: See Chapter 31: Extended Write-in Ballot Layout Guidelines for more 
information on creating the extended write-in read areas on the ballot.
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The Write-in Style Sheet window 
appears:

3. Style Sheet Name Section - 
In the Style Sheet Name 
field, enter a name for the 
new Write-in Style Sheet. 

4. Offices Applied To Section - 

Click the ellipsis button ( ) 
next to the Offices Applied 
To field. 

The Offices Applied To 
window appears:

Offices Applied To Window

5. On the Offices Applied To 
window, select the check 
boxes next to the offices to 
include in this style.

6. To apply additional criteria to 
the write-in style sheet, click 
Additional Criteria in the 
lower right corner of the window. 

The Additional Criteria window appears.

Note: The options 
available on the Write-in 
Style Sheet window are 
determined by the 
selected ballot layout 
format. The adjacent 
example represents the 
Grid-Landscape format.

Time Saver: You can also 
click Select All to select all 
of the listed races. Or, click 
Clear All to clear all of the 
selected races.
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Additional Criteria Window

7. From the left pane of the 
Additional Criteria window, 
you can select the following 
criteria for the style sheet:

• Click the Ballot Set check 
box to select from the list 
of ballot sets in the right 
pane.

• Click the Ballot Style 
check box to select from 
the list of ballot styles in 
the right pane.

• Click the Language 
Group check box to 
select from the list of 
language groups in the right pane.

• Click the Precinct check box to select from the list of precincts in the right pane.

• Click the District check box to select from the list of districts in the right pane.

If you select at least one criterion check box in the left pane, the Select All, and 
Clear All buttons become available. These buttons allow you to either select all or 
clear all items in the right pane.

• Click the Select All button to select all of the objects within one of the criteria 
groups for the style sheet. 

• Click the Clear All button to clear any or all of the criteria check boxes selected.

8. Either click OK to accept your changes and return to the Offices Applied To 
window, or, click Cancel to reject your changes and close the Additional Criteria 
window.

Return to the Offices Applied to Window

9. After returning to the Offices Applied To window, either click Cancel to reject your 
changes and close the window, or, click OK to accept your changes and return to the 
Write-in Style Sheet window.

Return to the Write-in Style Sheet window

Upon returning to the Write-in Style Sheet window, adjust the style sheet settings 
within the Size area.

10. In the Size area, enter the height the style sheet will span in the Height field.
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The height field is only enabled for the Column-Portrait ballot type.

The Width and Span fields are dimmed for the style sheet.

11. In the Margins area, enter the measurements (in inches) for the Top, Left, Bottom 
and Right fields to 0.0. The minimum area for the write-in recognition area is 10mm 
high by 24mm wide. On a portrait ballot, this usually requires at least two rows by 
three columns, depending on the timing mark’s density. Landscape ballots usually 
require three or four rows, depending on where any write-in verbiage is placed.

12. In the Ruling Lines area, enter the measurements (in inches) of the border around 
the write-in recognition area in the Top, Left, Bottom and Right fields. This can only 
be done in a non-reserved panel. 

Lines

• You can use vertical or horizontal lines to delineate the reserved panel as long as 
the lines are outside the gray outline of the reserved panel. If you use a line, 
place it immediately adjacent to the reserved area. ES&S recommends using a 
rule on the adjacent panel and keep the gutter space as close to ‘0’ as possible. 
You can also draw a vertical line on one side of smaller non-reserved panel to 
separate it from the larger reserved write-in panel. And then, if space allows, 
change the panel gutter width from 0.0 to the line thickness.

The panel that is marked as “reserved for write-in recognition” will have a gray 
border inside of the panel borders. This border only appears on screen and does 
not print on the ballot. Turn on the grid overlay to see the rows and columns the 
reserved panel occupies. 

• The following figure uses the column portrait ballot format and sets the line on 
the right side of the small panel to 0.006 and the panel gutter to 0.006. On most 
monitors, the vertical line will be covered by the reserved panel, so set the 
gutter to twice the line’s thickness to see it on the screen. When printed, it will 
appear as follows with the vertical line positioned outside of the reserved 
write-in recognition area. 

• Turn on the grid overlay to see the rows and columns the reserved panel 
occupies.

Note: Ruling lines for the Grid-Landscape version of the Write-in Style Sheet are defaulted 
to .006 inches for the top, left, bottom, and right ruling lines.
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13. Additional Information Section - Click the Background Color list and select the 
background color for the write-in style sheet.

14. Select the Vertically Center Content check box to place the items entered in the 
Content section in the center of the box. If this check box is not selected, the 
content will appear at the top of the style sheet. 

15. Click the Panels button to add, edit, and delete panels from the current Write-in 
Style Sheet.

16. In the Orientation area, select Horizontal 
(side-by-side) and click Add to add two 
panels, a small and a large panel.

Reference: To create a customized color, click Custom, located at the bottom of the 
drop-down menu. For more information about creating custom colors, see Custom Color 
Settings.

Note: The unmarked write-in area is designated by using panels in the Write-in Style Sheet. 
The minimum area for the write-in recognition area is 10mm high by 24mm wide. On a 
portrait ballot, this usually requires at least two rows by 3 columns, depending on the 
timing mark’s density. Landscape ballots usually require three or four rows, depending on 
where any write-in verbiage is placed. 

Reference: See Panels for more detailed information regarding creating panels for your 
ballot.



 Chapter 15: Style Sheets 106

EVS5200_DOC_SOP_EW03Design
 Software Version 4.6

 Published: April 25, 2014

17. In the first panel (target cell), set the width to 15%; set the width to 85% in the 
second panel (reserved for write-in) and click OK.

18. In the Panels window, set the gutter width to 
0.00 and click OK.

19. In the Write-in Style Sheet window, click 
either Edit, or Add to enter any content 
(usually the write-in verbiage) to be in Panel 1 
(the smaller panel).

Note: The target can be in the reserved write-in space. While the target column can be 
counted in the minimum required it is best to allow as many columns as possible for the 
reserved write-in area. Do not put any content in the main cell of the write-in. Place content in 
the panel that is not marked as reserved for write-in recognition. 

For a standard 3-column portrait ballot, setting the small panel to 15% and the larger at 85% 
works well. 

Note: You cannot use a gutter with horizontal 
panels unless the entire write-in is at least 
three columns wide.

Note: Place any verbiage, usually the “write-in” text, in the small panel and mark the large 
panel as reserved for write-in recognition.
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20. On the Style Sheet 
Content window, 
select panel 1 from 
the Panel drop-down 
menu.

21. Click OK to return to 
the Write-in Style 
Sheet and click OK 
again to return to the 
ballot. 

Party Style Sheet

The Party style sheet is applicable to two of the ballot layout types: Grid-Landscape, 
and Grid-Portrait. Options change depending on which of the two layout types are 
selected. The following information details the options available for the both layout 
types. Not all of the options listed are available for both ballot layout types. Be sure to 
verify that an option is available when reviewing the information below.

The Party style sheet enables you to change the appearance of the Party information 
that appears with each candidate. When you create a new Party style sheet, the default 
settings will automatically appear in the boxes in the Party Style Sheet window. 

Adding a Party Style Sheet

Take the following steps to create a new party style sheet for your ballot:

1. From the Style Sheets menu, click Party. 

The Party Styles window will appear:

If multiple Party style sheets are listed, 
you can click on and reposition your 
selected style sheet by clicking the 
Move Up and Move Down buttons. 
The default style sheet must be first in 
the list and cannot be moved up or 
down.

2. From the Party Styles window, click 
Add. 

Reference: See Chapter 32: Paper Ballot Style Sheet Option Tables for more information 
on the party style sheet window options, and their availability for both ballot layout types.



 Chapter 15: Style Sheets 108

EVS5200_DOC_SOP_EW03Design
 Software Version 4.6

 Published: April 25, 2014

The Party Style Sheet window will 
appear:

3. Style Sheet Name Section - 
In the Style Sheet Name 
field, enter a name for the 
party style sheet. 

4. Parties Applied To Section - 

Click the ellipsis button ( ) 
next to the Parties Applied 
To field. 

The Parties Applied To 
window appears:

Parties Applied to Window

5. From the Parties Applied To 
window, select the check 
boxes next to the parties to 
include in this party style 
sheet. Click OK to return to 
the Party Style sheet window.

6. To apply additional criteria to the party style sheet, click Additional Criteria in the 
lower right corner of the window. 

The Additional Criteria Window appears:

Note: The appearance of 
the Party Style Sheet 
window changes, 
depending on the layout 
style being used. The 
example above represents 
the Grid-Portrait version.

Time Saver: You can also click Select All to select all of the listed parties. Or, click Clear All 
to deselect any or all of the selected parties.
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Additional Criteria Window

7. From the left pane of the 
Additional Criteria window, 
you can select additional 
conditions that will enable 
the style sheet.

By selecting one of the 
additional conditions, the 
Select All, and Clear All 
buttons become enabled.

• Ballot Set enables you to 
select a particular ballot 
set. Selecting this option 
will allow you to select 
from the list of ballot sets 
in the right pane.

• Ballot Style enables you to select a particular ballot style. Selecting this options 
will allow you to select from the list of ballot styles in the right pane.

• Language Group enables you to select a particular language group. Selecting 
this option will allow you to select from the list of language groups in the right 
pane.

• Precinct enables you to select a particular precinct. Selecting this option will 
allow you to select from the list of precincts in the right pane.

• District enables you to select a particular district. Selecting this option will allow 
you to select from the list of districts in the right hand pane.

8. You can use the Select All button to select all of the objects within one of the 
criterion groups for the style sheet. You can also use the Clear All button to clear 
any or all of the objects selected within the criteria group.

For example, if you select the Ballot Style check box from the left side of the 
Additional Criteria window, you would use Select All to select all of the ballot styles 
listed in the right side of the Additional Criteria window.

9. When you are finished selecting additional criteria, click Cancel to reject your 
changes and close to the Additional Criteria window. Or, click OK to accept your 
changes and return to the Parties Applied To window.

Return to the Parties Applied to Window

10. After returning to the Parties Applied To window, select the parties you want the 
style sheet to apply to and click OK to accept your changes and return to the Party 
Style Sheet window.

• Or, click Cancel to reject your changes and close the window. 
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Return to the Party Style Sheet Window

Upon returning to the Party Style Sheet window continue editing your party style sheet, 
by adjusting settings within the size section.

11. Size Section - Enter the width the party style will span in the Width box.

The Width field is the only size option available for the Grid-Landscape layout type.

12. Enter the height the party style sheet will span in the Height field.

The Height field is the only size option available for the Grid-Portrait layout type.

The Span field is disabled for the party style sheet.

13. Margins Section - Under the Margins section, enter the measurement (in inches) in 
the Top, Left, Bottom and Right fields. 

14. Ruling Lines Section - Under the Ruling Lines section, enter the measurements (in 
inches) of the border around the party style sheet in the Top, Left, Bottom and 
Right fields. 

Ruling lines for the Grid-Landscape version of the party style sheet are defaulted to 
.006 inches for the top, left, bottom, and right ruling lines.

15. Additional Information Section - Click the Background Color list and select the 
background color for the party style sheet. 

16. Select the Vertically Center Content check box to place the items entered in the 
Content section in the center of the box. If this check box is not selected, your 
content will appear at the top of the box. 

17. Click the Panels button to add or delete panels from the party style sheet.

Reference: To create a customized color, click Custom, located at the bottom of the 
drop-down menu. For more information about creating custom colors, see Custom Color 
Settings.

Reference: See Panels for more information regarding creating panels for your ballot.



 Chapter 15: Style Sheets 111

EVS5200_DOC_SOP_EW03Design
 Software Version 4.6

 Published: April 25, 2014

Question Style Sheet

The Question style sheet is applicable to all three ballot layout types. Options change 
depending on which layout type is selected. The following information details the 
options available for all three layout types. Not all of the options listed are available for 
every ballot layout type. Be sure to verify that an option is available when reviewing the 
information below.

The question style sheet enables you to change the appearance of any questions that 
appear on the ballot. When you create a new question style sheet, the default settings 
will automatically appear in the fields in the Question Style Sheet window. 

Adding a Question Style Sheet

Take the following steps to create a new question style sheet:

1. From the Style Sheets menu, click Question. 

The Question Styles window will appear:

2. From the Question Styles window, click 
Add to add a new style; or Edit for 
existing style sheets. 

Reference: See Chapter 32: Paper Ballot Style Sheet Option Tables for more information 
on the Question Style Sheet window options, and their availability for your layout type.
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The Question Style Sheet window 
will appear:

3. Style Sheet Name Section - In the 
Style Sheet Name field, enter a 
name for the question style sheet. 

4. Questions Applied To Section - 

Click the ellipsis button ( ) next 
to the Questions Applied To field. 

The Questions Applied To window will appear:

Questions Applied To Window

5. From the Questions Applied To 
window, select the check boxes next 
to the listed questions to include in 
this question style. 

6. To apply additional criteria to the 
question style sheet, click Additional Criteria in the lower right corner of the 
window. 

The Additional Criteria Window appears:

Time Saver: You can also click 
Select All to select all of the listed 
questions. Or, click Clear All to 
deselect any or all of the selected 
questions.
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Additional Criteria Window

7. From the left pane of the 
Additional Criteria window, 
you can select additional 
conditions that will enable 
the style sheet.

By selecting one of the 
additional conditions, the 
Select All, and Clear All 
buttons become enabled.

• Ballot Set enables you to 
select a particular ballot 
set. Selecting this option 
will allow you to select 
from the list of ballot sets 
in the right pane.

• Ballot Style enables you to select a particular ballot style. Selecting this options 
will allow you to select from the list of ballot styles in the right pane.

• Language Group enables you to select a particular language group. Selecting 
this option will allow you to select from the list of language groups in the right 
pane.

• Precinct enables you to select a particular precinct. Selecting this option will 
allow you to select from the list of precincts in the right pane.

• District enables you to select a particular district. Selecting this option will allow 
you to select from the list of districts in the right hand pane.

8. You can use the Select All button to select all of the objects within one of the 
criterion groups for the style sheet. You can also use the Clear All button to clear 
any or all of the objects selected within the criteria group.

For example: If you select the Ballot Style check box from the left side of the 
Additional Criteria window, you would use Select All to select all of the ballot styles 
listed in the right side of the Additional Criteria window.

9. When you are finished selecting additional criteria, click Cancel to reject your 
changes and close to the Additional Criteria window. Or, click OK to accept your 
changes and return to the Questions Applied To window. 

Return to the Questions Applied To Window

10. After returning to the Questions Applied To window, select the questions you want 
the style sheet to apply to and click OK to accept your changes and return to the 
Question Style Sheet window.

• Or, click Cancel to reject your changes and close the window. 
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Return to the Question Style Sheet Window

Upon returning to the Question Style Sheet window, you can continue editing the 
question style sheet by adjusting settings in the Size section.

11. Size Section - Enter the width the question style will span in the Width field.

The Width field is the only enabled for the Grid-Landscape layout type.

12. Enter the height the question will span in the Height field. 

The Height field is only enabled for the Grid-Portrait and Column-Portrait layout 
types.

13. Margins Section - Under the Margins section, enter the measurement (in inches) in 
the Top, Left, Bottom and Right fields. 

The top margin for the Grid-Landscape question style sheet are defaulted to .025 for 
the top margin.

14. Ruling Lines Section - Under the Ruling Lines section, enter the measurements (in 
inches) of the border around the question in the Top, Left, Bottom and Right fields. 

Ruling lines for the Grid-Landscape version of the question style sheet are defaulted 
to .006 inches for the top, left, bottom, and right ruling lines.

15. Skip Section - If you wish to insert a space before or after the questions selected for 
this style sheet, enter the number of marks to skip before a question in the Marks to 
Skip Before box and the number of marks to skip after a question in the Marks to 
Skip After box. 

16. Additional Information Section (Grid-Landscape and Grid-Portrait Ballots) - Click 
the Background Color list and select the background color for the question.

17. Click the Panels button to add or delete panels from the question style sheet.

The Additional Information (2) section of the Office Style Sheet window differs in 
functionality, depending upon what ballot layout type is selected. Use the information 
below to set options in the Additional Information (2) section of the office style sheet.

18a. Additional Information Section (Grid-Landscape and Grid-Portrait Ballots) - 
Click the Response Settings button to configure the Question Response settings.

18b. Additional Information (2) Section: (Column Portrait Ballot) - Select Top Double 
Rule to apply a double ruling line to the top of the office.

Reference: To create a customized color, click Custom, located at the bottom of the 
drop-down menu. For more information about creating custom colors, see Custom Color 
Settings. 

Reference: See Panels for more detailed information regarding creating panels for your 
ballot.
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• Select Bottom Double Rule to apply a double ruling line to the bottom of the 
office.

The Top Double Rule and Bottom Double Rule options are only available for 
the Column-Portrait Ballot Type.

• Select Enable Text Flow to have the question text flow from one column to the 
next. When selected, the Text Flow Settings button becomes activated.

Click the Text Flow Settings to configure the question’s text flow. Select Allow 
text to flow from front side to back side to allow the question flow from the 
front of the ballot to the back side. Select Widow/Orphan control to ensure that 
paragraphs remain generally in tact when flowing between columns. This setting 
prevents too many lines of text from being orphaned from the main body of the 
question.

• Click the Response Settings button to configure the Question Response 
settings.

The Responses window appears.

Responses Window

19. From the Response Arrangement drop-down menu, 
select either Vertical or Horizontal to align the 
responses vertically or horizontally.

20. From the Target Position drop-down menu, select 
Upper Right, Lower Right, Upper Left, or Lower 
Left to select the position of the responses.

21. Click OK to accept your settings and return to the 
Question Style Sheet window. 

• Or, click Cancel to reject your changes and close the window.

22a. Position Section (Grid-Landscape Ballot) - Click the Question Row drop-down 
menu and select the position where the question will display on your ballots. 

• Select Current Row to display the questions on the first available row. 

• If you wish to apply this style sheet to a question row style you created in the 
Ballot Settings window, select the name of the question row style sheet.

22b. Position Section (Grid-Portrait and Column Portrait Ballots) - Click the Sheet/
Side drop-down menu and select either Auto, Sheet 1 - Front, or Sheet 1 - Back to 
place the question style sheet either automatically, or on the front or back of the 
sheet.
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• After selecting either Sheet (#) - Front or Sheet (#) - Back, the Column and Row 
drop-down menus become available. From these menus, select the column and 
row where the office style sheet will be placed.

23. Click OK to accept your changes and return to the Question Styles window.

• Or, click Cancel to reject your settings and close the window.

Question Response Style Sheet

The Question Response style sheet is applicable to all three ballot layout formats. 
Options change depending on which layout type is selected. The following information 
details the options available for all three layout types. Not all of the options listed are 
available for every ballot layout type. Be sure to verify that an option is available when 
reviewing the information below.

The question response style sheet enables you to change the appearance of any 
question responses that appear on the ballot. When you create a new question 
response style sheet, the default settings will automatically appear in the fields in the 
Question Response Style Sheet window.

Adding a Question Response Style Sheet

Take the following steps to edit, or create a new question style sheet:

1. From the Style Sheets menu, click Question Response. 

Note: The (‘#’) is equal to the available sheet number. (e.g. sheet 1)

Reference: See Chapter 32: Paper Ballot Style Sheet Option Tables for more information 
on the Question Response Style Sheet window options, and their availability for your layout 
type.

Note: In order to use the Question Response Style Sheet, there must be a Question 
Content Line with “Responses (style sheet-formatted).” The Question Content Line defaults 
to “Responses (content-formatted),” and must be changed.
If you do not change this setting, you will only be able to make changes based on the 
settings in the Question Style Sheet.
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The Question Response Styles window 
appears:

2. From the Question Response Styles 
window, click Add to add a new style; 
or Edit for existing style sheets. 

The Question Response Style 
Sheet window appears:

3. Style Sheet Name Section - 
In the Style Sheet Name 
field, enter a name for the 
question response style 
sheet. 

4. Responses Applied To 
Section - Click the ellipsis 

button ( ) next to the 
Responses Applied To field. 

The Responses Applied To window will appear:

Responses Applied To Window

5. From the Responses Applied To 
window, select the check boxes 
next to the listed responses to 
include in this question response 
style. 

Time Saver: You can also click 
Select All to select all of the 
listed questions. Or, click Clear 
All to deselect any or all of the 
selected questions.
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6. To apply additional criteria to the response style sheet, click Additional Criteria in 
the lower right corner of the window. 

The Additional Criteria Window appears:

Additional Criteria Window

7. From the left pane of the 
Additional Criteria window, 
you can select additional 
conditions that will enable 
the style sheet.

• Ballot Set enables you to 
select a particular ballot 
set. Selecting this option 
will allow you to select 
from the list of ballot sets 
in the right pane.

• Ballot Style enables you to select a particular ballot style. Selecting this options 
will allow you to select from the list of ballot styles in the right pane.

• Language Group enables you to select a particular language group. Selecting 
this option will allow you to select from the list of language groups in the right 
pane.

• Precinct enables you to select a particular precinct. Selecting this option will 
allow you to select from the list of precincts in the right pane.

• District enables you to select a particular district. Selecting this option will allow 
you to select from the list of districts in the right hand pane.

8. You can use the Select All button to select all of the objects within one of the 
criterion groups for the style sheet. You can also use the Clear All button to clear 
any or all of the objects selected within the criteria group.

For example, if you select the Ballot Style check box from the left side of the 
Additional Criteria window, you would use Select All to select all of the ballot styles 
listed in the right side of the Additional Criteria window.

9. When you are finished selecting additional criteria, click OK to accept your changes 
and return to the Responses Applied To window. 

• Or, click Cancel to reject your changes and close to the Additional Criteria 
window.

Note: By selecting one 
of the additional 
conditions, the Select 
All, and Clear All buttons 
are enabled.
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Return to the Responses Applied To Window

10. After returning to the Responses Applied To window, select the responses and 
questions you want the style sheet to apply to and click OK to accept your changes 
and return to the Question Response Style Sheet window.

• Or, click Cancel to reject your changes and close the window.

Return to the Question Response Style Sheet Window

Upon returning to the Question Style Sheet window, you can continue editing the 
question style sheet by adjusting settings in the Size section.

11. Size Section - Enter the width the question response style will span in the Width 
field.

12. Enter the height the question response style will span in the Height field.

The Span box is unavailable for the Question Response style sheet.

13. Margins Section - Under the Margins section, enter the measurement (in inches) in 
the Top, Left, Bottom and Right fields. 

14. Additional Information Section - Select the Vertically Center Content check box to 
place the items entered in the Content section in the center of the style sheet. If this 
check box is not selected, your content will appear at the top of the style sheet. 

15. Position Section - Enter the relative column for the question response style in the 
Relative Column field.

16. If you want the question response to have a column skipped after it, enter the 
column you want to skip in the Column Skip After field.

17. Click OK to accept your settings and return to the Question Response Styles 
window.

• Or, click Cancel to reject your settings and close the Question Response Style 
Sheet window.

Note: By selecting a question, all of the responses are selected or deselected. You can 
deselect undesired responses by clicking on them individually.

Note: Question Response style sheets are used within the Question Style sheet.
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Contest Level Text Style Sheet

The Contest Level Text Style Sheet is only available for the Column-Portrait layout 
format. Contest Level Text Style Sheets are used in conjunction with contests to offer 
related information such as special contest related information. Contest level text is 
entered in Capture, and is automatically positioned by Paper Ballot. Use the following 
information to add or edit contest level text style sheets:

Adding a Contest Level Text Style Sheet

Take the following steps to create a new candidate level text style sheet:

1. From the Style Sheets menu, click Contest Level Text.

The Contest Level Text Styles window 
will appear:

2. From the Contest Level Text Styles 
window, click Add to add a new style; or 
Edit for existing style sheets. 

The Contest Level Text Style 
Sheet window will appear:

3. Style Sheet Name Section - In 
the Style Sheet Name field, 
enter a name for the text style 
sheet. 

4. Contests Applied To Section - 

Click the ellipsis button ( ) 
next to the Contests Applied To 
field. 

The Text Applied To window 
appears:
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Text Applied To Window

5. From the Text Applied To window, 
select the check boxes next to the 
listed text to include with this text 
style. 

6. To apply additional criteria to the 
text style, click Additional Criteria in the lower right corner of the window. 

The Additional Criteria Window appears:

Additional Criteria Window

7. From the left pane of the 
Additional Criteria window, 
you can select additional 
conditions that will enable 
the style sheet.

• Ballot Set enables you to 
select a particular ballot 
set. Selecting this option 
will allow you to select 
from the list of ballot sets 
in the right pane.

• Ballot Style enables you to select a particular ballot style. Selecting this options 
will allow you to select from the list of ballot styles in the right pane.

• Language Group enables you to select a particular language group. Selecting 
this option will allow you to select from the list of language groups in the right 
pane.

• Precinct enables you to select a particular precinct. Selecting this option will 
allow you to select from the list of precincts in the right pane.

• District enables you to select a particular district. Selecting this option will allow 
you to select from the list of districts in the right hand pane.

Time Saver: You can also click 
Select All to select all of the 
listed questions. Or, click Clear 
All to deselect any or all of the 
selected questions.

Note: By selecting one of 
the additional conditions, 
the Select All, and Clear 
All buttons are enabled.
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8. You can use the Select All button to select all of the objects within one of the 
criterion groups for the style sheet. You can also use the Clear All button to clear 
any or all of the objects selected within the criteria group.

For example: If you select the Ballot Style check box from the left side of the 
Additional Criteria window, you would use Select All to select all of the ballot styles 
listed in the right side of the Additional Criteria window.

9. When you are finished selecting additional criteria, click OK to accept your changes 
and return to the Text Applied To window. 

• Or, click Cancel to reject your changes and close to the Additional Criteria 
window.

Return to the Text Applied To Window

10. After returning to the Text Applied To window, select the parties you want the style 
sheet to apply to and click OK to accept your changes and return to the Text Style 
Sheet window

• Or, click Cancel to reject your changes and close the window.

Return to the Text Style Sheet Window

Upon returning to the Text Style Sheet window, you can continue editing your ballot by 
making changes in the Size section.

11. Size Section - Enter the number of marks for the text height in the Height field.

The Span and Width fields are disabled for text style sheets.

12. Margins Section - Under the Margins section, enter the measurement (in inches) in 
the Top, Left, Bottom and Right fields. 

13. Ruling Lines Section - Under the Ruling Lines section, enter the measurements (in 
inches) of the border around the text in the Top, Left, Bottom and Right fields. 

Ruling lines for the Column-Portrait version of the party style sheet are defaulted to 
.006 inches for the top, left, bottom, and right ruling lines.

14. Additional Information Section 1 - Click the Background Color drop-down menu, 
and select the background color for the text.

15. Select the Vertically Center Content check box to place the items entered in the 
Content section in the center of the box. If this check box is not selected, your 
content will appear at the top of the box. 

Reference: To create a customized color, click Custom, located at the bottom of the list. 
For more information about creating custom colors, see Custom Color Settings. 
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16. Click the Panels button to add or delete panels from the current text style sheet.

17. Additional Information Section 2 - Select Enable Text Flow to have the text flow from 
one column to the next. When selected, the Text Flow Settings button becomes 
activated.

Click the Text Flow Settings to configure the text’s flow. Select Allow text to flow 
from front side to back side to allow the text to flow from the front of the ballot to 
the back side. Select Widow/Orphan control to ensure that paragraphs remain 
generally in tact when flowing between columns. This setting prevents too many 
lines of text from being orphaned from the main body.

18. Position Section - The Position section lists a Sheet/Side option. Click the Sheet/
Side drop-down list and select the position where the text will display on your 
ballots. 

• Select Auto for an automatic positioning of the text style sheet. 

• You can select to have the text style appear on the next available sheet by 
selecting the Sheet (‘#’)-Front/Back option. 

• If you opt for the text to appear on a different sheet, the Column and Row 
options become available. 

• Select the column you would like the text to appear in by selecting a number 
from the Column list. 

• Select the row number where you want the text style to appear by selecting a 
number from the Row list.

19. Click OK to accept your changes and return to the Contest Level Text Style Sheet 
window.

• Or, click Cancel to reject your settings and close the window.

Reference: See Panels for more detailed information regarding creating panels for your 
ballot.

Note: The (‘#’) is equal to the available sheet number. (e.g. sheet 1)

Note: Leave the Column selection set for Auto if you want the text style to appear in the 
first column on the back of the ballot.

Note: Leave the Row selection set for Auto if you want the text style to appear in the first 
column on the back of the ballot.
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Candidate Level Text Style Sheet

The Candidate Level Text style sheet is applicable to all three ballot layout formats. 
Candidate Level Text Style Sheets are used in conjunction with candidates to offer 
related information such as address and vocational information. Candidate level text is 
entered in Capture, and is automatically positioned by Paper Ballot. Use the following 
information to add or edit candidate level text style sheets:

Adding a Candidate Level Text Style Sheet

Take the following steps to create a new candidate level text style sheet:

1. From the Style Sheets menu, click Candidate Level Text.

The Candidate Level Text Styles window 
will appear:

2. From the Candidate Level Text Styles 
window, click Add to add a new style; or 
Edit for existing style sheets. 

The Candidate Level Text 
Style Sheet window will 
appear:

3. Style Sheet Name Section - 
In the Style Sheet Name 
field, enter a name for the 
text style sheet. 

4. Candidates Applied To 
Section - Click the ellipsis 

button ( ) next to the 
Contests Applied To field. 

The Text Applied To window 
appears:
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Candidates Applied To 
Window

5. From the Candidates Applied 
To window, select the check 
boxes next to the listed 
Candidate Level Text to 
include with this Candidate 
style. 

6. To apply additional criteria to the Candidate Level Text style, click Additional Criteria in 
the lower right corner of the window. 

The Additional Criteria Window appears:

Additional Criteria Window

7. From the left pane of the 
Additional Criteria window, 
you can select additional 
conditions that will enable 
the style sheet.

• Ballot Set enables you to 
select a particular ballot 
set. Selecting this option 
will allow you to select 
from the list of ballot sets 
in the right pane.

• Ballot Style enables you to select a particular ballot style. Selecting this options 
will allow you to select from the list of ballot styles in the right pane.

• Language Group enables you to select a particular language group. Selecting 
this option will allow you to select from the list of language groups in the right 
pane.

• Precinct enables you to select a particular precinct. Selecting this option will 
allow you to select from the list of precincts in the right pane.

Time Saver: You can also 
click Select All to select all 
of the listed Candidate 
Level Text. Or, click Clear 
All to deselect any or all of 
the selected Candidate 
Level Text.

Note: By selecting one of 
the additional conditions, 
the Select All, and Clear 
All buttons are enabled.
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• District enables you to select a particular district. Selecting this option will allow 
you to select from the list of districts in the right hand pane.

8. You can use the Select All button to select all of the objects within one of the 
criterion groups for the style sheet. You can also use the Clear All button to clear 
any or all of the objects selected within the criteria group.

For example: If you select the Ballot Style check box from the left side of the 
Additional Criteria window, you would use Select All to select all of the ballot styles 
listed in the right side of the Additional Criteria window.

9. When you are finished selecting additional criteria, click OK to accept your changes 
and return to the Text Applied To window. 

• Or, click Cancel to reject your changes and close to the Additional Criteria 
window.

Return to the Candidates Applied To Window

10. After returning to the Candidates Applied To window, select the contests you want 
the style sheet to apply to and click OK to accept your changes and return to the 
Text Style Sheet window.

• Or, click Cancel to reject your changes and close the window.

Return to the Candidate Level Text Style Sheet Window

Upon returning to the Candidate Level Text Style Sheet window, you can continue 
editing your ballot by making changes in the Size section.

11. Size Section - Enter the number of marks for the text height in the Height field.

The Span and Width fields are disabled for text style sheets.

12. Margins Section - Under the Margins section, enter the measurement (in inches) in 
the Top, Left, Bottom and Right fields. 

13. Ruling Lines Section - Under the Ruling Lines section, enter the measurements (in 
inches) of the border around the text in the Top, Left, Bottom and Right fields. 

Ruling lines for the Column-Portrait version of the party style sheet are defaulted to 
.006 inches for the top, left, bottom, and right ruling lines.

14. Additional Information Section - Click the Background Color drop-down menu, 
and select the background color for the text.

Reference: To create a customized color, click Custom, located at the bottom of the list. 
For more information about creating custom colors, see Custom Color Settings. 
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15. Select the Vertically Center Content check box to place the items entered in the 
Content section in the center of the box. If this check box is not selected, your 
content will appear at the top of the box. 

16. Click the Panels button to add or delete panels from the current text style sheet.

17. Click OK to accept your changes and return to the Candidate Level Text Style Sheet 
window.

• Or, click Cancel to reject your settings and close the window.

Office Heading Style Sheet

The Office Heading Style Sheet is only available for the Column-Portrait layout style. 
Use office headings to differentiate offices categorically. The Office Heading Style Sheet 
enables you to adjust properties related to office headings. 

Adding an Office Heading Style Sheet

Take the following steps to create a new office heading style sheet:

1. From the Style Sheets menu, click Office Heading. 

The Office Heading Styles window 
appears:

2. From the Office Heading Styles 
window, click Add to add a new style; 
or Edit for existing style sheets. 

Reference: See Panels for more detailed information regarding creating panels for your 
ballot.
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The Office Heading Style Sheet 
window appears:

3. Style Sheet Name Section - In 
the Style Sheet Name field, 
enter a name for the office 
heading style sheet. 

4. Headings Applied to Section - 

Click the ellipsis button ( ) 
next to the Headings Applied 
To field. 

The Office Headings Applied To 
window appears:

5. Office Headings Applied To 
Window - From the Office 
Headings Applied To window, 
select the check boxes next to 
the listed race types to include 
with this office heading style.

6. To apply additional criteria to the office headings style, click Additional Criteria in 
the lower right corner of the window. 

The Additional Criteria Window appears:

Time Saver: You can also click 
Select All to select all of the 
listed contest types. Or, click 
Clear All to deselect any or all 
of the selected contest types.
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Additional Criteria Window

7. From the left pane of the 
Additional Criteria window, 
you can select additional 
conditions that will enable 
the style sheet.

By selecting one of the 
additional conditions, the 
Select All, and Clear All 
buttons are enabled.

• Ballot Set enables you 
to select a particular 
ballot set. Selecting this 
option will allow you to 
select from the list of 
ballot sets in the right 
pane.

• Ballot Style enables you to select a particular ballot style. Selecting this options 
will allow you to select from the list of ballot styles in the right pane.

• Language Group enables you to select a particular language group. Selecting 
this option will allow you to select from the list of language groups in the right 
pane.

• Precinct enables you to select a particular precinct. Selecting this option will 
allow you to select from the list of precincts in the right pane.

• District enables you to select a particular district. Selecting this option will allow 
you to select from the list of districts in the right hand pane.

8. You can use the Select All button to select all of the objects within one of the 
criterion groups for the style sheet. You can also use the Clear All button to clear 
any or all of the objects selected within the criteria group.

For example: If you select the Ballot Style check box from the left side of the 
Additional Criteria window, you would use Select All to select all of the ballot styles 
listed in the right side of the Additional Criteria window.

9. When you are finished selecting additional criteria, click OK to accept your changes 
and return to the Office Headings Applied To window. 

• Or, click Cancel to reject your changes and close to the Additional Criteria 
window.

Return to the Heading Style Sheet Window

Upon return to the Heading Style Sheet window, you can continue editing your ballot by 
making changes to the Size section.
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10. Size Section - Enter the number of marks for the office heading height in the Height 
field.

11. Enter the span of the heading style sheet in the Span field.

The Width field is disabled for office heading style sheets.

12. Margins Section - Under the Margins section, enter the measurement (in inches) in 
the Top, Left, Bottom and Right fields. 

13. Ruling Lines Section - Under the Ruling Lines section, enter the measurements (in 
inches) of the border around the text in the Top, Left, Bottom and Right fields. 

14. Additional Information Section - Click the Background Color list and select the 
background color for the text.

15. Select the Vertically Center Content check box to place the items entered in the 
Content section in the center of the style sheet. If this check box is not selected, 
your content will appear at the top of the style sheet. 

16. Click the Panels button to add or delete panels from the current Office Heading 
style sheet.

Office Row Heading Style Sheet

The Office Row Heading style sheet is applicable to only the Grid-Landscape ballot.The 
following information details the options available for this style sheet.

Note: You can use the span setting to make a heading span the entire width of a ballot. 
This is typically used when creating Rank Choice Voting (RCV) contests, as the races 
themselves are laid out horizontally, and the heading is used as the contest title for all of 
the affected races. 

See the image below for an example of a RCV contest with the heading spanning all three 
columns of the ballot:

Reference: To create a customized color, click Custom, located at the bottom of the 
drop-down menu. For more information about creating custom colors, see Custom Color 
Settings.

Reference: See Panels for more detailed information regarding creating panels for your 
ballot.
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The Office Row Heading style sheet enables you to change the appearance of your 
office row headings on a landscape ballot. You cannot add or delete style sheets from 
the Office Row Heading Style window. You can only edit the default Office Row Heading 
style sheet.

Editing the Office Row Heading Style Sheet

Take the following steps to edit the office row heading style sheet:

1. From the Style Sheets menu, click Office Row Heading. 

The Office Row Heading Style window 
appears:

2. From the Office Row Heading Style 
window, select the default office row 
heading and click Edit. 

The Heading Style Sheet 
window appears:

Style Sheet Name Section - 
The Default Office Row 
Heading Style Sheet name 
cannot be edited.

Headings Applied To 
Section - The Default Office 
Row Heading Style Sheet 
Headings Applied To 
information cannot be 
edited.

3. Size Section - Enter the 
width the office row heading 
style sheet will span in the 
Width field.

The Height and Span fields 
are both disabled for the 
Office Row Heading style 
sheet.
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4. Margins Section - Under the Margins section, enter the measurement (in inches) in 
the Top, Left, Bottom and Right boxes.

5. Ruling Lines Section - Under the Ruling Lines section, enter the measurements of 
the border width around the office row heading (in inches) in the Top, Left, Bottom 
and Right boxes. 

Ruling lines for the Grid-Portrait version of the office row heading style sheet are 
defaulted to .006 inches for the top, left, bottom, and right ruling lines.

6. Additional Information Section - Click the Background Color drop-down menu, 
and select the background color for the office row heading.

7. Select the Vertically Center Content check box to place the items contained in the 
Content section in the center of the style sheet. If this check box is not selected, 
your content will appear at the top of the style sheet. 

8. Click the Panels button to add or delete panels from the current office row heading 
style sheet.

Write-in Row Heading Style Sheet 

The Write-in Row Heading style sheet is applicable to only the Grid-Landscape ballot. 
The following information details the options available for this style sheet.

The Write-In row heading style sheet enables you to change the appearance of the 
Write-In row headings on your ballot. The Write-In row heading appears to the left of all 
of your write-in options for contests. You cannot add or delete style sheets from the 
Write-in Row Heading Style window. You can only edit the default Write-in Row Heading 
style sheet.

Editing the Write-in Row Heading Style Sheet

Take the following steps to edit the default Write-In row heading style sheet:

1. From the Style Sheets menu, click Write-in Row Heading. 

Reference: To create a customized color, click Custom, located at the bottom of the 
Background Color list. For more information about creating custom colors, see Custom 
Color Settings.

Reference: See Panels for more detailed information regarding creating panels for your 
ballot.
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The Write-in Row Heading Style 
window will appear:

2. From the Write-in Row Heading Style 
window, click Edit. 

The Heading Style Sheet 
window will appear: 

Style Sheet Name Section - 
The Default Write-in Row 
Heading Style Sheet name 
cannot be edited.

Headings Applied To 
Section - The Default 
Write-in Row Heading Style 
Sheet Headings Applied To 
information cannot be 
edited.

3. Size Section - Enter the 
width the Write-in row 
heading style will span in the 
Width field.

The Height and Span boxes 
are disabled for the Write-in 
Row Heading style sheet.

4. Margins Section - Under the Margins section, enter the measurement (in inches) in 
the Top, Left, Bottom and Right fields. 

5. Ruling Lines Section - Under the Ruling Lines section, enter the measurements (in 
inches) of the border around the write-in row heading in the Top, Left, Bottom and 
Right fields. 

Note: Ruling lines for the Grid-Portrait version of the Write-in row heading style sheet are 
defaulted to .006 inches for the top, left, bottom, and right ruling lines.
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6. Additional Information Section - Click the Background Color drop-down menu, 
and select the background color for the write-in row heading. 

7. Select the Vertically Center Content check box to place the items entered in the 
Content section in the center of the style sheet. If this check box is not selected, 
your content will appear at the top of the style sheet. 

8. Click the Panels button to add or delete panels from the current Write-in row 
heading style sheet.

Write-in Column Heading Style Sheet 

The Write-in Column Heading style sheet is only applicable to the Grid-Portrait layout 
type only. The following information details the options available for this style sheet.

The write-in column heading style sheet enables you to change the appearance of the 
write-in column headings on your ballot. The write-in column heading appears at the 
top of your write-in column. When you create a new write-in column heading, the 
default settings will automatically appear in the boxes within the Heading Style Sheet 
window. 

Adding a Write-in Column Heading Style Sheet

Take the following steps to add or edit the default write-in column heading style sheet:

1. From the Style Sheets menu, click Write-in Column Heading. 

The Write-in Column Heading Style 
window will appear:

2. From the Write-In Column Heading 
Style window, click Add to add a new 
Write-In column heading. 

• Or click Edit to edit and existing 
Write-In column heading. 

Reference: To create a customized color, click Custom, located at the bottom of the list. 
For more information about creating custom colors, see Custom Color Settings. 

Reference: See Panels for more detailed information regarding creating panels for your 
ballot.
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The Heading Style Sheet 
window appears: 

3. Style Sheet Name Section - 
In the Style Sheet Name 
field, enter a name for the 
Write-In column heading 
style sheet. 

4. Headings Applied To 
Section - Click the ellipsis 

button ( ) next to the 
Headings Applied To field.

The Headings Applied To window 
appears:

5. Headings Applied To Window - 
From the Headings Applied To 
window, select the check boxes 
next to the listed sheets to include 
with this heading style. 

6. To apply additional criteria to the 
Write-In column headings style, click Additional Criteria in the lower right corner of 
the window. 

Time Saver: You can also click 
Select All to select all of the 
listed contest types. Or, click 
Clear All to deselect any or all 
of the selected contest types.
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The Additional Criteria 
Window appears:

Additional Criteria Window

7. From the left pane of the 
Additional Criteria window, 
you can select additional 
conditions that will enable 
the style sheet.

By selecting one of the 
additional conditions, the 
Select All, and Clear All 
buttons are enabled.

• Ballot Set enables you to 
select a particular ballot set. Selecting this option will allow you to select from 
the list of ballot sets in the right pane.

• Ballot Style enables you to select a particular ballot style. Selecting this options 
will allow you to select from the list of ballot styles in the right pane.

• Language Group enables you to select a particular language group. Selecting 
this option will allow you to select from the list of language groups in the right 
pane.

• Precinct enables you to select a particular precinct. Selecting this option will 
allow you to select from the list of precincts in the right pane.

• District enables you to select a particular district. Selecting this option will allow 
you to select from the list of districts in the right hand pane.

8. You can use the Select All button to select all of the objects within one of the 
criterion groups for the style sheet. You can also use the Clear All button to clear 
any or all of the objects selected within the criteria group.

For example: If you select the Ballot Style check box from the left side of the 
Additional Criteria window, you would use Select All to select all of the ballot styles 
listed in the right side of the Additional Criteria window.

9. Click OK to accept your changes and return to the Headings Applied To window.

• Or, click Cancel to reject your changes close the Additional Criteria window.

Return to the Headings Applied To Window

10. After returning to the Headings Applied To window, select the race types you want 
the style sheet to apply to and click OK to accept your changes and return to the 
Heading Style Sheet window. 

• Or, click Cancel to reject your changes and close the window.
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Return to the Heading Styles Sheet Window

Upon returning to the Heading Style Sheet window, you can continue editing your ballot 
by making changes in the size section.

11. Size Section - There are no available size options for the Grid-Portrait Write-in 
column heading style sheet.

12. Margins Section - Under the Margins section, enter the measurement (in inches) in 
the Top, Left, Bottom and Right boxes. 

13. Ruling Lines Section - Under the Ruling Lines section, enter the measurements (in 
inches) of the border around the write-in column heading in the Top, Left, Bottom 
and Right fields. 

Ruling lines for the Grid-Portrait version of the Write-in Column Heading style sheet 
are defaulted to .006 inches for the top, left, bottom, and right ruling lines.

14. Additional Information Section - Click the Background Color drop-down menu, 
and select the background color for the write-in column heading. 

15. Select the Vertically Center Content check box to place the items entered in the 
Content section in the center of the box. If this check box is not selected, your 
content will appear at the top of the box. 

16. Click the Panels button to add or delete panels from the current Write-in Column 
Heading style sheet.

Reference: To create a customized color, click Custom, located at the bottom of the list. 
For more information about creating custom colors, see Custom Color Settings.

Reference: See Panels for more detailed information regarding creating panels for your 
ballot.
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Column Heading Style Sheet 

The Column Heading style sheet is only available for the Column-Portrait layout type. 
Use the column heading style sheet to change the appearance of the column headings 
on your ballot. The column heading appears to at the top of your ballot columns. When 
you create a new column heading, the default settings will automatically appear in the 
boxes within the Column Heading Style window. 

Adding a Column Heading Style Sheet

Take the following steps to add or edit the default column heading style sheet:

1. From the Style Sheets menu, click Column Heading. 

The Column Heading Style window 
appears:

2. From the Column Heading Style 
window, click Add to add a new 
column heading. Or click Edit to edit 
an existing column heading. 

The Heading Style Sheet 
window appears: 

3. Style Sheet Name Section - In 
the Style Sheet Name field, 
enter a name for the heading 
column style sheet. 

4. Headings Applied To Section - 

Click the ellipsis button ( ) 
next to the Headings Applied 
To field. 
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The Column Headings Applied To window appears:

Column Headings Applied To 
Window

5. From the Headings Applied To 
window, select the check boxes next 
to the listed sheets and columns to 
include with this heading style. 

6. To apply additional criteria to the column headings style, click Additional Criteria in 
the lower right corner of the window.

The Additional Criteria Window appears:

Additional Criteria Window

7. From the left pane of the 
Additional Criteria window, 
you can select additional 
conditions that will enable 
the style sheet.

By selecting one of the 
additional conditions, the 
Select All, and Clear All 
buttons are enabled.

• Ballot Set enables you to 
select a particular ballot 
set. Selecting this option 
will allow you to select 
from the list of ballot sets 
in the right pane.

• Ballot Style enables you to select a particular ballot style. Selecting this options 
will allow you to select from the list of ballot styles in the right pane.

• Language Group enables you to select a particular language group. Selecting 
this option will allow you to select from the list of language groups in the right 
pane.

• Precinct enables you to select a particular precinct. Selecting this option will 
allow you to select from the list of precincts in the right pane.

Time Saver: You can also click 
Select All to select all of the listed 
contest types. Or, click Clear All 
to deselect any or all of the 
selected contest types.
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• District enables you to select a particular district. Selecting this option will allow 
you to select from the list of districts in the right hand pane.

8. You can use the Select All button to select all of the objects within one of the 
criterion groups for the style sheet. You can also use the Clear All button to clear 
any or all of the objects selected within the criteria group.

For example: If you select the Ballot Style check box from the left side of the 
Additional Criteria window, you would use Select All to select all of the ballot styles 
listed in the right side of the Additional Criteria window.

9. Click Cancel to reject your changes and close the Additional Criteria window. Or, 
click OK to accept your changes and return to the Column Headings Applied To 
window. 

Return to the Column Headings Applied To Window

10. After returning to the Column Headings Applied To window, select the headings you 
want the style sheet to apply to and click OK to accept your changes and return to 
the Heading Style Sheet window. 

• Or, click Cancel to reject your changes and close the window.

Return to the Heading Style Sheet Window

Upon returning to the Heading Style Sheet window, you can continue to edit your ballot 
by making changes to the Size section.

11. Size Section - Enter the number of marks for the office heading height in the Height 
box.

The Width, and Span buttons are disabled for the Column Heading Style Sheet.

12. Margins Section - Under the Margins section, enter the measurement (in inches) in 
the Top, Left, Bottom and Right fields. 

13. Ruling Lines Section - Under the Ruling Lines section, enter the measurements (in 
inches) of the border around the write-in row heading in the Top, Left, Bottom and 
Right fields. 

14. Additional Information Section - Click the Background Color drop-down menu, 
and select the background color for the write-in row heading. 

15. Select the Vertically Center Content check box to place the items entered in the 
Content section in the center of the style sheet. If this check box is not selected, 
your content will appear at the top of the style sheet. 

Reference: To create a customized color, click Custom, located at the bottom of the list. 
For more information about creating custom colors, see Custom Color Settings.
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16. Click the Panels button to add or delete panels from the column heading style 
sheet.

Reference: See Panels for more detailed information regarding creating panels for your 
ballot.
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Chapter 16: Adding Content to Style Sheets

Add Data to Style Sheets

1. In the Content section of the selected Style Sheet window, click Add to add data to 
the style sheet. 

The Style Sheet Content 
window appears:

2. Content Type Section - 
Click the Data radio 
button in the Content 
Type section to insert data 
carried over from Capture. 
From the drop-down 
menu, select the data you 
would like to insert. 

The default data to appear 
on your ballot are the Office Title and the “Vote for” phrase. In addition, you can 
add any other data you may have included in Capture, such as the term phrase, 
district name, or any miscellaneous information you added in the additional text 
fields.

In addition, you can select Blank Line to add a line of space to separate data, text, 
or graphics.

3. Additional Information Section - Enter your data margins (in inches) in the Left 
Margin and Right Margin fields. 

If an Absolute option is selected in the Position drop-down menu, the Margin fields 
are absent from the Additional Information section.

4. Click the Panels drop-down menu to select one of the panels you added under the 
Additional Information section of the selected Style Sheet window.

5. Content Properties Section - Enter additional settings in the Content Properties 
section: 

• Click the Position drop-down menu, and select where you want the data to 
display within the style sheet. 

Select Top to place the data at the top of the style sheet. 

Select Bottom to place the data at the bottom of the style sheet. 

Reference: See Panels for more information regarding adding panels to the style sheet.
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Select Absolute/Left Top, Absolute/Right Top, Absolute/Left Bottom, or 
Absolute/Right Bottom to enable the Left or Right, and Top or Bottom Offset 
fields. The entries made in these fields will determine how far from the left or 
right, and top or bottom of the style sheet the data will appear.

• Select the Same Line check box to include all of your data on the same line as 
previous content item. For instance, if you wanted both the additional data 
content and additional text content (e.g. the office title and vote for phrase) 
both to appear on the same line, you would click Same Line for the additional 
text content. This flags the system that you want to merge the two items on the 
first line of the style sheet. 

The Same Line option is not available if an Absolute option is selected from the 
Position drop-down menu.

• Click the Line Size drop-down menu, and select the height of the area used for 
your data. If you choose Font Size, the data will display with standard spacing 
between two lines of data. If you select a smaller line size, two lines of data will 
be closer together. If you select a larger line size, two lines of data will be farther 
apart. 

The Line Size option is not available if an Absolute option is selected from the 
Position drop-down menu.

• To rotate your data, click the Rotate list and select the appropriate angle. 

• Click the Alignment list and select the select the appropriate data alignment 
option (for example, Right, Center, or Justify). 

The Alignment option is not available if an Absolute option is selected from the 
Position drop-down menu.

• The text wrap option is automatically enabled. If you want to disable the text 
wrap option, select the No Text Wrap check box. 

The No Text Wrap option is not available if an Absolute option is selected from 
the Position drop-down menu.

• Click the Language drop-down menu, and select the appropriate ballot 
language.

6. To change the appearance of the text, click Font, and make the appropriate changes 
in the Font window. 

Note: If the Content Rows are positioned as TOP, then you should apply the Same Line 
options to the second of the two Content Rows you want to combine. If the Content Rows 
are positioned as Bottom then you should apply the Same Line options to the first of the 
tow Content Rows you want to combine.

Warning: If you place additional items on the same line, you must use different alignments 
(Left, Center, or Right) for each of them. Failure to do so will make the two items overlap 
in the style sheet.

Reference: See Font Settings Window for more detailed information regarding changing 
your font settings.
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7. Click the Font Kerning drop-down menu, and select the appropriate setting. The 
greater the positive number, the farther apart the data will appear. The greater the 
negative number, the closer together the data will appear.

8. Click OK. Your text setting will appear in the Content section in the selected Style 
Sheet window:

9. Enter additional elements, such as text, a line or an imported graphic to the style 
sheet. 

• To add text to a style sheet, see  Add Text to Style Sheets.

• To add graphics to a style sheet, see  Add Graphics to Style Sheets. 

• To add lines to a style sheet, see  Add Lines to Style Sheets.

Add Text to Style Sheets

1. In the Content section of the Office Style Sheet window, click Add to add a text item 
to the style sheet. 

The Style Sheet Content window will appear:

2. Content Type Section - Click the Text radio button and either enter the desired 
text, or select a text entry or substitution variable from the drop-down menu.

3. To provide text items such as detailed instructions, select Text Editor to generate a 
Text window. 

Note: Added text is used primarily in Frames, or for data that appears on the paper ballot 
but not in Accessible Ballot.

Warning: Text items added to a style sheet will not carry forward into Accessible Ballot, 
and will not appear on the AutoMark.

Note: You can also paste the text item into the Text box.
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The Text window appears. 

4. Enter the text, as you want 
it to appear on the ballot, 
in the Text window. 

5. Click OK to accept your 
changes and return to the 
Style Sheet Content 
window.

• Or, click Cancel to 
reject your changes 
and close the text 
window.

Return to the Style Sheet 
Content Window

6. Additional Information Section - Enter your text margins (in inches) in the Left 
Margin and Right Margin fields.

If an Absolute option is selected in the Position drop-down menu, the Margin fields 
are absent from the Additional Information section.

7. Click the Panels drop-down menu to select one of the panels you added under the 
Additional Information section of the selected style sheet window.

8. Content Properties Section - Enter additional settings in the Content Properties 
section: 

• Click the Position list and select where you want the text to display within the 
style sheet. 

Select Top to place the text at the top of the style sheet.

Select Bottom to place the text at the bottom of the style sheet. 

Select Absolute/Left Top, Absolute/Right Top, Absolute/Left Bottom, or 
Absolute/Right Bottom to enable the Left or Right, and Top or Bottom Offset 
boxes. The entries made in these boxes will determine how far from the left or 
right, and top or bottom of the style sheet the text will appear.

Reference: See Panels for more information regarding adding panels to the style sheet.
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• Select the Same Line check box to include all of your text on the same line as 
previous content item. For instance, if you wanted both the additional data 
content and additional text content (e.g. the office title and vote for phrase) 
both to appear on the same line, you would click Same Line for the additional 
text content. This flags the system that you want to merge the two items on the 
first line of the style sheet.

The Same Line option is not available if an Absolute option is selected from the 
Position drop-down menu.

• Click the Line Size drop-down menu and select the height of the area used for 
your text. If you choose Font Size, the text will display with standard spacing 
between two lines of text. If you select a smaller line size, two lines of text will be 
closer together. If you select a larger size, two lines of text will be farther apart. 

The Line Size option is not available if an Absolute option is selected from the 
Position drop-down menu.

• To rotate your text, click the Rotate list and select the appropriate angle. 

• Click the Alignment list and select the appropriate text alignment option (for 
example, Right, Center, or Justify). 

The Alignment option is not available if an Absolute option is selected from the 
Position drop-down menu.

• The text wrap option is automatically activated. If you want to turn off the text 
wrap option, select the No Text Wrap check box.

The No Text Wrap option is not available if an Absolute option is selected from 
the Position drop-down menu.

• Click the Language drop-down menu and select the appropriate ballot 
language.

9. To change the appearance of the text, click Font, and make the appropriate changes 
in the Font window. 

10. Click the Font Kerning list and select the appropriate setting. The greater the 
positive number, the farther apart the text will appear. The greater the negative 
number, the closer together the text will appear.

11. Click OK. Your text setting will appear in the Content section in the selected style 
sheet window.

Note: If the Content Rows are positioned as TOP, then you should apply the Same Line 
options to the second of the two Content Rows you want to combine. If the Content Rows 
are positioned as Bottom then you should apply the Same Line options to the first of the 
tow Content Rows you want to combine.

Warning: If you place additional items on the same line, you must use different alignments 
(Left, Center, or Right) for each of them. Failure to do so will make the two items overlap 
in the style sheet.

Reference: See Font Settings Window for more detailed information regarding changing 
your font settings.
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12. To place the text above style sheet data, graphics or lines, click the text and click 
Move Up. To place the text below style sheet data, graphics or lines, click the text 
and click Move Down. 

13. Incorporate additional elements, such as data, lines or graphics in the style sheet. 

• To add data to a style sheet, see Chapter 16: Adding Content to Style Sheets

• To add graphics to a style sheet, see  Add Graphics to Style Sheets. 

• To add lines to office style sheets, follow steps  Add Lines to Style Sheets.

Add Graphics to Style Sheets

1. In the Content section, click Add to add a graphic to the selected style sheet. 

The Style Sheet Content 
window appears: 

2. Content Type Section - 
Click Graphic and select 
the appropriate graphic to 
include from the 
drop-down menu. 

Graphic types include the 
following:

• Party Graphic – 
imported in Capture, 
and associated with specific parties (e.g. Republican = elephant mascot).

• Candidate Graphic – imported in Capture, and related to specific candidates 
(e.g. candidate faces).

• Ballot set party graphic – associated with a particular ballot set (e.g., a closed 
primary with a Democrat ballot set may utilize a donkey as its mascot).

3. Additional Information Section - Enter the margins for the graphic (in inches) in the 
Left and Right Margin fields.

If an Absolute option is selected in the Position drop-down menu, the Margin fields 
are absent from the Additional Information section.

4. Click the Panels drop-down menu to select one of the panels you added under the 
Additional Information section of the selected style sheet window.

Reference: If your graphic is missing, refer to Chapter 9: Graphics for instructions about 
importing graphics.

Reference: See Panels for more information regarding adding panels to a style sheet.
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5. Content Properties Section - Enter additional settings in the Content Properties 
section:

• Click the Position list and select where you want the graphic to display within 
the style sheet. 

Select Top to place the graphic at the top of the style sheet.

Select Bottom to place the graphic at the bottom of the style sheet. 

Select Absolute/Left Top, Absolute/Right Top, Absolute/Left Bottom, or 
Absolute/Right Bottom to enable the Left or Right, and Top or Bottom Offset 
fields. The entries made in these fields will determine how far from the left or 
right, and top or bottom of the style sheet the graphic will appear.

• Click the Line Size drop-down menu, and select the height you desire. The line 
size adjusts the spacing between the graphic and the next content line. If you 
choose Graphic Size, the graphic will appear the same size as allocated to the 
graphics file. The Line Size option is not available if an Absolute option is 
selected from the Position drop-down menu.

• To rotate the image, click the Rotate drop-down menu and select the 
appropriate angle.

• Choose to align the graphic to the Left, Right, or Center from the Alignment 
drop-down menu.

If an Absolute position is selected, the Alignment option is unavailable.

• Click the Scale Factor drop-down menu, and select the image scale (in percent). 

• Click the Language drop-down menu and select the appropriate ballot 
language.

The Language option is currently disabled for graphics in this version of 
ElectionWare.

6. Click OK to accept your changes and return to the selected style sheet window. Your 
graphic settings will appear in the Content section in the selected style sheet 
window.

• Or, click Cancel to reject your changes and close the Style Sheet Content 
window.

7. Incorporate additional elements, such as text, lines or graphics in the style sheet. 

• To add data to a style sheet, see Chapter 16: Adding Content to Style Sheets.

• To add text to a style sheet, see  Add Text to Style Sheets.

• To add lines to a style sheet, see  Add Lines to Style Sheets.

Add Lines to Style Sheets

1. In the Content section, click Add to add a line to the office style sheet. 
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The Style Sheet Content 
window will appear: 

2. Content Type Section - 
Click Line and select either 
Vertical Line or Horizontal 
Line from the drop-down 
menu. 

3. Additional Information 
Section - If you selected 
Vertical Line, enter your 
line margins (in inches) in 
the Top Margin and 
Bottom Margin fields. The entries in these fields will determine how far the line will 
be from the top and bottom of the office style sheet.

• If you selected Horizontal Line, enter the margins (in inches) for the lines in the 
Left Margin and Right Margin fields. Entries made in these fields will determine 
how far the line will be from the left and right of the office style sheet. 

4. Click the Panels drop-down menu to select one of the panels you added under the 
Additional Information section of the Office Style Sheet window.

5. Content Properties Section - Enter additional settings in the Content Properties 
section:

• Enter the thickness of the line (in inches) in the Line Thickness field.

• If you selected Vertical Line, enter the margins for the line (in inches) in the Left 
Offset field. The entry made in this field will determine how far the line will be 
from the left side of the office style sheet.

• If you selected Horizontal Line, enter the margins for the line (in inches) in the 
Top Offset field. The entry in this field will determine how far the line will be 
from the top of the office style sheet. 

• Click the Line Color drop-down menu, and select the line color.

• Click the Line Style list to set the style as solid, dotted, or dashed.

6. Click OK to accept your settings and return to the Office Style Sheet window. Your 
line setting will appear in the Content section in the Office Style Sheet window:

• Or, Click Cancel to reject your settings and close the Style Sheet window.

7. Incorporate additional elements, such as text, lines or graphics in the style sheet. 

• To add data to a style sheet, see Chapter 16: Adding Content to Style Sheets.

Reference: See Panels For more information regarding adding panels to the office style 
sheet.

Reference: To create a customized color, click Custom, located at the bottom of the list. 
For more information about creating custom colors, see Custom Color Settings.
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• To add text to a style sheet, see  Add Text to Style Sheets.

• To add graphics to a style sheet, see  Add Graphics to Style Sheets.
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Chapter 17: Managing Style Sheets

In addition to designing style sheets, you can also copy, edit, and delete style sheets as 
is appropriate to your election. Use the following information to copy, edit, and delete 
style sheets.

Copy Style Sheets

1. From the Style Sheets menu, select the desired style sheet. 

The (selected) Styles window will 
appear:

2. Select a style sheet, and Click Copy. 

The Copy Style Sheet window appears:

3. Enter a name for the copied style sheet in the Style 
Sheet Name field.

4. Click OK to accept the copy and return to the 
selected style sheet window.

• Or, click Cancel to cancel the copy and close the 
Copy Style Sheet window.

Import Style Sheets

You can Import text from other layout versions of this election, but not from other 
elections since each election has its own database. All of the style types located under 
the Style Sheets menu can be imported. 

Take the following steps to import style sheets:

1. On the Style Sheets menu, click Import. The Open window appears.

2. Select the ballot containing the style(s) you wish to import.

3. Click Open. The Import Style Sheets window appears.

4. Click the box next to the style you wish to import. To import a specific sheet, click ‘+’ 
next to the style and click on the specific style sheet. 
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5. Click OK. 

Edit Style Sheets

1. Click the Style Sheets menu and select a style sheet.

2. Select the appropriate style sheet from the (selected) Styles window and click Edit.

3. From the (selected) Style Sheet window, make any necessary changes.

4. Click OK.

5. Click OK. Your changes will appear in the style sheet Paper Ballot work pane.

Delete Style Sheets

1. Click the Style Sheets menu and select a style sheet.

2. Select the appropriate style sheet from the (selected) Styles window and click 
Delete.

3. When prompted, click Yes to delete the style sheet.

4. Click Close to close the Office Styles window and return to Paper Ballot.

Edit Style Sheet Content

1. Click the Style Sheets menu and select a style sheet.

2. Select the appropriate style sheet in the (selected) Styles window and click Edit.

3. From the (selected) Style Sheet window, locate the content in the Content section 
and click Edit.

4. Enter any changes in the Style Sheet Content window. 

5. Click OK.

6. Click OK. Your changes will appear in the Paper Ballot work pane.

Delete Style Sheet Content

1. Click the Style Sheets menu and select a style sheet.

2. Select the appropriate style sheet in the (selected) Styles window and click Edit.

3. From the (selected) Style Sheet window, locate the content in the Content section 
and click Delete. A confirmation window appears, asking if you want to delete the 
item.

4. Click Yes to confirm the deletion, or No to reject the deletion.

5. Click OK. Your changes will appear in the Paper Ballot work pane.
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Style Sheet Shortcuts

Create a New Style Sheet Shortcut

You can create a new style sheet by right-clicking on a cell (for example, party, 
candidate, office, etc.) and selecting New Style Sheet.

Editing Style Sheets

Once you create your style sheets, you can edit any 
style sheet either by selecting the style sheet from the 
Style Sheets menu or by right-clicking on the style 
sheet or empty cell and selecting Edit Style Sheet.

Applying Different Style Settings

If you have created different style 
sheets for an object type, such as a 
candidate or contest, you can 
apply a different style sheet by 
right- clicking on the object and 
selecting one of the existing style 
sheets.
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Use a Previous Style Setting in a New Style Sheet

You can use the settings of a previously created style sheet in a new style sheet. 

1. Click the Style Sheets menu and select a style sheet.

The selected style sheet window will 
appear: 

2. Click on the style sheet containing the 
settings you wish to use for your new 
style sheet. 

3. Click Add... The style sheet window will 
appear with the settings from the style 
sheet you selected.

Note: If you click Add... without clicking on any style sheet, Paper Ballot will use the 
settings from the default style sheet. These include settings defined in the Ruling Lines and 
Margins sections. However, the Content frame will be empty. 
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Chapter 18: Ballot Frames

Use ballot frames to place instructional information on your ballot. You can assign 
frames, exact ballot positions or position frames by columns. In addition, election data 
can flow around or through the frames you create.

When you create a new frame, the default settings will automatically appear in the 
boxes within the Frame window.

Adding a Frame

Take the following steps to create a new frame:

1. From the Frames menu, click Frame. 

The Frame window appears:

2. Select the Sheet (#) Front tab to place 
your frame at the front of your ballot. 
Select the Sheet (#) Back tab to place 
your frame at the back of your ballot.

3. Click Add. 

Note: The (‘#’) is equal to the 
currently selected sheet number. (e.g. 
sheet 1)
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Frame Window

The Frame window will 
appear:

4. Frame Name Section - In 
the Frame Name field, enter 
a name for the frame. 

5. Location Section - Enter the 
column in which you want to 
place the frame in the 
Column field. 

6. Enter the row in which you 
want to place the frame in 
the Row field. 

7. Size Section - Enter the 
number of marks for the 
frame width in the Width 
field.

8. Enter the number of marks 
for the frame height in the Height field.

9. Margins Section - Under the Margins section, enter the measurement (in inches) in 
the Top, Left, Bottom and Right fields. 

10. Ruling Lines Section - Under the Ruling Lines section, enter the measurements (in 
inches) of the border around the frame in the Top, Left, Bottom and Right fields. 

11. Display Section - Click the Frame Criteria button. 

The Additional Criteria window appears.

Note: Sheet ruling lines are defaulted to .006 inches for the top, left, bottom, and right 
ruling lines.
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Additional Criteria Window

12. From the left pane of the 
Additional Criteria window, 
you can select additional 
conditions that will enable 
the style sheet.

• Ballot Set enables you to 
select a particular ballot 
set. Selecting this option 
will allow you to select 
from the list of ballot sets 
in the right pane.

• Ballot Style enables you to select a particular ballot style. Selecting this options 
will allow you to select from the list of ballot styles in the right pane.

• Language Group enables you to select a particular language group. Selecting 
this option will allow you to select from the list of language groups in the right 
pane.

• Precinct enables you to select a particular precinct. Selecting this option will 
allow you to select from the list of precincts in the right pane.

• District enables you to select a particular district. Selecting this option will allow 
you to select from the list of districts in the right hand pane.

13. Use the Select All button to select all of the objects within one of the criterion 
groups for the style sheet. You can also use the Clear All button to clear any or all of 
the objects selected within the criteria group.

For example: If you select the Ballot Style check box from the left side of the 
Additional Criteria window, you would use Select All to select all of the ballot styles 
listed in the right side of the Additional Criteria window.

14. Click OK to accept your changes and return to the Frame window.

• Or, click Cancel to reject your changes and close the Additional Criteria window. 

Return to the Frame Window

Upon returning to the Frame window, you can continue to edit your ballot by changing 
the settings in the Additional Information frame.

Note: By selecting one 
of the additional 
conditions, Select All, 
and Clear All buttons are 
enabled.
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15. Additional Information Section - Click the Background Color drop-down menu and 
select the background color for the frame.

16. Select the Vertically Center Content check box to place the items entered in the 
Content section in the center of the frame. If this check box is not selected, your 
content will appear at the top of the frame. 

17. Click the Panels button to add or delete panels from the current frame style sheet.

18. Frame Rotation Section - Click the Rotation Angle list and select a value to rotate 
the frame on your ballot.

19. Position Section - Select a method for positioning your frame from the Positioning 
Method drop-down menu. 

• From the drop-down menu, select Column, Row to use columns or rows to 
position your frames. Or, select Left/Top, Left/Bottom, Right/Top or Right/
Bottom as absolute values for the frame locations

• If any of the absolute values are selected, the Absolute Position button is 
activated. 

Absolute Position Window - The Absolute Position 
window enables you to set absolute values to apply to your 
frame locations. To apply absolute positioning to your 
frames, follow the steps listed below:

20. From the Frame window, click Absolute Position 

The Absolute Position window appears:

21. Enter your horizontal offset, (in inches) in the Horizontal 
Offset field. This option sets how far from the top the 
frame will be located on your ballot.

22. Enter your vertical offset, (in inches) in the Vertical 
Offset field. This option sets how far from the left the frame will be located on your 
ballot.

23. Select whether the frame will be positioned in the Foreground or Background by 
selecting one of the afore mentioned options from the Z-Order drop-down menu. 
Selecting Foreground will place the frame in the foreground, whereas selecting 
Background will place the frame in the background.

24. Enter the frame width, (in inches) into the Frame Width box.

25. Enter the frame height, (in inches) into the Frame Height box.

Reference: To create a customized color, click Custom, located at the bottom of the list. 
For more information about creating custom colors, see Custom Color Settings. 

Reference: See Panels for more detailed information regarding creating panels for your 
ballot.
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26. Click OK to accept your changes and return to the Frame window.

• Or, click Cancel to reject your changes and close the Absolute Position window. 

27. Enter additional elements, such as text, lines or an imported graphics to the frame. 
Otherwise, skip to step 25.

• To add data to the frame, follow steps 28 - 35

• To add a text item to the frame, follow steps 37 - 9.

• To add an image to the frame, follow steps 11 - 16. 

• To add a line to the frame, follow steps 18 - 24.

Add Data to a Frame

28. In the Content section, click Add to add data to the frame. 

The Frame Content 
window appears:

29. The Data content type is 
selected by default. You 
can choose from the data 
types on the drop-down 
menu. (Select Blank Line 
to add a blank line 
between text, graphics, 
and lines.)

30. Additional Information 
Section - Enter the 
margins (in inches) in the 
Left Margin and Right Margin fields. 

31. Click the Panels drop-down menu to select one of the panels you added under the 
Additional Information section of the Frame Style Sheet window

32. Content Properties Section - Enter additional settings in the Content Properties 
section: 

• Click the Position drop-down menu, and select where you want the data to 
display within the frame. 

Select Top to place the data at the top of the frame. 

Select Bottom to place the data at the bottom of the frame. 

Note: If an Absolute option is selected the Margin fields are absent from the Additional 
Information section.

Reference: See Panels for more detailed information regarding creating panels for your 
ballot.
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Select Absolute/Left Top, Absolute/Right Top, Absolute/Left Bottom, or 
Absolute/Right Bottom to enable the Left or Right, and Top or Bottom Offset 
fields. The entries made in these fields will determine how far from the left or 
right, and top or bottom of the frame the data will appear.

• Select the Same Line check box to include all of your data on the same line as 
previous content item. For instance, if you wanted both the additional data 
content and additional text content (e.g. the office title and vote for phrase) 
both to appear on the same line, you would click Same Line for the additional 
text content. This flags the system that you want to merge the two items on the 
first line of the style sheet. 

The Same Line option is not available if an Absolute option is selected from the 
Position drop-down menu.

• Click the Line Size drop-down menu, and select the height of the area used for 
your data. If you choose Font Size, the data will display with standard spacing 
between two lines of data. If you select a smaller line size, two lines of data will 
be closer together. If you select a larger line size, two lines of data will be farther 
apart. 

The Line Size option is not available if an Absolute option is selected from the 
Position drop-down menu.

• To rotate your data, click the Rotate list and select the appropriate angle. 

• Click the Alignment list and select the select the appropriate data alignment 
option (for example, Right, Center, or Justify). 

The Alignment option is not available if an Absolute option is selected from the 
Position drop-down menu.

• The text wrap option is automatically enabled. If you want to disable the text 
wrap option, select the No Text Wrap check box. 

The No Text Wrap option is not available if an Absolute option is selected from 
the Position drop-down menu.

• Click the Language drop-down menu, and select the appropriate ballot 
language.

33. To change the appearance of the text, click Font, and make the appropriate changes 
in the Font window. 

Note: If the Content Rows are positioned as TOP, then you should apply the Same Line 
options to the second of the two Content Rows you want to combine. If the Content Rows 
are positioned as Bottom then you should apply the Same Line options to the first of the 
tow Content Rows you want to combine.

Important: If you place additional items on the same line, you must use different 
alignments (Left, Center, or Right) for each of them. Failure to do so will make the two 
items overlap in the frame.

Reference: See Font Settings Window for more detailed information regarding changing 
your font settings.
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34. Click the Font Kerning drop-down menu, and select the appropriate setting. The 
greater the positive number, the farther apart the data will appear. The greater the 
negative number, the closer together the data will appear.

35.Click OK. Your text setting will appear in the Content section in the Frame window:

36. Enter additional elements, such as text, lines or an imported graphics to the frame. 
Otherwise, skip to step 25.

• To add a text item to the frame, follow steps 37 - 9.

• To add an image to the frame, follow steps 11 - 16. 

• To add a line to the frame, follow steps 18 - 24.

Add Text to a Frame

37. In the Content section, click Add to add instructional text to the frame. 

The Frame Content 
window appears:

38. Content Type Section - 
Click Text and either enter 
the text you wish to 
appear in the frame, or 
select the appropriate text 
item from the list. If you 
want to import available 
text files, select Text 
Manager from the Text 
drop-down menu. To 
create a text file, select Text Editor from the Text drop-down menu and follow the 
instructions listed in the substeps below.

a. .To provide text items 
such as detailed 
instructions, select Text 
Editor to generate a Text 
window.
The Text window appears.

b. Enter the text, as you 
want it to appear on the 
ballot, in the Text window.

c. Click OK to accept your 
changes and return to the 
Frame window.



 Chapter 18: Ballot Frames 162

EVS5200_DOC_SOP_EW03Design
 Software Version 4.6

 Published: April 25, 2014

• Or, click Cancel to reject your changes and close the text window.

4. Additional Information Section - Enter your text margins (in inches) in the Left 
Margin and Right Margin fields. 

If an Absolute option is selected in the Position drop-down menu, the Margin fields 
are absent from the Additional Information section.

5. Click the Panels drop-down menu to select one of the panels you added under the 
Additional Information section of the Frame window

6. Content Properties Section - Enter additional settings in the Content Properties 
section: 

• Click the Position list and select where you want text to display in the frame. 

Select Top to place the text at the top of the frame.

Select Bottom to place the data at the bottom of the frame. 

Select Absolute/Left Top, Absolute/Right Top, Absolute/Left Bottom, or 
Absolute/Right Bottom to enable the Left or Right, and Top or Bottom Offset 
fields. Enter your settings (in inches) in the fields. The entries made in these 
fields will determine how far from the left or right, and top or bottom of the 
frame that the text will appear.

• Select the Same Line check box to include all of your data on the same line as 
previous content item. For instance, if you wanted both the additional data 
content and additional text content (e.g. the office title and vote for phrase) 
both to appear on the same line, you would click Same Line for the additional 
text content. This flags the system that you want to merge the two items on the 
first line of the style sheet. 

The Same Line option is not available if an Absolute option is selected from the 
Position list.

• Click the Line Size list and select the height of the area used for your text. If you 
choose Font Size, the text will display with standard spacing between two lines 
of text. If you select a smaller line size, two lines of text will be closer together. If 
you select a larger size, two lines of text will display farther apart. This list is not 
available if Absolute is selected from the Position list. 

• To rotate your text, click the Rotate list and select the appropriate angle. 

Reference: See Panels for more detailed information regarding creating panels for your 
ballot.

Note: If the Content Rows are positioned as TOP, then you should apply the Same Line 
options to the second of the two Content Rows you want to combine. If the Content Rows 
are positioned as Bottom then you should apply the Same Line options to the first of the 
tow Content Rows you want to combine.

Important: If you place additional items on the same line, you must use different 
alignments (Left, Center, or Right) for each of them. Failure to do so will make the two 
items overlap in the style sheet.
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• Click the Alignment drop-down menu and select the appropriate text alignment 
option (for example, Right, Center, or Justify). 

The Alignment option is not available if an Absolute option is selected from the 
Position list.

• The text wrap option is automatically activated. If you want to turn off the text 
wrap option, select the No Text Wrap check box. 

The No Text Wrap option is not available if an Absolute option is selected from 
the Position list.

• Click the Language list and select the appropriate ballot language.

7. To change the appearance of the text, click Font... and make the appropriate 
changes in the Font window.

8. Click the Font Kerning drop-down menu and select the appropriate setting. The 
greater the positive number, the farther apart the text will appear. The greater the 
negative number, the closer together the text will appear.

9. Click OK. Your text setting will appear in the Content section in the Frame window.

10. Enter additional elements, such as lines or an imported graphics to the frame. 
Otherwise, skip to step 25.

• To add an image to the frame, follow steps 11 - 16. 

• To add a line to the frame, follow steps 18 - 24.

Add a Graphic to a Frame

11. In the Content section, click Add to add an image to the frame. 

The Frame Content 
window appears: 

12. Content Type Section - 
Click Graphic and select 
the appropriate graphic to 
include from the list. 

Reference: See Font Settings Window for more detailed information regarding changing 
your font settings.

Reference: If your 
graphic is missing, see 
Chapter 9: Graphics 
for instructions about 
importing graphics. 
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13. Additional Information Section - Enter your text margins (in inches) in the Left 
Margin and Right Margin fields.

14. Click the Panels drop-down menu to select one of the panels you added under the 
Additional Information section of the Frame window.

15. Content Properties Section - Enter additional settings in the Content Properties 
section: 

• Click the Position list and select where you want the graphic to display in the 
frame. 

Select Top to place the graphic at the top of the frame.

Select Bottom to place the graphic at the bottom of the frame.

• Select Absolute/Left Top, Absolute/Right Top, Absolute/Left Bottom, or 
Absolute/Right Bottom to enable the Left or Right, and Top or Bottom Offset 
fields. Enter your settings (in inches) in the fields. The entries made in these 
fields will determine how far from the left or right, and top or bottom of the 
frame the graphic will appear.

• Click the Line Size list and select the height you desire. The line size adjusts the 
spacing between the graphic and the next content line.

• To rotate your graphic, click the Rotate list and select the appropriate angle. 

• Click the Alignment list and select the appropriate graphic alignment option (for 
example, Right, Center, or Justify). 

• Click the Scale Factor drop-down menu and select the image scale (in percent). 

Note: If an Absolute option is selected in the Position drop-down menu, the Margin fields 
are absent from the Additional Information section.

Reference: See Panels for more detailed information regarding creating panels for your 
ballot.

Note: If an absolute position is selected, the Line Size option is unavailable.

Note: The Alignment option is not available if an Absolute option is selected.
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• Click the Language drop-down menu and select the appropriate ballot 
language.

16.Click OK. Your image setting will appear in the Content section in the Frame window.

17. Enter additional elements, such as a lines to the frame. Otherwise, skip to step 25.

• To add a line to the frame, follow steps 18 - 24.

Add Lines to a Frame

18. In the Content section, click Add to add a line to the frame. 

The Frame Content 
window appears:

19. Content Type Section - 
Click Line and select 
either Vertical Line or 
Horizontal Line from the 
drop-down menu. 

20. Additional Information 
Section - If you selected 
Vertical Line, enter the 
margins (in inches) for the 
line in the Top Margin and 
Bottom Margin fields. The entries made in these fields will determine how far the 
line will be from the top and bottom of the frame.

• If you selected Horizontal Line, enter the margins (in inches) for the lines in the 
Left Margin and Right Margin fields. Entries made in these fields will determine 
how far the line will be from the left and right sides of the frame. 

21. Click the Panels drop-down menu to select one of the panels you added in the 
Frame Window.

22. Content Properties Section - Enter additional settings in the Content Properties 
section:

23. Enter the thickness of the line (in inches) in the Line Thickness field.

Note: The Language option is disabled for graphics.

Note: If an Absolute option is selected the Margin fields are absent from the Additional 
Information section.

Reference: See Panels for more detailed information regarding creating panels for your 
ballot.
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• If you selected Vertical Line, enter the margins for the line (in inches) in the Left 
Offset field. The entry made in this field will determine how far the line will be 
from the left side of the frame. 

• If you selected Horizontal Line, enter the margins for the line (in inches) in the 
Top Offset field. The entry made in this field will determine how far the line will 
be from the top of the frame. 

• Click the Line Color drop-down menu and select the line color. 

• Click the Line Style list to set the style as solid, dotted, or dashed.

24.Click OK. Your line setting will appear in the Content section in the Frame window.

25.Click OK to save your frame. 

The ballot image will appear, showing your 
changes to the frame.

Edit Frame Content

1. Click the Frames menu and select Frames.

2. Select the appropriate frame in the Frames window and click Edit.

3. From the Frame window, locate the content in the Content frame and click Edit.

4. Enter any changes in the Frame Content window. 

5. Click OK.

6. Click OK. Your changes will appear in the style sheet on the main Paper Ballot 
screen.

Edit Frame Shortcut

Once you create your frame, you can edit a frame 
by right-clicking the frame on the main Paper 
Ballot screen and clicking Edit Frame.

Delete Frame Content

1. Click the Frames menu and select.

Reference: To create a customized color, click Custom, located at the bottom of the 
drop-down menu. For more information about creating custom colors, see Custom Color 
Settings. 
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2. Select the appropriate frame in the Frames window and click Edit.

3. From the Frame window, locate the content in the Content frame and click Delete. 
A confirmation window appears, asking if you want to delete this item.

4. Click Yes.Click OK. Your changes will appear in the style sheet on the main Paper 
Ballot screen.

Delete Frame Shortcut

Once you create your frame, you can delete frame by 
right-clicking the frame on the main Paper Ballot screen 
and clicking Delete Frame.

Import Frames 

You can import frames from other layouts created in Paper Ballot. Use the following 
steps to import a frame: 

1. From the Frames menu, click Frames. 

The Frame window appears:

2. Click Import.
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The Select Layout window appears

3. Select the layout that contains the frame 
you want to import. 

4. Click OK. 

The Import window appears:

5. Click the check box(es) next to the frame(s) to 
import. 

6. Click OK. 

The imported frame(s) will appear in the Paper 
Ballot work pane. 
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Copy Frames

You can copy a previously-created frame in the Frames window. Use this option if you 
want to use a frame’s settings for another ballot style. Use the following steps to copy a 
frame: 

1. From the Frames menu, click. 

The Frames window appears.

2. Click on the frame you want to copy. 

3. Click Copy. 

The Copy Frame window appears.

4. To rename the frame, enter the new name in the Frame 
Name field. 

5. Click the Ballot Sheet drop-down menu, and select the 
page where the frame will appear. 

6. Click the Ballot Side drop-down menu, and select Front 
or Back. 

7. Click OK. 

The copied frame(s) will appear in the Paper Ballot work 
pane. 

Moving Frames

You can move a frame to another ballot page in the Frame window. Take the following 
steps to move a frame. 

1. From the Frames menu, click Frames. 
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The Frames window appears.

2. Click the frame you wish to move. 

3. Click Move. 

The Move Frame window appears.

4. Enter a new name for the frame in the Frame Name 
field. 

5. Click the Ballot Sheet drop-down menu, and select the 
ballot page to display the frame. 

6. Click the Ballot Side drop-down menu, and select either 
Front or Back.

7. Click OK. 
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Chapter 19: Finalizing the Ballot

Use the information provided in this chapter to begin finalizing your ballots. Finalizing 
your ballots involves scanning your ballots for errors, saving the ballots, and updating 
the database. Follow the steps listed below for further information.

Scanning the Finalized Ballots For Errors

Scan your ballots for errors one final time, after you are satisfied with your ballot layout. 
If errors are present, refer to the steps in this manual that coincide with the region where 
the error(s) exist.

Saving the Ballots

Save your ballots after you scan and find no errors present. 

Finalize Ballot Layout

Use the Finalize Ballot Layout option only after scanning your ballots to verify there are 
no layout errors, and then saving the final layout. To update the database, follow the 
steps below:

1. From the File menu, click Finalize Ballot Layout. A warning prompt appears.

2. Click YES to start the finalization process. 

• Or, click NO to cancel finalizing your ballot data.

A scrolling status bar appears until the finalization is complete.

3. If the finalization is successful, a prompt stating this will appear.

4. Click OK.

Reference: See Chapter 14: Scan for Errors for more information on scanning your ballots 
for errors.

Reference: See Save for more information on saving your ballots.

Reference: If the finalization is unsuccessful, a prompt will display offering a generalized 
reason for the error. See Chapter 14: Scan for Errors to rescan the ballots. Use the steps 
listed there to clear any errors you may have missed.
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5. If at this time you choose to close the Paper Ballot module and return to the main 
ElectionWare window, you may be prompted to save your ballot. 

6. Save your ballot, and then click OK to continue to the ElectionWare main window.
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Chapter 20: Print Ballots

After you have finalized your ballots, save them in a PDF file to preserve the original 
ballot layout.

Create a PDF of Your Ballot

If your system has Adobe Acrobat 9 installed, and this is the first time you have created 
a PDF using Paper Ballot, use the steps below to configure the PDF file options.

The following applies to generating BOD, not for generating the PDF that you would 
send to a printer:

 If your system has Acrobat 9 installed with sufficient user rights, the following steps 
are automated by Paper Ballot. Once the PDF generation has completed, the 
Acrobat settings will revert to their original settings.

 If you have Acrobat 9 installed, but do not have sufficient user rights, the following 
screens for Adobe Acrobat 8 will be displayed. You will need to follow the 
instructions below to set up printing properties for BOD generation.

Note: If your version of Adobe Acrobat is other than version 9, or the system cannot 
determine the version you are using, you will be prompted to abort or continue the BOD 
generation process. Version 8 and all other versions must be set manually.

Note: Proceed with care, as the system will expect you to be knowledgeable in creating 
PDF files.

To change the settings associated with the Adobe PDF printer driver, use the following 
steps:

1. Click the Windows Start button.

2. Select Control Panel from the Start menu.

3. Right-click on Adobe PDF and select Printing Preferences.

4. Set the Adobe ODF Output Folder to the default Documents\*PDF by 
selecting it from the drop-down list.

5. Clear the View Adobe PDF Results option.

6. Clear the Ask to replace existing PDF file option

7. Click OK to continue.
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Setting Up the PDF Paper Sizes

1. On the File menu, select Print. 

2. On the Printer window, 
choose Adobe PDF 
from the Name field 
drop-down menu and 
click Properties.

3. Click Add on the Adobe PDF 
Settings tab, Adobe PDF 
Document Properties window.

4. On the Add Custom Paper Size window, in 
the Paper Name field, type a name that is 
easily recognizable for this ballot size. (e.g., 
9x11.5 for an 8.5x11 inch ballot).

Important: You must be logged in as a Windows administrator to make changes to the 
Adobe PDF paper size.
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5. Enter the width and height of the paper in the Width and Height fields respectively.

6. Click Add/Modify to accept the custom paper size settings and return to the Adobe 
PDF Document Properties window.

• Or, click Cancel to reject your changes and close the window.

7. Repeat this process for the 8.5x14 inch, 8.5x17, and 8.5x19 inch ballot sizes.

8. After entering all four paper sizes, click OK in the Adobe PDF Document 
Properties window.

9. On the Print window, click OK.

Print to Portable Document Format

Complete the following steps to create a PDF of your ballots:

1. On the File menu, click Print Setup.

2. In the Print area, choose the paper size 
from the Size drop-down menu and click 
OK.

Note: The PDF page size should be at least a half-inch larger than the ballot. For example, 
if you have an 8.5 x 17 ballot with no stubs, type 9 in the Width box and 17.5 in the Height 
box. If your ballot has stubs, you will need to adjust the Width and Height boxes to 
accommodate the stub area. 
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3. Click the File menu and select Print. The 
Print window appears:

The Adobe PDF Document Properties window appears: 

4. Set the Default Settings to 
Press Quality.

Note: If you do not have the registration 
crosshairs activated, you will be prompted 
to activate them. Select Yes to continue 
without the registration crosshairs. Or, refer 
to Ballot Setup for further information on 
activating the registration crosshairs.
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5. Click the Layout tab of the Adobe PDF Document Properties window, and select 
the portrait orientation for all ballots, including landscape and mixed orientation 
ballots (portrait front, landscape back).

6. Click OK to accept your settings and return to the Print window.

7. In the Print Options Frame of the Print window, select the Print Front Side check 
box to print only the front side of your ballots. Select the Print Back Side check box 
to print only the back side of your ballots. Select both check boxes to print the front 
and back sides of the ballot. If you select Skip Blank Sides, ballot sides with no 
contests, frames or questions will not print. 

8. Next, select one of the following:

• Select Entire Election to print all ballot styles for all ballot sets for the election.

• Select All Styles in Current Ballot Set Only to print all the ballot styles in the 
currently selected ballot set. 

• Select Current Style on Screen Only to print only the ballot style displayed on 
the screen. 

• Click Selected Styles to print a specific style sheet. If you select this option, click 
Selection. 

Important: Verify that the Auto-Rotate Pages option from the Adobe PDF Settings 
window is deactivated. For this option to be saved for future sessions, this setting must 
be changed from Windows. To access this option, you must be logged in as a Windows 
administrator. Follow these steps to adjust the Adobe settings: 

 In Windows, click the Start menu and select Control Panel.

 On the Control Panel window, click Devices and Printers.

 Right-click the Adobe PDF printer icon and click Printing Preferences.

 On the Adobe PDF Printing Preferences window, choose Press Quality 
from the Default Settings drop-down menu and click Edit.

 On the Press Quality - Adobe PDF Settings window, choose Off from the 
Auto-Rotate Pages drop-down menu.

 Click OK. 

 In the Save Adobe Settings As window, specify the name for this new 
setting and click Save.

 In the Adobe PDF Printing Preferences window, click Apply and then OK.
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The Print Selection window appears.

From the Print Selection window, click the + 
symbol next to the Ballot Set to view all ballot 
styles for that particular set. Click the check 
box next to the ballot styles you wish to print. 
To select all ballot styles under a ballot set, 
click the check box next to the ballot set. 

9. From the Print Selection window, click Cancel to 
close the Print Selection window. Or, click OK to 
return to the Paper Ballot Print window.

10. Select the number of copies to print from the 
Number of Copies list.

11. Click OK.

The Validate Ballots window appears:

12. Click Scan Now, to scan your ballots for errors now. 
Click Print Now, to bypass the ballot scan and print the 
ballots. Or, click Cancel, to close the Validate Ballots 
window.

13. The Save PDF As window appears.

14. Click Save. 

Adjust Printer Settings for Two-Sided and Multi-Sided Ballots

If you cannot see all ballot marks and cut marks on the PDF image, you may have to 
manually adjust the printer settings and create another PDF file for your ballot. 

1. Left-click on the Start menu, point to Settings and click Control Panel. The Control 
Panel window appears. 

2. Double-click Devices and Printers. The Devices and Printers window appears. 

3. Right-click the Adobe PDF printer icon and click Printing Preferences.

Note: This window only appears if the ballots have not 
already been successfully validated.
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The Adobe PDF Printing 
Preferences window appears.

4. On the Adobe PDF Settings 
tab, click Add next to the Adobe 
PDF Page Size drop-down 
menu.

The Add Custom Paper Size window 
appears. 

5. Type the new custom paper size name in the 
Paper Names field.

6. Select your preferred unit of measurement from the Unit options. 

7. Enter the width of your ballot in the Width field. 

8. Enter the height of your ballot in the Height field.

9. Click Add/Modify. 

Note: It is recommended that you include 
the paper size dimensions in the Paper 
Names. For example, type 9x17.5 in the 
Paper Names ballots for a 8.5 x 17 paper 
ballot type. 

Note: The PDF file page size should be at least a half-inch larger than the ballot. For 
example, if you have an 8.5 x 17 ballot with no stubs, type 9 in the Width box and 17.5 in 
the Height box. If your ballot has stubs, you will need to adjust the Width and Height 
boxes to accommodate the stub area. 



 Chapter 20: Print Ballots 180

EVS5200_DOC_SOP_EW03Design
 Software Version 4.6

 Published: April 25, 2014

You will return to the Adobe PDF 
Printing Preferences window. 

10. Click the Adobe PDF Page Size 
drop-down menu, and select your 
newly-created paper name. 

11. Click OK. 

12. Return to Paper Ballot.

13. From Paper Ballot, point to File 
and select Print Setup. 

14. On the Print window, click 
the Name drop-down menu 
and choose Adobe PDF. 

15. Select newly-created paper 
name from the Adobe PDF 
Page Size drop-down menu 
and click OK.

16. Create another PDF file by 
following the steps under the Create a PDF of Your Ballot heading. 

Check Portable Document Format Files for Errors

View each of your ballot PDF files in Acrobat and print copies of your ballots to ensure 
that the on-screen images match what appears on the paper ballot. Verify that all 
candidates and responses correlate to their voter target locations. Reconfigure the 
ballot options in Capture and fix any formatting issues in the Style Sheets menu of Paper 
Ballot to fix any formatting problems. Regenerate your PDF files after any corrections 
are made. 

Print Hard Copies of Ballots

When you print a hard copy of your ballot, you can choose what side of the ballot to 
print or save the ballot to your workstation. Take the following steps to print a hard copy 
of the ballot. 

1. Click the File menu and select Print. 
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The Paper Ballot Print window will appear:

2. From the Name drop-down menu, select the 
destination printer. 

3. In the Print Options frame, select Print Front 
Side to print only the front side of your 
ballots. Select Print Back Side to print only 
the back side of your ballots. Select both 
check boxes to print the front and back sides 
of the ballot. If you select Skip Blank Sides, 
ballot sides with no contests, frames or 
questions will not print. 

4. Select one of the following options:

• Select Entire Election to print all ballot 
styles for all ballot sets for the election. 

• Select All Styles in Current Ballot Set 
Only to print all the ballot styles in the currently selected ballot set.

• Select Current Style on Screen Only to print only the ballot set displayed on the 
screen.

• Click Selected Styles to print a specific style sheet. If you select this option, click 
Selection. 

The Print Selection window appears.

From the Print Selection window, click the ‘+’ 
symbol next to the Ballot Set to view all ballot 
styles for that particular set. Click the check 
box next to the ballot styles you wish to print. 
To select all ballot styles under a ballot set, 
click the check box next to the ballot set. 

From the Print Selection window, click OK to 
return to the Paper Ballot Print window. 

5. Enter the number of copies to print in the 
Number of Copies field. 

6. Select the Print to File check box to save the 
ballot to your workstation in a (.prn) format. If this 
check box is selected, a hard copy version of the ballot will not be printed. 

7. Click OK. 
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The Validate Ballots window appears:

8. Click Scan Now, to scan your ballots for errors now. 
Click Print Now, to bypass the ballot scan and print 
the ballots. Or, click Cancel, to close the Validate 
Ballots window.

9. Your ballots will print to the device you selected.

Generate BOD Data

Once you have proofed your ballots for errors, you can use the Generate BOD Data 
option to create BOD data to be used with the Print module in ElectionWare.

Paper Ballot generates a PDF image of each of your selected ballot styles. When used, 
Paper Ballot respects the PDF options related to printing only one side of the ballot, or 
skipping blank sides all together. 

During the generation process, Adobe Acrobat will repeatedly display its own progress 
dialog for each ballot style. When used on a very fast PC, these dialogs will appear to 
flicker as Adobe Acrobat displays and dismisses each progress dialog. As ballot style 
images are generated, Paper Ballot will begin to update the database with the PDF 
images being generated during this process. A progress bar will help to display the 
progress of the PDF generation.

Use the following steps to generate BOD data:

1. From the File menu, select Generate BOD Data. 

Note: This window only appears of the ballots have 
not already been successfully validated.

Note: If you change the print device using the Print window previous to printing, you will 
be prompted with a warning. The warning indicates that if you change the print device at 
print time, may cause the ballot to print differently than how it currently appears on the 
screen. Click No to cancel the print job and return to the Paper Ballot window. Or, click 
Yes to proceed with the print job.

Note: If you have not modified your PDF settings, the prompt will appear. Follow the 
instructions listed in the prompt, and click OK to return to Paper Ballot.
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The Print window will appear:

2. Verify the print settings and click OK. 

The Validate Ballots window appears:

3. Select Scan Now to scan the ballots and update the 
BOD database.

4. Click Cancel to cancel the print option and return to 
the Paper Ballot window.

5. After scanning your ballots, you can go to the Print 
module to print BOD ballots for individual polling 
places

.

Reference: See ElectionWare Volume IV: Deliver Operator Guide, Chapter 21: Print BOD 
Ballots for more information on printing BOD ballots.



Part 2: Accessible Ballot 185

EVS5200_DOC_SOP_EW03Design
 Software Version 4.6

 Published: April 25, 2014

Part 2: Accessible Ballot

The Accessible Ballot module of the Design group enables you to edit terminal display 
elements and export and import ballot audio for Accessible Equipment. The edited 
ballot display and layout may also be previewed for the AutoMARK and ExpressVote 
equipment types. Accessible Ballot contains information about the following topics:

 Chapter 21: Introduction to Accessible Ballot

 Chapter 22: Accessible Ballot Navigator

 Chapter 23: Formatting Display Elements

 Chapter 24: Export Ballot Audio Scripts

 Chapter 25: Audio File Production

 Chapter 26: Import Ballot Audio Recordings

 Chapter 27: Preview AutoMARK Ballot

 Chapter 28: Preview ExpressVote Ballot

 Chapter 29: Validate Data

 Chapter 30: Accessible Ballot Reports
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Chapter 21: Introduction to Accessible Ballot

Use the commands in Accessible Ballot to import or edit visual and audio elements of 
your election. Here you can perform actions such as formatting display elements, 
exporting and importing ballot audio, and validating data. 

Do one of the following:

 From the Modules menu, point to Design, and select 
Accessible Ballot.

 From the Modules pane, click the Accessible Ballot symbol.

Accessible Ballot is now active in Electionware.
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Accessible Ballot Toolbar 
Icons

In addition to the default 
ElectionWare symbols, Accessible 
Ballot has a unique set of symbols 
in the toolbar as well. Use these 
symbols as shortcuts to 
ElectionWare menu options.

Reference: For information 
regarding the default 
software symbols, see 
Electionware Volume I: 
Administrator’s Guide, 
Chapter 9: Default 
Electionware Icons.

Accessible Ballot Toolbar Icons

Icon Action Name Description

Preview 
AutoMARK Ballot

Preview ballots as they 
will appear on the 
AutoMARK.

Preview 
ExpressVote Ballot

Preview ballots as they 
will appear on the 
ExpressVote.

Format Ballot 
Style Names

Specify how ballot style 
names will appear on the 
accessible equipment.

Format Headings
Specify how contest 
headings will appear on 
the accessible 
equipment.

Format Contests
Specify how contests will 
appear on the accessible 
equipment.

Format Contest 
Summary 

Specify how contest 
summaries will appear 
on the accessible 
equipment.

Format 
Candidates

Specify how candidates 
will appear on the 
accessible equipment.

Validate Data
Validate data, 
translations and audio.

Export Ballot 
Audio Scripts

Export ballot audio 
scripts.

Import Ballot 
Audio Recordings

Import ballot Audio 
Recordings.
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Accessible Ballot Status

The Accessible Ballot Status screen is split into two sections. The first section, Election 
Properties, includes information regarding the Election name, template applied, 
jurisdiction information, election date, description and type.

The second section, Accessible Ballot Status, contains the current status of the 
Accessible Ballot portion of your election. This information includes time and date 
stamping for the following: Formatting Last Changed, Export Audio Script, Validate 
Data, and Import Recordings. The time and date stamp is updated to reflect the most 
recent time and date that each of these options were accessed.

The status page opens whenever the Accessible Ballot module is accessed. 
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Chapter 22: Accessible Ballot Navigator

Upon selecting the Accessible Ballot module, note the four navigation buttons at the 
bottom of the Navigator pane: Headings, Contests, Candidates, and Ballot Style 
Names. The Navigation buttons each open a specific view of election elements in the 
Navigator pane, and work in conjunction with Manage menu selections. For information 
regarding these Navigator views, please review the following information:

Headings

Use the Headings Navigator button to open the contest 
headings view in the Navigator pane. The languages view 
enables you to format contest headings elements of the 
on-screen ballot.

By utilizing the Navigator toolbar 
symbols in conjunction with 
right-clicking elements in the 
navigator tree, you will be able to 
perform many of the functions 
normally performed through the 
ElectionWare menu tree.

Note: The navigator pane view corresponds to the highlighted button in the Navigator 
pane.

Reference: More information about formatting contest 
heading elements can be found in  Format Headings.

Headings Navigator Icons

Icon Action Name Description

Format Headings

Specify how 
contest headings 
will appear on the 
accessible 
equipment.
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Contests

Use the Contests Navigator button to open the contests 
view in the Navigator pane. The contests view enables you 
to format contest elements and edit contest summary 
screens. 

By utilizing the Navigator toolbar 
symbols in conjunction with 
right-clicking elements in the 
navigator tree, you will be able to 
perform many of the functions 
normally performed through the 
ElectionWare menu tree.

Reference: More information about formatting contest 
elements, and editing contest summaries can be found in  
Format Contests.

Contests Navigator Icons

Icon Action Name Description

Format Contests

Specify how 
contests will 
appear on the 
accessible 
equipment.

Format Contest 
Summary

Specify how 
contest 
summaries 
appear on the 
accessible 
equipment.
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Candidates

Use the Candidates Navigator button to open the 
candidates view in the Navigator pane. The candidate view 
enables you to format candidate elements of the on-screen 
ballot. 

By utilizing the Navigator toolbar 
symbols in conjunction with 
right-clicking elements in the 
navigator tree, you will be able to 
perform many of the functions 
normally performed through the 
ElectionWare menu tree.

Reference: More information about formatting candidate 
elements can be found in  Format Candidates.

Candidates Navigator Icons

Icon Action Name Description

Format Candidates

Specify how 
candidates will 
appear on the 
accessible 
equipment.
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Ballot Style Names

Use the Ballot Styles Names navigator button to open the 
ballot names view in the Navigator pane. The ballot style 
names view enables you to format ballot name elements of 
the on-screen ballot.

By utilizing the Navigator toolbar 
symbols in conjunction with 
right-clicking elements in the 
navigator tree, you will be able to 
perform many of the functions 
normally performed through the 
ElectionWare menu tree.

Reference: More information about formatting ballot 
name elements can be found in  Format Ballot Style 
Names.

Ballot Style Names Navigator Icons

Icon Action Name Description

Format Ballot 
Style Names

Specify how 
ballot style names 
will appear on the 
accessible 
equipment.
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Chapter 23: Formatting Display Elements

Use the options under the Manage menu to format various visual aspects of the 
on-screen ballot used with the ES&S AutoMARK and ExpressVote. These elements 
include the following: Contest Headings, Contests, Contest Summaries, Candidates, 
and Ballot Style Names. To format visual ballot elements, follow the steps listed below:

From the Manage menu, choose from the listed elements to 
format.

You must select from the navigator buttons at the bottom of 
the Navigator pane, for that option to become active in the 
Manage menu.

Formatting ballot elements such as contests or candidates, 
allows you to change how these elements will appear on the 
accessible ballot. To learn more about these formatting options, see the following 
sections.

When formatting any of the ballot elements you must select text within the display 
editor for the controls to be enabled.

Format Headings

Use Format Headings to format contest headings as they appear on the ES&S 
AutoMARK and ExpressVote displays. To format contest headings, follow the steps 
below:

Note: Display formatting is applied to all languages universally; changes cannot be applied 
separately to the language content in this editor.

Note: The Headings button must be selected to format headings.
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1. From the Manage menu, click Format Headings. 

• Or, from the Navigator pane, right-click on a contest 
heading and left-click Format Headings.

A screen similar to the one below appears:

From the Format Labels screen you 
can select the font color from the 
Font Color drop down menu. You 
can also use any of the tool buttons 
on the screen to bold, or justify the 
contest font.

Once you have made all of the 
formatting changes to your contest 
headings, select Save if you want to 
save these parameters. Select 
Refresh to clear all of the unsaved 
contest heading information. Or, 
click Close to exit the screen. 

If you close the Format Labels screen 
prior to saving, a prompt will appear 
asking you if you want to save. Click 
Yes to save and exit the screen. Click 
No to close the prompt and the Format Labels screen without saving. Or, click Cancel to 
return to the Format Labels screen.

Format Contests

Use the Format Contests option to format the contests as they appear on the ES&S 
AutoMARK and ExpressVote on-screen ballots. To format contests, follow the steps 
below:

Time Saver: You can also select several or all of the contest 
headings in the Navigator pane. If one contest heading is 
selected, the exact contest heading is displayed in the editor. 
If more than one ballot heading is selected a generic contest 
heading is shown.

Note: The Contests button must be selected to format contests.
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1. From the Manage menu, click Format Contests. 

• Or, from the Navigator pane, right-click on a contest 
and left-click Format Contests.

A screen similar to the one below appears:

From the Format Labels screen you can 
select the font color from the Font Color 
drop down menu. You can also use any of 
the tool buttons on the screen to bold, or 
justify the contest font. 

Once you have made all of the formatting 
changes to your contests, select Save if 
you want to save these parameters. Select 
Refresh to clear all of the unsaved contest 
information. Or, click Close to exit the 
screen. 

If you close the Format Labels screen 
prior to saving, a prompt will appear 
asking you if you want to save. Click Yes to save and exit the screen. Click No to close 
the prompt and the Format Labels screen without saving. Or, click Cancel to return to 
the Format Labels screen.

Format Contest Summary

The Contest Summary formatting option is related to the Contests portion of the 
Navigator Pane. Use Format Contest Summary to format the contest summary as it 
appears on the ES&S AutoMARK and ExpressVote displays. To format contest 
summaries, follow the steps below:

Time Saver: You can also select several or all of the contests 
in the Navigator pane. If one contest is selected, the exact 
contest title is displayed in the editor. If more than one 
contest is selected a generic contest title is shown.

Note: The Contests button must be selected to format contest summaries.



 Chapter 23: Formatting Display Elements 196

EVS5200_DOC_SOP_EW03Design
 Software Version 4.6

 Published: April 25, 2014

1. From the Manage menu, click Format Contest Summary.

• Or, from the Navigator pane, right-click on a contest 
and left-click Format Contest Summary.

A screen similar to the one below appears:

From the Summary View 
screen you can edit the contest 
summary. To use the default 
ballot verbiage, click Use 
Ballot View.

Once you have finished editing 
your contest summary, select 
Save if you want to save these 
parameters. Click Refresh to 
clear all of the unsaved contest 
summary information. Or, click 
Close to exit the screen. 

If you close the Summary View screen prior to saving, a prompt will appear asking you if 
you want to save. Click Yes to save and exit the screen. Click No to close the prompt 
and the Summary View screen without saving. Or, click Cancel to return to the Summary 
View screen.

Format Candidates

Use Format Candidates to format the candidates as they appear on the ES&S 
AutoMARK and ExpressVote displays. To format candidates, follow the steps below:

Note: Summary 
content changes must 
be applied to each 
election language.

Note: The Candidates button must be selected to format contests.
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1. From the Manage menu, click Format Candidates. 

• Or, from the Navigator pane, right-click on a candidate and 
left-click Format Candidates.

A screen similar to the one below appears:

From the Format Labels screen you can 
select the font color from the Font Color 
drop down menu. You can also use any 
of the tool buttons on the screen to 
bold, or justify the contest font. 

Once you have made all of the 
formatting changes to your candidates, 
select Save if you want to save these 
parameters. Select Refresh to clear all of 
the unsaved contest information. Or, 
click Close to exit the screen.

If you close the Format Labels screen 
prior to saving, a prompt will appear 
asking you if you want to save. Click Yes to save and exit the screen. Click No to close 
the prompt and the Format Labels screen without saving. Or, click Cancel to return to 
the Format Labels screen.

Format Ballot Style Names

Use Format Ballot Style Names to format the ballot style names as they appear on the 
ES&S AutoMARK and ExpressVote displays. To format ballot style names, follow the 
steps below:

Time Saver: You can also select several or all of the candidates in 
the Navigator pane. If one candidate is selected, the exact 
candidate name is displayed in the editor. If more than one 
candidate is selected a generic candidate name is shown.

Note: The Ballot Style Names button must be selected to format ballot names.
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1. From the Manage menu, click Format Ballot Style Names. 

• Or, from the Navigator pane, right-click on a ballot name 
and left-click Format Ballot Style Names.

A screen similar to the one below appears:

From the Format Labels screen you can select 
the font color from the Font Color drop down 
menu. You can also use any of the tool buttons 
on the screen to bold, or justify the contest 
font. 

Once you have made all of the formatting 
changes to your ballot style names, select Save 
if you want to save these parameters. Select 
Refresh to clear all of the unsaved ballot name 
information. Or, click Close to exit the screen.

If you close the Format Labels screen prior to saving, a prompt will appear asking you if 
you want to save. Click Yes to save and exit the screen. Click No to close the prompt 
and the Format Labels screen without saving. Or, click Cancel to return to the Format 
Labels screen.

Time Saver: You can also select several or all of the ballot style 
names in the Navigator pane. If one ballot style name is selected, 
the exact ballot style name is displayed in the editor. If more than 
one ballot style name is selected a generic ballot style name is 
shown.

Note: Ballot Style Names will always be 
Center justified on the AutoMARK 
terminal. Left and Right justification is 
currently not supported for display.
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Chapter 24: Export Ballot Audio Scripts

Use the Export Ballot Audio Scripts command to export the ballot audio script for your 
current election. The ballot audio script is exported to a Microsoft Excel (.xls) format. 
Each of the columns within the script indicate separate categories of information. 
General information about the categories are as follows:

 Column A: This column contains the Label ID for the election audio file. The Label ID 
is created by ElectionWare and should not be altered.

 Column B: This column contains the Label-Language ID for the election audio file. 
The Label-Language ID is created by ElectionWare and should not be altered.

 Column C: This column contains the Alternate ID for the election audio file. The 
Alternate ID column is populated from the information in the Candidate Additional 
Text 6 field in Capture and should not be altered.

 Column D: This column contains the Default File Name for the election audio files. 
The default file name is created by ElectionWare and should not be altered.

 Column E: This column contains the Alternate File Name for the election audio files. 
File names can contain any alphanumerical characters, but should contain the 
underscore character rather than spaces. Filenames should also contain the file 
extension of the associated file. For example ‘Candidate_00056.WAV’ would be in 
the proper naming format. 

 Column F: This column contains the verbiage that will need to be recorded. 
Depending on the language, this information will match the translations you 
incorporated into the election. This verbiage must be recorded as it appears in the 
script, in order for the audio to match the visual ballot information. 

 Column G: This column contains the phonetic text utilized with the text to speech 
utility. Edit information in this column to change how the text to speech utility 
pronounces information on the ballot.

 Column H: This column indicates whether an audio prompt is repeated within the 
script or not. Repeated prompts are applied multiple times within the same election 
and these files are reused for particular elements.

Note: Column E is intentionally left blank for editing purposes. You must edit this column 
to incorporate any alternate audio file names for the current election. If you do not use an 
alternate file name, you must uncheck the Use Alternate ID check box at import. If you do 
use an alternate file name, the audio import process will not succeed if Column E is left 
blank. See Chapter 26: Import Ballot Audio Recordings for more information.
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Following is an example of the Exported Election Audio sheet:

To export the election audio script, follow the steps listed below:

1. From the Tools menu, click Export Ballot Audio Scripts. 
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The Export Ballot Audio Scripts screen appears

2. The Choose Language(s) 
region enables you to select 
the languages you wish to 
export. Select the languages 
you wish to export by checking 
the appropriate selection next 
to that language.

3. The radio button just beneath 
the Choose Language(s) frame 
indicates whether to export all 
election audio information, or 
just those pieces of election 
audio information that are 
missing or changed. 

• Select All election audio to export all available election audio information. 

• Select Missing or changed election audio to export only the election audio 
information that is missing, or changed.

4. Click Browse to select the folder location for the election audio script. 

A file browser dialog box appears:

5. Once the appropriate folder is specified, click Select to use that directory for export.

6. Click Export to begin the election audio script export. 

If the export process is successful, a prompt will appear detailing this. Click OK to return 
to the main ElectionWare dialog box.

A Microsoft Excel spreadsheet will reside in the location 
you specified for the election audio script. This sheet will 
contain individual tabs representative of all the 
languages you selected for export. 

Note: By default, all 
languages are selected for 
export. To deselect a 
particular language, click 
the appropriate selection 
next to that language.

Important: Do not change the name of the script file. Changing the script name will lead to 
errors during the audio import process.
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Use the sheets within this file to record election audio files. You can send the 
spreadsheet to a professional studio, or record the election audio files yourself. When 
completed, you will use the same election audio spreadsheet to import the new election 
audio files. 

Reference: For more information about importing the system audio, see Chapter 26: 
Import Ballot Audio Recordings.
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Chapter 25: Audio File Production

The audio production process involves the recording of all of the audio files for the 
current election. This process can be completed in either a professional studio 
environment or in the average office environment. It is recommended, that if the office 
environment is your chosen method for audio production, the following information be 
used as a guide for the production process.

Audio File Formatting

The formatting of the audio files should be the following: 

 WAV (.wav) format

 22.5 kilohertz (kHz)

 8 bit

 Mono

For further information regarding the audio format, please see the Audio Recording 
Process information found later in this chapter.

Recommended Audio Production Tools

The following tools are recommended for successful completion of the audio process:

 Dedicated Audio Production Computer

 Digital Universal Serial Bus (USB) microphone

 Audio Editing Software

The use of a dedicated computer is recommended to help avoid file degradation over 
time. Files are susceptible to digital distortion or occasional deletion due to repetitive 
disk access during normal operation. By using a dedicated computer, this detrimental 
scenario can be avoided.

The quality of personal microphones has increased substantially. For this reason, the 
average digital USB microphone should be sufficient for successful recording purposes. 
It is strongly recommended that the preferred USB microphone have noise canceling 
capabilities. When combined with a reasonably quiet environment, this feature helps to 
eliminate ambient noise found within the average office environment.

Note: The 22.5 kilohertz (kHz) setting is recommended for your election audio files, but can 
be adjusted. This setting has been chosen as a standard because it provides a good 
balance between quality and file size. It can be reduced to as low as 8 kilohertz (kHz) 
however, in situations where an election is too large for the selected media type.
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There are multiple versions of audio editing software available for purchase. As many of 
these audio tools are similar in function, ES&S does not recommend a particular brand 
of audio editing tool. It is necessary however, that your preference in software be able 
to meet the process requirements found in the  Audio Recording Process, as well as 
meet the audio format specifications listed in  Audio File Formatting.

Audio Recording Process

To eliminate distortion issues, audio files should be recorded in a reasonably quiet 
environment, and at a higher format setting than required by either the ES&S 
AutoMARK or ExpressVote. For example the optimal recording format would be a 44.1 
kilohertz (kHz), 16 bit, mono setting. After you record the files in this format, you will 
then reduce them to the appropriate levels listed in the Audio File Formatting section.

It is recommended that the files be recorded in one long stream, rather than in separate 
files. This helps to ensure vocal and volume consistency. The full stream of audio is then 
broken down into the individual file sets found in the exported audio script file, (e.g. 
races, candidates, questions, etc...).

Once the audio is broken down into individual files and named accordingly, the files 
should then be processed through the audio editing software. During this process four 
steps need to be completed

1. All audio files should be reduced to their 22.5 kilohertz (kHz), 8 bit, mono format.

2. All audio files should be processed through a noise reduction process to ensure that 
ambient noise is as minimal as possible.

3. All audio files should be normalized to a 2 decibel volume level. ES&S recommends 
this setting, as it is the preferred volume level to be used with accessible equipment.

4. All audio files should have one quarter second of silence inserted into the beginning 
and end of every file. 

Warning: Step 2 must be performed before step 3. If not processed in this order, any 
ambient noise or audio distortion will be amplified and difficult to eliminate.

Note: The two decibel volume level may sound louder than desired when played on the 
audio production computer. It is still recommended that the 2 decibel level be used as a 
standard. The volume controls incorporated into the ES&S AutoMARK, or ExpressVote will 
allow the voter to decide on a comfortable level of their choosing.

Reference: See the ES&S AutoMARK System Operator Guide and ES&S ExpressVote SOP 
for further information about changing the volume settings.



 Chapter 25: Audio File Production 205

EVS5200_DOC_SOP_EW03Design
 Software Version 4.6

 Published: April 25, 2014

Once all four steps have been completed, the audio files are ready to be imported into 
the current election.

Note: A full set of audio files will need to be produced for every language incorporated in 
the election.
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Chapter 26: Import Ballot Audio Recordings

The Import Audio Recordings feature enables you to import recorded ballot audio files. 
If you exported the election audio script as described inChapter 24: Export Ballot Audio 
Scripts, the same exported ballot audio script, along with your recorded audio files, will 
be used in the ballot audio import process. You must place the recorded WAV files into 
the same folder as the exported audio script, before beginning the import process.

Depending on the election, this information may include Parties, Races, Referendum, 
Candidates, or any other information pertinent to the current election. To ensure that no 
errors are incurred during the import process, verify that all elements included in the 
spreadsheet have a matching audio file.

To import audio files for the current election, follow the steps below.

1. From the Tools menu, click Import Ballot Audio Recordings. 

The Import Ballot Audio Recordings screen appears:

2. The Language(s) Imported 
region enables you to select the 
languages you wish to import. 
Select the languages you wish to 
import by checking the 
appropriate check box next to 
that language

Note: Only one ElectionWare user can access the election when importing audio files.

Note: The Use Alternate File 
Name check box must be 
selected if the audio files have 
been named differently from 
the default file name.
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3. Click Browse to locate the ballot audio script. Then click the Select button to select 
the prompt audio script you want to import. 

4. Click Import to begin the ballot audio recordings import. A progress appears until 
the import process is complete.

If ballot audio files have been imported previously, ElectionWare will prompt you to 
verify that you wish to import audio files again. Click Yes to overwrite one file, or 
click Yes All to overwrite all of the audio files. Otherwise, click No to skip a file, or 
Cancel to abort the import process.

Upon successful import of the system audio files, a dialog box detailing its success will 
appear.

5. Click OK to return to the main ElectionWare dialog box.

6. Click Close to close the Import Audio Recordings screen.

If the import process is unsuccessful, be sure to check the Validate Data screen in 
Accessible Ballot for details regarding why the import process failed.

Note: Once the ballot script is specified, all languages are selected for import by default. 
To deselect a particular language, click the appropriate checkbox next to that language.

Note: Verify that the Number of Records matches the Records Imported. If these numbers 
do not coincide, check to see what translations were not successfully imported by running 
the Missing Ballot Audio Files report from the Reports menu.

Reference: See Chapter 29: Validate Data for further information on the Validate Data 
feature.
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Chapter 27: Preview AutoMARK Ballot

The Preview AutoMARK Ballot feature is directly tied to the Ballot Style Names 
portion of the Navigator pane. Use Preview Ballot to preview an emulation of the ballot 
as it will appear on the ES&S AutoMARK. To open the external Preview Ballot dialog 
box, follow the steps below:

1. From the Manage menu, click Preview AutoMARK Ballot. 

• Or, right-click on a ballot style in the Navigator pane, and 
click Preview AutoMARK Ballot.

A preview of the on-screen ballot appears in an external viewer.

Navigating in Preview Mode

Preview Mode will give you a good idea of how your election will appear on the 
AutoMARK voter assist terminal. The size of your monitor will affect how the preview 
appears. Viewing the election in Preview Mode enables you to identify any problems 
before loading the election onto the AutoMARK. Once you identify any problems, 
elements can be edited using modules within ElectionWare. Take the following steps to 
navigate the preview.

Note: The VAT Preview must be installed on the system and the Ballot Style Names button 
must be selected to preview ballots.

Note: You must complete all of the election creation steps, including those in the Paper 
Ballot and Configure Equipment modules before previewing the ballot. If steps have not 
been completed, Electionware will prompt you to complete those steps before continuing.

Also, If you have completed processing your election, and have made changes which 
affect your audio files, you may preview the ballot without audio playback.
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1. If additional languages have been 
programmed in the election, the 
Language Selection screen appears first:

2. Select a language by clicking on one of 
the available selections. ElectionWare 
automatically advances to the next 
screen.

3. The Election Title, Ballot Style Name, 
and voting instructions appear on the 
Ballot Instructions screen.

4. Click the NEXT arrow to advance.

Note: Some fonts may not appear 
correctly on the Preview screens. If an 
Asian Language is not displayed 
correctly, you may need to install Asian 
fonts on your PC.

Note: Unless you are using a very large 
monitor with a height of 1024 pixels, the 
preview will show a shorter screen than 
on the actual VAT. In most cases, the 
information will scroll as needed. 
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5. The first race appears. Select a candidate 
on the voting screen. 

6. Click NEXT to advance.

7. To go back to review a previous race, 
click BACK.

8. To enter a write-in candidate, click the 
oval next to “Write-in”, and a graphical 
key-pad will appear. Touch the 
appropriate keys in order to spell the 
name of the candidate.

9. After all races have been previewed, the 
Summary screen appears.

10. To return to the ElectionWare program, 
click Exit Return Ballot.

Note: The number of characters 
allowed is 28 when previewing 
the ballot in Electionware. 
However, on the actual 
AutoMARK, the number of 
characters might be limited to the 
space available on the ballot. If 
concerned about the length of 
any names, test the name on the 
actual AutoMARK.
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11. Click Exit to return to ElectionWare.
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Chapter 28: Preview ExpressVote Ballot

The Preview ExpressVote Ballot feature is directly tied to the Ballot Style Names 
portion of the Navigator pane. Use Preview Ballot to preview an emulation of the ballot 
as it will appear on the ES&S ExpressVote. To open the external Preview Ballot dialog 
box, follow the steps below:

1. From the Manage menu, click Preview ExpressVote Ballot. 

• Or, right-click on a ballot style in the Navigator pane, and 
click Preview ExpressVote Ballot.

A preview of the on-screen ballot appears in an external viewer.

Navigating in Preview Mode

Preview Mode will give you a good idea of how your election will appear on the 
ExpressVote voter assist terminal. The size of your monitor will affect how the preview 
appears. Viewing the election in Preview Mode enables you to identify any problems 
before loading the election onto the ExpressVote. Once you identify any problems, 
elements can be edited using modules within ElectionWare. Take the following steps to 
navigate the preview.

1. If additional languages have been programmed in the election, the Language 
Selection screen appears first:

Note: The ExpressVote Previewer must be installed on the system and the Ballot Style 
Names button must be selected to preview ballots.

Note: You must complete all of the election creation steps, including those in the Paper 
Ballot and Configure Equipment modules before previewing the ballot. If steps have not 
been completed, Electionware will prompt you to complete those steps before continuing.

Also, If you have completed processing your election, and have made changes which 
affect your audio files, you may preview the ballot without audio playback.

Note: Some fonts may not appear correctly on the Preview screens. If an Asian Language is 
not displayed correctly, you may need to install Asian fonts on your PC.



 Chapter 28: Preview ExpressVote Ballot 213

EVS5200_DOC_SOP_EW03Design
 Software Version 4.6

 Published: April 25, 2014

2. Select a language by clicking on one of the available selections. Electionware 
automatically advances to the next screen.

3. The Election Title, and Election Date 
appear on the opening screen. Click OK 
to continue.

Note: Unless you are using a very large monitor with a height of 1024 pixels, the preview 
will show a shorter screen than on the actual VAT. In most cases, the information will scroll 
as needed. 
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4. The first race appears. Select a candidate 
on the voting screen. 

5. Click Next to advance.

6. To go back to review a previous race, 
click Previous.

7. To enter a write-in candidate, click the 
“write-in” option, and a graphical 
key-pad will appear. Touch the 
appropriate keys in order to spell the 
name of the candidate.

8. After all races have been voted, the 
Summary screen appears.

9. To return to the ElectionWare program, 
click Exit.

Note: The number of characters allowed 
is 28 when previewing the ballot in 
Electionware. However, on the actual 
ExpressVote, the number of characters 
might be limited to the space available 
on the ballot. If concerned about the 
length of any names, test the name on 
the actual ExpressVote.

Note: In the adjacent image, the yellow 
exclamation points indicate that an 
undervote situation has occurred. When 
a proper selection has been made, a 
green check mark appears in place of 
the exclamation point.
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10. Click Next to return to ElectionWare.
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Chapter 29: Validate Data

Use Validate Data to verify the status of both the election and system translations and 
audio for accessible equipment types. To start the Data Validation Errors process, follow 
the steps below:

1. From the Tools menu, click Validate Data. 

The Validation Errors screen appears:

2. If the Data Validation 
Errors screen holds 
errors, select the 
element with errors 
and click View 
Details. This opens a 
detailed report about 
any missing 
translation, system 
audio or, election 
audio information. 

3. Click Close to close 
the Data Validation 
Errors screen.

Reference: If Validate Data reports errors, see the following chapters for important 
information regarding audio and translation imports:

ElectionWare Volume II: Define Operator Guide:

• Chapter 23: Export AutoMARK System Translations Script

• Chapter 24: Import AutoMARK System Translations

• Chapter 25: Export AutoMARK System Audio Script

• Chapter 26: Import AutoMARK System Audio Recordings

• Chapter 27: Export ExpressVote System Translations Script

• Chapter 28: Import ExpressVote System Translations

• Chapter 29: Export ExpressVote System Audio Script

• Chapter 30: Import ExpressVote System Audio Recordings

ElectionWare Volume III: Design Operator Guide

• Chapter 24: Export Ballot Audio Scripts

• Chapter 26: Import Ballot Audio Recordings
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Chapter 30: Accessible Ballot Reports

Use the Reports menu in Accessible Ballot, to open the report options for that module. 

Missing Ballot Data Report

Use the Missing Ballot Data option to access the report that relates to missing ballot 
data. The Missing Ballot Data report includes specific information about missing ballot 
data. This information includes the Language, Label Type, Text Label, and Related 
Content. The time and date stamp is updated to reflect when the most recent report is 
run.

To run this report, from the Reports menu, click Missing Ballot Data.

The Missing Ballot Data report appears:

Use the Report Screen Toolbar to Print, Save, change the current page, or change the 
view of the displayed report.

Note: Missing data must be entered or corrected in Capture and 
Paper Ballot.

Reference: See Report Screen Toolbar for further information regarding Report Screen 
Toolbar functions.
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Missing Ballot Audio Files

Use the Missing Ballot Audio Files option to access the report that relates to missing 
ballot audio files. The Missing Ballot Audio Files report includes specific information 
about missing recordings. This information includes the missing Label Type, the English 
Text translation, the Language that requires audio file support, the expected audio file 
name, and any Alternate ID. The time and date stamp is updated to reflect when the 
most recent report is run.

To run this report, from the Reports menu, click Missing Ballot 
Audio Files. 

The Missing Ballot Audio Files report appears.

Use the Report Screen Toolbar to Print, Save, change the current page, or change the 
view of the displayed report.

Reference: See Report Screen Toolbar for further information regarding Report Screen 
Toolbar functions.
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Part 3: Appendix

 Chapter 32: Paper Ballot Style Sheet Option Tables

 Chapter 33: General Information

 Chapter 34: Paper Ballot System Messages

 Chapter 35: Revision History
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Chapter 31: Extended Write-in Ballot Layout Guidelines

ElectionWare Paper Ballot design guidelines for the Extended Write-In apply to the 
following ballot layout types: 

 Column with Portrait Orientation

 Grid with Portrait Orientation

 Grid with Landscape Orientation

The ElectionWare Write-In module allows DS scanners to identify ballots with write-in 
votes without the associated ovals filled in, as well as filter and display the same by type 
ballot in ElectionWare. By following the guidelines described in this section, you can 
achieve greater write-in recognition accuracy by the DS scanners. 

Specifying the Extended Write-In Area

The DS200 and DS850 scanners look for written candidate names in the designated 
reserve write-in area, which must meet the following requirements for each candidate 
name:

 Minimum area of 10mm x 24mm.

 No maximum size.

The reserve write-in area coordinates are included in the DS scanners’ election definition 
packages. Ballot artwork that extends into the reserve write-in area causes inaccuracies 
with the scanner write-in detection logic. Voter-entered information that extends 
outside the reserve write-in area on the voted ballot is not captured.

Column Portrait Ballot Row Density Overview

Ballot row density refers to the number or rows that you can specify on the ballot in the 
portrait orientation. You can select from three row density options depending on the 
number of rows that you want on a ballot. See the following chart for the number of 
rows for each option and the corresponding distance (mm) between rows.

Note: The Paper Ballot Finalize process issues an alert if the size of the reserve write-in area 
is too small. 
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For example, you can have one of the following row options for a 8.5” x 14” page size:

In the following figure, each black box along the sides of the ballot equates to a ballot 
row. Notice how the distances between rows are different for the three densities.

Column Portrait Ballot Row Density

Less distance between rows means more rows are needed to meet the minimum area 
required for the reserve write-in area. Likewise, the more distance between rows means 
fewer rows are needed. 

Row Density Options

Number of Columns Number of Rows Distance in MM between Rows

24 41 8

24 50 6.5

24 65 5

Note: The number of rows required to satisfy the minimum area needed for the reserve 
write-in recognition area may change depending on the row density of the ballot

Note: Rows and columns are reversed for the Grid Landscape ballot.
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Column Portrait Ballot Column Density Overview

Column Portrait ballots have 24 fixed columns that are 8mm apart (the distance 
between black boxes at the top and bottom of the ballot) no matter which row density 
you choose for the ballot to meet the minimum requirement for the reserve write-in 
area.

The following figure shows an example of a 24-column portrait ballot with rows that are 
8mm apart.

Column Portrait Fixed Column Width

Designing Column Portrait Ballots

Use the Column Portrait ballot layout guidelines in this section if you want to use the 
Extended Write-in feature.

Column Portrait Ballot

The extended write-in area of the ballot has three components:

• Write-in Phrase

• Reserve Write-in Recognition Area

• Write-in Horizontal Line

Note: For the Grid Landscape ballot, the distances between rows are fixed at 8mm and the 
columns can be 5mm, 6.5mm or 8mm apart.

The number of rows required to satisfy the minimum area needed for the reserve write-in 
recognition area may change depending on the row density of the ballot.
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The following image on the left is a printed ballot. The image on the right is what is seen 
in Paper Ballot when designing the ballot with the Extended Write-in feature. The 
reserve write-in area is indicated by a gray border while designing ballots in Paper 
Ballot. The gray border does not get printed.

Add a Write-in Phrase

Adhere to the following guidelines when adding the write-in phrase:

 Position the write-in phrase on the same horizontal line as the oval.

 To ensure that the write-in phrase does not interfere with the scanner’s write-in 
recognition logic, ES&S recommends that there be a 2mm (0.079 inches) space 
between the write-in phrase and the reserved write-in area.

Create a Reserve Write-in Area

The scanner looks for potential voter write-in candidate names in the reserve write-in 
area.

Paper Ballot stores the reserve write-in area bounding box coordinates for each write-in 
to the ElectionWare database. The reserved write-in area bounding box information is 
then packaged and sent to the scanner to be used by the scanner recognition logic.

Note: The border of the Reserve Write-in Recognition Area highlighted above, does not 
appear on the printed ballot.

Note: The scanner recognition logic requires white space around the reserved write-in area 
because of potential ballot skews.
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Create a Write-in Horizontal Line

Adhere to the following guidelines when adding a horizontal line:

 Position the horizontal line under the reserve write-in area to indicate the voter 
where to enter their write-in candidate information.

 To not interfere with the scanner recognition logic, ES&S recommends that the 
horizontal line be 0.004 inches in width or less. In addition, all horizontal and vertical 
lines can lie alongside the reserved write-in area as long as the line thickness is 0.004 
inches or less.

Setting up Column Portrait Ballots

Complete the following steps to setting up Column Portrait ballots. The reserve write-in 
area must be at least 10mm high and 24mm wide.

Specify the Write-in Row Height

Include the height of the write-in phrase and the horizontal line together to determine 
the total height of the reserve write-in area. For example, a ballot with a row density of 
5mm and an 8.5-inch x 14-inch, 24-column x 65 row ballot layout, requires a minimum 
write-in height of three rows: 

 Two rows (10mm) for the reserve write-in areas, plus one row for the write-in phrase 
and write-in line.

To define the reserve write-in area

1. On the Sheet Settings screen, specify the column width in the Columns area. The 
standard three column ballot defaults to a column width value of 8 in the Ballot 
Sheet dialog of Ballot Settings, which equates to a width of 64 mm.

Note: It is never recommended that a non-flush write-in line ever be used even if there is a 
2mm gap between the line and the reserved write-in area. The reason is that if the voter 
writes on a non-flush write-in line, the captured name will get truncated because the 
scanner will be looking at a reserved region that is 2 mm or more above the line.



 Chapter 31: Extended Write-in Ballot Layout Guidelines 225

EVS5200_DOC_SOP_EW03Design
 Software Version 4.6

 Published: April 25, 2014

2. On the Write-In Style Sheet screen, specify the row height in the Height field, so 
the ballot column width should be set to a minimum of 3.

Use Reserved Write-in Panels

Use panels to define the reserved write-in area. Vertical panels take up the entire width 
of the write-in area.

For Column Portrait ballot layouts, ES&S recommends that the entire write-in height be 
divided into three vertical panels – one of which is defined as the Reserve Panel for 
Write-in Recognition. For Column Portrait ballot layouts, the reserve write-in area must 
be 10mm or greater in height. Panel sizes are specified by the percentage of the 
available cell space. Calculations are needed to determine the minimum percentage 
size of the reserve write-in panel.

The following table shows the total amount of space available for various row heights of 
the three available row density layouts:

The following table shows the minimum reserve write-in panel size as a percentage of 
the total available write-in area. For example, with a 5mm row density and a 3 row 
write-in, the reserve write-in panel would need to be a minimum of 67% of the total 
write-in area height.

Note: Choosing ballot layouts of 6.5mm and 8mm row densities may only require a write-in 
height of 2 depending on the size of the write-in phrase and write-in line areas.

Ballot Space Available

Rows by Row Density 5 mm 6.5 8 mm

2 10 13 16

3 15 19.5 24

4 20 26 32

Note: The calculations are only valid when panels make up the entire cell. Content placed 
in the cell outside a panel will reduce the amount of total space available in the cell for 
panels.

Minimum Panel Size

Rows 5 mm %
6.5 
mm % 8 mm %
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Create Vertical Panels

Create the following vertical panels:

• First panel contains the write-in phrase.

• Second panel contains the reserved write-in area.

• Third panel contains the horizontal line. 

To create vertical panels

1. On the Write-in Style Sheet, select the Panels button: 

2. On the Panels screen, select Vertical 
(stacked) and specify 0.000 in the Gutter 
Height field.

3. To create the first vertical panel, click Add and do the following:

• Once the Panel Properties window 
appears, in the Height (percentage of 
cell) field, type or select 27 so that the first 
panel will account for 27% of the three row 
write-in area. 

• Verify that all margins and ruling line values 
are set to zero. 

• Ensure that the Reserve Panel for Write-in 
Recognition check box is cleared and click 
OK.

4. To create the second vertical panel, click Add and do the following:

2 10 100 10 13 77 10.01 16 63 10.08

3 15 67 10.05 19.5 52 10.14 24 42 10.08

4 20 50 10 26 39 10.14 32 32 10.24

Minimum Panel Size (continued)
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• Once the Panel Properties window 
appears, in the Height (percentage of 
cell) field, type or select 67 so that the first 
panel will account for 67% of the three row 
write-in area. 

• Verify that all margins and ruling line 
values are set to zero. 

• Ensure that the Reserve Panel for 
Write-in Recognition check box is 
selected and click OK.

•

5. To create the third vertical panel, click Add 
and do the following.

• Once the Panel Properties window 
appears, in the Height (percentage of 
cell) field, type or select 6so that the first 
panel will account for 6% of the three row 
write-in area. 

• Set the value in the Ruling Lines Top field 
to 0.004.

• Verify that all margins and ruling line 
values are set to zero. 

• Ensure that the Reserve Panel for 
Write-in Recognition check box is cleared 
and click OK.

Assign the Write-in Phrase

To assign a write-in phrase to the first panel

1. On the Write-in Style sheet, click Add.

2. On the Style Sheet Content dialog box, do the following:

• In the Content Type area, select Data and Text Title from the drop‐down menu.
• Select panel 1 from the Panel drop‐down menu.
• Select Font and specify 6 point font for the write‐in phrase and click OK.
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3. To create a 2mm space 
between the bottom of the 
write-in phrase and the top 
of the reserved write-in 
area, add a 6 pt. Arial 
blank line to panel 1 to 
ensure a 2mm space.

4. Click OK to return to the 
Write-in Style Sheet and 
click OK again to return to 
the ballot. 
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Add a Horizontal Line to the Third Panel

Instead of using the Horizontal Line feature of the Style Sheet Content dialog, ES&S 
recommends adding a top ruling line for the third panel.

To add a horizontal line to the top of the third panel

1. On the Write-in Style Sheet screen, select 
Add.

2. On the Panel Properties screen, in the Ruling 
Lines area, specify the line width in the Top 
field.

The following example layout below does not meet the guideline requirements:

Note: The larger the height percentage of the third panel, the greater the space will exist 
between the write-in line and the candidate or contest that follows.

The height of three panel’s percentage values should add up to 100%.

ES&S recommends that there is at least 2mm of space after the write-in line and the 
beginning of the next candidate or contest. 
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3. Add a 6 pt. Arial blank 
line to create a 2mm 
space between the 
write-in ruling line and 
the next contest or 
candidate.

Designing Grid Portrait 
Ballots

Use the Grid Portrait ballot layout guidelines in this section if you want to use the 
Extended Write-in feature.

Grid Portrait Ballot

The extended write-in area on the ballot has two or three components:

• Write-in Phrase

• Reserve Write-in Recognition area

• Write-in Horizontal line (optional)
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The following horizontal figure on the top is a printed ballot. The vertical figure in the 
center is the image seen in Paper Ballot when designing the ballot with the Extended 
Write-in feature. The reserved write-in area is indicated by a gray border while designing 
ballots in Paper Ballot. The gray border is not printed.

Add a Write-in Phrase

Adhere to the following guidelines when adding the write-in phrase:

 Position the write-in phrase on the same horizontal line as the oval.

 To ensure that the write-in phrase does not interfere with the scanner’s write-in 
recognition logic, ES&S recommends that there be a 2mm (0.079 inches) space 
between the write-in phrase and the reserved write-in area.

Create a Reserve Write-in Area

The scanner looks for potential voter write-in candidate names in the reserve write-in 
area.

Note: The scanner recognition logic requires white space around the reserved write-in area 
because of potential ballot skews.
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Paper Ballot stores the reserve write-in area bounding box coordinates for each write-in 
to the ElectionWare database. The reserved write-in area bounding box information is 
then packaged and sent to the scanner to be used by the scanner recognition logic.

Create a Write-in Horizontal Line

Adhere to the following guidelines when adding a horizontal line:

 Position the horizontal line under the reserve write-in area to indicate the voter 
where to enter their write-in candidate information.

 To not interfere with the scanner recognition logic, ES&S recommends that the 
horizontal line be 0.004 inches in width or less. In addition, all horizontal and vertical 
lines can lie alongside the reserved write-in area as long as the line thickness is 0.004 
inches or less.

Specify the Write-in Row Height and Width

The minimum reserved write-in area of 10mm high by 24mm wide must include the 
combined height of the write-in phrase and the horizontal line.

To determine the row height of the reserved write-in area

For example, an 8.5-inch x 14-inch ballot layout with a row density of 8mm, 24-columns, 
and 41 rows, requires a minimum write-in height of two rows: 

 Two rows (8mm + 8mm = 16mm) for the minimum 10mm reserved write-in area, plus 
6mm for the write-in phrase.

On the Candidate Style Sheet screen, specify the row height of 2:

Note: Ballot with a 5 mm row density can be 2 rows in height if no write-in phrase is used. 
Set the reserve panel to 100 percent. The oval can exist inside the reserve write-in area.
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To determine the write-in row width of the reserved write-in area

Grid Portrait ballots have a 
fixed column size of 8mm 
(the distance between 
black boxes along the top 
and bottom of the ballot). 

On the Sheet Settings 
dialog box, specify a 
minimum of 3 (columns) in 
the Write-in Column 
Width field (8mm X 3 = 
24mm):

Use Reserve Write-In Panels

ES&S recommends that write-in height be divided between the write-in phrase and the 
reserve write-in panel. Place the write-in phrase at the bottom of the cell and let the 
reserve write-in panel take 100 percent of the remaining space. The reserve write-in 
panel will automatically expand to fill the entire write-in area when a contest wraps to a 
second candidate row, as seen in the examples above.

Vertical panels take up the entire width of the write-in cell.

Assigning the Write-in Phrase

On the Write-in Style sheet window, 
add the following two content items:

 6 pt. Arial blank line

 Text Title (write-In phrase) in the 
point size of your choice.

The blank Line creates a 2mm space 
between the write-in phrase and the 
reserved write-in area. Also make 
the bottom margin 0.075 to bring 
the write-in phrase parallel to the 
oval. Leave all other settings at their 
default values.
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Calculating Reserve Panel Percentages

Grid Landscape Ballot Layouts

For Grid Landscape layouts, the reserved write-in area must be 10mm or greater in 
width. Use panels to define the reserved write-in area. Panel sizes are specified by the 
percentage of the available cell space. Calculations are needed to determine the 
minimum percentage size of the reserved write-in panel. The following table shows the 
total amount of space available for various row widths of the three column density 
layouts:

The following table shows the total amount of space available for various row widths of 
the three available row density layouts (column density is variable for landscape layouts):

The following table shows the minimum reserved write-in panel size as a percentage of 
the total available write-in area. For example, with a 5 mm row density and a 3 row 
write-in, the reserve write-in panel would need to be a minimum of 67% percentage of 
total write-in cell height.

Ballot Space Available

Columns by Column 
Density 5 mm 6.5 8 mm

2 10 13 16

3 15 19.5 24

4 20 26 32

Minimum Panel Size

Rows 5 mm %
6.5 
mm % 8 mm %

2 10 100 10 13 77 10.01 16 63 10.08

3 15 67 10.05 19.5 52 10.14 24 42 10.08

4 20 50 10 26 39 10.14 32 32 10.24

Note: The calculations above are only valid when panels make up the entire cell. Content 
placed in the cell outside a panel will reduce the amount of total space available in the cell 
for panels.
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Chapter 32: Paper Ballot Style Sheet Option Tables

The following tables will help illustrate the varying Paper Ballot Style Sheet options, as 
they change depending upon the chosen layout type. Use this information to verify that 
variable options are available for your chosen layout type. An “X” in a column indicates 
that an option is available to the specified layout type. A dash in a column indicates that 
an option is not available to the specified layout type.

• Column one - 
Frame: Represents 
the frame within 
the Style Sheet 
dialog box. 

• Column two - 
Setting: 
Represents the 
settings available 
within that frame.

• Column three - 
Grid-Landscape: 
This column shows 
the options 
available for the 
Grid-Landscape 
ballot type.

• Column four - 
Grid-Portrait: This 
column shows the 
options available 
for the 
Grid-Portrait ballot 
type.

• Column five ‐ 
Column‐Portrait: 
This column shows 
the options 
available for the 
Column‐Portrait 
ballot type.

Candidate Style Sheet Window Options

Frame Setting
Grid-

Landscape
Grid-

Portrait
Column-
Portrait

Size Frame

Width - - -

Height - X X

Span - - -

Margins

Top X X X

Left X X X

Bottom X X X

Right X X X

Ruling Lines

Top X X X

Left X X X

Bottom X X X

Right X X X

Landscape 
Options

Relative 
Candidate 
Position

X - -

Adjacent 
Party Cell

X - -

Additional 
Information

Background 
Color

X X X

Vertically 
Center 

Content

X X X

Panels X X X

Relative 
Target 

Position

Row X X X

Column X X X
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 Style Sheet Window Options

Frame Setting
Grid-

Landscape
Grid-

Portrait
Column-
Portrait

Size Frame

Width - - -

Height - - X

Span - - -

Margins

Top X X X

Left X X X

Bottom X X X

Right X X X

Ruling Lines

Top X X X

Left X X X

Bottom X X X

Right X X X

Additional 
Information

Background 
Color

X X X

Vertically 
Center 

Content

X X X

Panels X X X

Relative 
Target 

Position

Row X X X

Column X X X

Party Style Sheet Window Options

Frame Setting
Grid-

Landscape
Grid-

Portrait

Size Frame

Width X -

Height - X

Span - -

Margins

Top X X

Left X X

Bottom X X

Right X X
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Ruling Lines

Top X X

Left X X

Bottom X X

Right X X

Additional 
Information

Background 
Color

X X

Vertically 
Center 

Content

X X

Panels X X

Question Style Sheet Window Options

Frame Setting
Grid-

Landscape
Grid-

Portrait
Column-
Portrait

Size Frame

Width X - -

Height - X X

Span - - -

Margins

Top X X X

Left X X X

Bottom X X X

Right X X X

Ruling Lines

Top X X X

Left X X X

Bottom X X X

Right X X X

Skip

Marks to 
Skip Before

X X

Marks to 
Skip After

X X

Additional 
Information 

1

Background 
Color

X X X

Vertically 
Center 

Content

X X X

Panels X X X

Party Style Sheet Window Options (continued)

Frame Setting
Grid-

Landscape
Grid-

Portrait
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Additional 
Information 

2

Top Double 
Rule

X

Bottom 
Double Rule

X

Response 
Settings

X X X

Position

Question 
Row

X

Sheet/Side X X

Column X X

Row X X

Question Response Style Sheet Window Options

Frame Setting
Grid-

Landscape
Grid-

Portrait
Column-
Portrait

Size Frame

Width X X X

Height X X X

Span - - -

Margins

Top X X X

Left X X X

Bottom X X X

Right X X X

Additional 
Information 

Vertically 
Center 

Content

X X X

Position

Relative 
Column

X X X

Column Skip 
After

X X X

Candidate Level Text Style Sheet Window Options

Frame Setting
Grid-

Landscape
Grid-

Portrait
Column-
Portrait

Size Frame

Width X X -

Height - X X

Span - X -

Question Style Sheet Window Options (continued)

Frame Setting
Grid-

Landscape
Grid-

Portrait
Column-
Portrait
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Margins

Top X X X

Left X X X

Bottom X X X

Right X X X

Ruling Lines

Top X X X

Left X X X

Bottom X X X

Right X X X

Additional 
Information

Background 
Color

X X X

Vertically 
Center 

Content

X X X

Panels X X X

Candidate Level Text Style Sheet Window Options (continued)

Frame Setting
Grid-

Landscape
Grid-

Portrait
Column-
Portrait
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Chapter 33: General Information

Report Screen Toolbar

Each module within ElectionWare offers its own collection of individual reports. These 
reports appear in the work space, and can be saved, viewed and printed all by utilizing 
the report screen toolbar. Use the report screen toolbar to save, print, scroll through 
pages, and change the view of the report currently displayed. Use the following 
information for reference on how to use the Report Screen Toolbar.

Saving and Printing Reports

To access the Report Screen Toolbar, use the Reports menu to produce reports specific 
to the module you are currently using.

Upon displaying the report in the work space, the report screen toolbar becomes 
available:

At the top left of the Report Screen 
Toolbar are the Print and Save 
symbols.

Use the Save symbol to save the report currently displayed in the Report Screen. 
ElectionWare reports may be saved in the following file formats:

 .html – Hypertext Markup Language File

 .pdf – Portable Document Format File

 .rtf – Rich Text Format File

Note: An election must be selected before trying to access a report.
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 .xls – Excel Spreadsheet

Click the Save symbol.

The Save Report File dialog 
box appears:

Enter a file name that 
describes the report in the 
File name field, and click 
Save Report File.

Use the Print symbol to print a hard-copy of a 
report. The Print dialog box appears:

Select the printer of your choice from the 
Name drop-down menu.

You can choose to print all pages by selecting 
All from the print range dialog box. Or, you 
can select a specific page range by selecting 
Pages, and entering the desired page 
numbers in the from and to fields.

Select the number of copies you wish to print 
from the Number of copies cell. You may enter the number of copies you wish 
manually, or you can use the up or down arrows to increase or decrease the number of 
copies respectively.

Select Collate if you wish the report pages to print in sequential order.

Note: Reports are defaulted to save in the (PDF) format.
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Click Cancel to cancel the print job and close the Print dialog box. Or, click OK to 
accept the print job and return to the ElectionWare dialog box.

Page Selection Arrows

Use the page selection arrows to navigate through the report pages sequentially, or to 
jump to the beginning or end of the report. 

Click the Previous Page arrow to move one page backward in the report. 

Click the Next Page arrow to move one page forward in the report.

Click the First Page arrow to skip to the first page. 

Click the Last Page arrow to skip to the last page.

Or, use the Go To Page field to skip to a specific 
page in the report. You can also use this field to 
check the number of the currently displayed 
page.

Note: The print option can be used to create soft copies of a report as well. Use the Name 
drop-down list to select Adobe PDF option if Adobe 9.0 or higher is installed. Otherwise 
select Print to file from the drop-down menu.
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Changing the On screen Report View

Use the page size and zoom symbols to change the way that the on screen report is 
currently displayed. 

Use the Actual Size symbol to view the report in its actual size.

Use the Fit Page symbol to make the report fit the page to the size of the current 
screen.

Use the Fit Width symbol to make the report fit to the width of the current screen.

Use the Zoom In symbol to zoom in on the report.

Use the Zoom Out symbol to zoom out of the report.

Use the Zoom Ratio drop-down menu to manually select the size of the report on 
screen. The Zoom Ratio ranges from 100% to 800%. Select from the available 
percentages, or enter a manual percentage in the box.
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Chapter 34: Paper Ballot System Messages
Paper Ballot System Messages

System Messages Message Type Solution

Add Font Substitution Informational 
Message

No action required.

Add Frame: <frame name> Informational 
Message

No action required.

Add Stylesheet: <style sheet name> Informational 
Message

No action required

Add Text Item: <text item name> Informational 
Message

No action required.

Application Error: Another user has 
recently modified this data. Data cannot 
be saved.

Error 
Message

Verify that no other users are in 
ElectionWare Paper Ballot, and 
then try saving again.

Application Error: Error loading election 
data.

Error 
Message

Contact ES&S Customer Support.

Application Error: Error saving data. Data 
was not saved.

Error 
Message

Contact ES&S Customer Support.

Application Error: Finalize Ballot Layout 
aborted due to the following error: <error 
text>

Error 
Message

Review the reason for the error. If 
possible, follow any steps necessary for 
resolution. Otherwise, contact ES&S 
Customer Support.

Application Error: No print device was 
found. Printing disabled.

Error 
Message

Verify that a print device has been 
specified in Microsoft Windows. If 
necessary, use your Windows 
documentation, or contact Microsoft for 
assistance in selecting a print device.

If a print device has been selected and the 
error continues, contact ES&S Customer 
Support for assistance.

Application Error: Unable to display help. Error 
Message

Contact ES&S Customer Support.

Application Error: Unable to display the 
User Guide.

Error 
Message

Contact ES&S Customer Support.

Application Warning: Could not create 
internal printer DC. Print menu will be 
disabled

Warning 
Message

Contact ES&S Customer Support.

Close Document: <document name> Informational 
Message

Click Yes to close the document.

Copy Frame: <frame name> Informational 
Message

Click Yes to copy the frame.

Copy Stylesheet: <style sheet name> Informational 
Message
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Delete Font Substitution Informational 
Message

No action required.

Delete Frame: <frame name> Informational 
Message

No action required.

Delete Stylesheet: <style sheet name> Informational 
Message

No action required.

Delete Text Item: <text item name> Informational 
Message

No action required.

Exception: A database exception 
occurred: <error text>

Error 
Message

Contact ES&S Customer Support.

Exception: A database exception 
occurred: <error text>

Error 
Message

Contact ES&S Customer Support.

Export aborted due to the following error:

Unsupported contest float occurred.

Error 
Message

Contact ES&S Customer Support.

Export: Ballot layout finalization failed. Error 
Message

Contact ES&S Customer Support.

Export: Finalize Ballot Layout aborted due 
to the following error: <error text>

Error 
Message

Contact ES&S Customer Support.

Export: Start of ballot layout finalization. Informational 
Message

Contact ES&S Customer Support

Export: The ballot layout was finalized 
successfully.

Informational 
Message

Contact ES&S Customer Support

Language Change: <language ISO code> Informational 
Message

No action required.

Load Template: <template filename> Informational 
Message

No Action Required.

Load Template: <template name> Informational 
Message

No action required.

Move Frame: <frame name> Informational 
Message

No action required.

New Document: <datafile name> Informational 
Message

No action required.

Open Document: <document name> Informational 
Message

No action required.

Paper Ballot module exit Informational 
Message

No action required.

Paper Ballot module start Informational 
Message 

No action required.

Print: Ballots with Errors Informational 
Message 

No action required.

Paper Ballot System Messages

System Messages Message Type Solution
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Print: Error detection turned off, no check 
for errors

Informational 
Message 

No action required.

Print: Unvalidated Ballots Informational 
Message 

No action required.

Print: Validated Ballots Informational 
Message 

No action required.

Save Document: <document name> Informational 
Message 

No action required.

Save Template: <template filename> Informational 
Message 

No action required.

Save Template: <template name> Informational 
Message 

No action required.

Settings Change Informational 
Message 

No action required.

Update Font Substitution Informational 
Message 

No action required.

Update Frame: <frame name> Informational 
Message 

No action required.

Update Stylesheet: <style sheet name> Informational 
Message 

No action required.

Update Text Item: <text item name> Informational 
Message 

No action required.

Paper Ballot System Messages

System Messages Message Type Solution
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Chapter 35: Revision History

Electionware Volume III: Design User’s Guide
April 25, 2014

Document Version 3.0

Chapter Version Description Project

24,33 3.0 Removed references to Viewer. 5.2.0.0

Electionware Volume III: Design User’s Guide
February 21, 2014

Document Version 2.0

Chapter Version Description Project

Entire Book 2.0 Updated manual title to manual filename in footer.. 5.2.0.0

Electionware Volume III: Design User’s Guide
January 10, 2014

Document Version 1.11

Chapter Version Description Project

Entire Book 1.0 New book based on EVS FL 4.5. 5.2.0.0

27 1.1 Add Important note that Viewer is required to view/print 
exported spreadsheets.

5.2.0.0

27 1.1 Add Important note that exported spreadsheets must be 
saved to a computer w/ Excel in order to edit them.

5.2.0.0

33 1.1 Add Important note that Viewer is required to view/print 
exported spreadsheets.

5.2.0.0

Entire Book 1.11 Miscellaneous improvement revisions requested by 
review team.

5.2.0.0

10 1.11 Updated Text Variables table.

Added note under Font Codes that fonts must first be 
installed on the system.

5.2.0.0
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15 1.11 Added explanation about the Question Response style 
sheet.

Corrected “Text Applied to Window” to “Candidates 
Applied to Window.”

Removed “Position Section,” as this is not in the 
“Candidate Level Text Style Sheets.”

Removed “Return to Office Headings” section, as this 
instruction is already provided at the end of the previous 
section.

5.2.0.0

16 1.11 Added warning about adding text to Style Sheets. 5.2.0.0

20 1.11 Removed note about Adobe Type Basic.

Removed misplaced “click yes/no” instructions.

5.2.0.0

2 1.11 Print Symbols: Corrected description for Print symbol. 5.2.0.0

10 1.1 Edit Text Items: Corrected wording of Step 4 Note. 5.2.0.0

10 1.1 Substitution Variables: Corrected text. 5.2.0.0

10 1.1 Substitution Variables: Updated Text Variables table. 5.2.0.0

10 1.1 Text Formula Codes: Added voter instruction. 5.2.0.0

10 1.1 Font Codes: Added note about needing font installed. 5.2.0.0

15 1.1 Question Response Style Sheet: Added explanation. 5.2.0.0

15 1.1 Text Applied to Window: Corrected terms. 5.2.0.0

15 1.1 Return to the Text Applied to Window: Corrected terms. 5.2.0.0

15 1.1 Return to the Text Applied to Window: Removed step 
17.

5.2.0.0

15 1.1 Return to the Office Headings Applied to Window: 
Removed redundant section.

5.2.0.0

15 1.1 Return to the Column Headings Applied to Window: 
Corrected wording.

5.2.0.0

15 1.1 Add Text to Style Sheets: Added warning. 5.2.0.0

18 1.1 Add Text to a Frame: Improved numbering convention. 5.2.0.0

20 1.1 Removed recommendation of Adobe Type Basic. 5.2.0.0

20 1.1 Removed misplaced steps. 5.2.0.0

2 1.1 Paper Ballot Formatting Menus: Revised caution. 5.2.0.0

2 1.1 Paper Ballot Formatting Menus: Added Warning. 5.2.0.0

2 1.1 Paper Ballot Formatting Menus: Added graphic. 5.2.0.0

Electionware Volume III: Design User’s Guide
January 10, 2014

Document Version 1.11

Chapter Version Description Project
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Index
A

Accessible Ballot, 185
Candidates, 203
Introduction, 186
Preview Ballot, 208
Status, 188
Validate Data, 216

Accessible Ballot Navigator, 189
Add

Text to a Watermark, 49
Add a Ballot Frame, 155
Add an Image, 68
Add Ballot Sheets, 51
Add Ballot Title, 59
Add Candidate Level Text Style Sheet, 124
Add Candidate Style Sheet, 96
Add Column Heading Style Sheet, 138
Add Contest Level Text Style Sheet, 120
Add Data to Frames, 159
Add Data to Style Sheets, 142
Add Graphics to Ballot Frames, 163
Add Graphics to Style Sheets, 147
Add Lines to Ballot Frames, 165
Add Lines to Style Sheets, 148
Add Office Row, 55
Add Office Style Sheet, 127
Add Panels, 39
Add Party Style Sheet, 107
Add Question Row, 57
Add Question Style Sheet, 111
Add Straight Party Style Sheet, 91
Add Text to Ballot Frames, 161
Add Text to Style Sheets, 144
Add Write-in Column Heading Style Sheet, 134
Add Write-in Style Sheet, 101
Adding a Question Response Style Sheet, 116
Apply Different Style Sheets to Existing Style Sheets,
153
Audio File Formats, 203
Audio File Production, 203
Audio Recording Process, 204

B
Ballot Errors, 34
Ballot Frames, 155

Add, 155
Import, 167

Ballot Glossary, 19
Ballot Settings Window, 46, 47

Ballot Tab, 45
Ballot Setup, 44

Ballot Tab, 45
Ballot Templates, 27
Ballot Title Window, 59

C
Candidates, 203
Clear Message, 33
Clear messages when a new document is opened

Message Pane Settings, 33
Close, 25
Column Portrait Ballot

Working with Column Templates, 65
Column Properties Window, 63, 64
Column Templates, 65
Column-Portrait Ballot

Deleting a Column, 67
Column-Portrait Sheet Settings Options, 64
Configuring (.pdf) Paper Size, 174
Content Outside Cell Errors, 34
Copy Style Sheets, 151
Copying Ballot Frames, 169
Create a New Style Sheet Shortcut, 153
Creating (.pdf) Ballots, 173
Custom Color Settings, 41

D
Default Language, 81
Delete a Ballot Question Form, 63
Delete a Ballot Title, 61
Delete Column, 67
Delete Font Substitutions, 79
Delete Frame Content, 166
Delete Images, 69
Delete Office Row, 57
Delete Panels, 41
Delete Question Row, 58
Delete Style Sheet Content, 152
Delete Style Sheets, 152
DeleteText Items, 72
Duplicate Messages, 33

E
Edit Font Substitutions, 79
Edit Panels, 40
Edit Style Sheet Content, 152
Edit Style Sheets, 152, 153
Editing a Ballot Title, 59
Editing a Question Row, 57
Editing an Empty Cell Style Sheet, 84



Index 250

EVS5200_DOC_SOP_EW03Design
 Software Version 4.6

 Published: April 25, 2014

Editing an Office Row, 55
Editing Frame Content, 166
Editing Image, 69
Editing Text Items, 72
Editing the Office Row Heading Style Sheet, 131
Editing the Write-in Row Heading Style Sheet, 132
Election Audio Recordings

Importing, 206
Extended Write-in Guidelines, 220

F
Features, 30
Finalize Ballot Layout, 171
Finalizing Ballots, 171
Font Codes, 77
Font Settings Window, 37
Font Substitutions, 78
Format Display, 193

Format Ballot Style Names, 197
Format Candidates, 196
Format Contest Summary, 195

Formating Elements
Format Headings, 193

Formatting Elements
Format Contests, 194

Frames
Add a Line, 165
Add Data, 159
Add Graphics, 163
Add Text, 161
Copying, 169
Deleting Ballot Frame Content, 166
Editing Content, 166
Moving, 169

G
Generate BOD Data, 182
Graphic Management

Delete Images, 69
Edit Images, 69

Grid-Landscape Ballot
Add a Ballot Title, 59
Add a Question Row, 57
Adding an Office Row, 55
Delete an Office Row, 57
Deleting a Ballot Question Form, 63
Deleting a Question Row, 58
Edit a Ballot Title, 59
Edit a Question Row, 57
Editing an Office Row, 55
Sheet Settings Window, 54

Grid-Landscape Ballot Layout
Deleting a Ballot Title, 61
Import Text Items, 71

Grid-Portrait Ballot
Column Properties Window, 63

Layout Options, 62
Sheet Settings Options, 61

I
Import Ballot Frames, 167
Import Style Sheets, 151
Importing Grid-Landscape Text Items, 71

L
Load Template, 27
Load Template From File, 29

M
Mark Numbers, 31
Message Pane Settings, 33
Misc Tab, 47
Moving Ballot Frames, 169
Multi-Sheet Setup, 80

N
New Document Wizard, 21

O
Office Row Window, 55

Layout Tab, 55
Parties Tab, 56

Open, 24

P
Panels, 38
Paper Ballot

Add an Image, 68
Add Ballot Sheets, 51
Add Panels, 39
Ballot Errors, 34
Ballot Frames, 155
Ballot Setup, 44
Ballot Sheet Management, 51
Ballot Template Management, 27
Ballot Title Window, 59
Candidate Level Text Style Sheet, 124
Candidate Style Sheet, 96
Close, 25
Column Properties Window, 64
Column-Portrait Sheet Settings Options, 64
Configuring (.pdf) Paper Size, 174
Content Outside Cell Errors, 34
Contest Level Text Style Sheet, 120
Creating Ballot (,pdf) Files, 173
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Custom Color Settings, 41
Default Language, 81
Default Style Sheets, 83
Delete Font Substitutions, 79
Delete Panels, 41
Delete Text Items, 72
Edit Font Substitutions, 79
Edit Panels, 40
Edit Text Items, 72
Finalize Ballot Layout, 171
Finalizing the Ballot, 171
Font Codes, 77
Font Settings Window, 37
Font Substitutions, 78
Generate BOD Data, 182
Grid Overlay Icon, 17
Load Template, 27
Load Template From File, 29
Mark Numbers, 31
Menu Trees, 11
Message Pane Settings, 33
Multi-Sheet Setup, 80
New, 20
New Document Wizard, 21
Office Heading Style Sheet, 127
Office Row Heading Style Sheet, 130
Office Row Window, 55
Office Style Sheet, 85
Open, 24
Overview, 10
Panels, 38
Party Style Sheet, 107
Print Ballots, 173
Print Icon, 16
Print Preview Icon, 16
Print to (.pdf), 175
Printer Settings for Two-Sided and Multi-Sided Bal-

lots, 178
Printing Ballots, 180
Question Response Style Sheet, 116
Question Row Window, 58
Question Style Sheet, 111
Save, 25
Save As, 26
Save As Template, 28
Save Template to File, 29
Saving Ballots, 171
Scan for Errors, 82
Scan Icons, 17
Scanning Ballots for Errors, 171
Status Bar, 36
Straight Party Style Sheet, 91
Style Sheets, 83
Substitution Variables, 72
Target Encroachment Errors, 34
Text Format Codes, 76
Toolbar, 35
Tooltips, 32
Universal Features, 37

Universal Sheet Settings, 53
View Menu, 30
Workspace Utility Icons, 16
Write-in Column Heading Style Sheet, 134
Write-in Row Heading Style Sheet, 132
Write-in Style Sheet, 100
Zoom Features, 30
Zoom Icons, 17

Paper Ballot Menu Trees, 11
Parties Tab, 56
Preview Ballot

Navigation, 208, 212
Print and Save Icons, 240
Print Ballots, 173

Q
Question Row Window, 58
Question Style Sheet, 116

R
Recommended Audio Production Tools, 203
Report Page Selection Arrows

Page Selection Arrows, 242
Report Screen Toolbar

Report Screen, 240
Report Screen Toolbar, and Changing the Current View

Report Screen View Options, 243
Report Toolbar, 240, 242, 243
Reports

Missing Ballot Audio Files, 218
Missing Ballot Data, 217

S
Save, 25
Save As, 26
Save As Template, 28
Save Template to File, 29
Saving and Printing Reports, 240
Saving Ballots, 171
Scan, 17
Scanning Finalized Ballots for Errors, 171
Scanning for Errors, 82
Sheet Settings Window, 54
Sheet Settings Window - Universal Options, 53
Status

Accessible Ballot, 188
Status Bar, 36
Style Sheet Shortcuts, 153
Style Sheets, 83

Add Data, 142
Add Graphics, 147
Add Lines, 148
Add Text, 144
Adding a Candidate Level Text Style Sheet, 124
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Adding a Candidate Style Sheet, 96
Adding a Column Heading Style Sheet, 138
Adding a Contest Level Text Style Sheet, 120
Adding a Party Style Sheet, 107
Adding a Question Response Style Sheet, 116
Adding a Question Style Sheet, 111
Adding a Straight Party Style Sheet, 91
Adding a Write-in Column Heading Style Sheet, 134
Adding a Write-in Style Sheet, 101
Adding an Office Style Sheet, 127
Apply Different Style Sheets to Existing Style

Sheets, 153
Candidate, 96
Candidate Level Text, 124
Contest Level Text, 120
Copy Existing Style Sheets, 151
Default, 83
Delete Content, 152
Delete Style Sheets, 152
Edit Content, 152
Edit Style Sheets, 152
Editing an Empty Cell Style Sheet, 84
Editing Shortcut, 153
Editing the Office Row Heading Style Sheet, 131
Editing the Write-in Row Heading Style Sheet, 132
Empty Cell

Paper Ballot
Empty Cell Style Sheets, 84

Import, 151
New Shortcut, 153
Office, 85
Office Heading, 127
Office Row Heading, 130
Party, 107
Question, 111
Question Response, 116
Question Style Sheet, 116
Shortcuts, 153
Straight Party, 91
Use a Previous Style Sheet Setting in a New Style

Sheet, 154
Write-in, 100
Write-in Column Heading, 134
Write-in Row Heading, 132

Substitution Variables, 72
Suppress Duplicate Messages

Message Pane Settings, 33

T
Tab

Layout, 55
Target Encroachment Errors, 34
Target Tab, 46
Text Format Codes, 76
Toolbar, 35, 240
Tooltips, 32

U
Universal Paper Ballot Features, 37
Use a Previous Style Sheet Setting in a New Style Sheet,
154

V
View Menu, 30

W
Watermark

Add Text, 49
Watermark Settings, 47
Write-in

Extended Guidelines, 220

Z
Zoom, 30
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